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1. IntRoduZIonE

1.1 PAnoRAMICA SuL SIStEMA
La nuova gamma di prodotti VAIE 2000 è stata progettata e costruita per offrire soluzioni innovative nella realizzazione di sistemi applicati ai 
servizi d’emergenza. È in grado di gestire le situazioni d’allarme e consentire, in accordo alle norme vigenti (En 54-16, ISo 7240-19 ed 
En 60849), un’evacuazione guidata e controllata.

L’architettura dell’intero sistema si basa sul controller VAC 2006, unità di gestione e diagnostica particolarmente idonea sia per le grandi 
che per le piccole installazioni, dove sono richieste elevati livelli di sicurezza, flessibilità e praticità d’uso. La semplicità di collegamento (cavo 
schermato CAT.5e SF/UTP) tra le varie unità di gestione, gli amplificatori e le postazioni microfoniche d’emergenza, rende efficace ed economica 
la sonorizzazione di edifici complessi, consentendo l’utilizzo di apparecchi sia centralizzati che locali.

ogni controller VAC 2006 è predisposto per la gestione di 6 linee di controllo alle quali possono essere direttamente collegate le seguenti 
unità:
•  Amplificatori digitali di potenza dotati di scheda di diagnostica (Serie dPu), fino ad un massimo di 16 per linea;
•  Router VAR 2006 (1 per linea), in grado di gestire 6 zone con doppia linea d’uscita a 100 V (A e B);
•  Sistemi integrati compatti a 6 zone (VAIE 2250, massimo 1 per linea);
• Numero massimo di zone dell’intero sistema: 216.

È possibile collegare tra loro fino ad un massimo di 6 controller VAC 2006.
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Controller VAC 2006 ed amplificatori digitali Serie dPu Controller VAC 2006 e router VAR 2006

Sistema VAIE 2000 in configurazione mista
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2. dESCRIZIonE GEnERALE

2.1 ContRoLLER VAC 2006  
F1. Pulsante incassato per l’attivazione della modalità di Emergenza Manuale (EMERGENCY).
F2. Microfono palmare con tasto di attivazione Push to Talk (P.T.T.) per annunci di emergenza a viva-voce.
F3. Pannello comandi con display grafico retroilluminato monocromatico da 128x64 pixel.
R1. Interruttore d’accensione.
R2. Ingressi per il collegamento delle postazioni microfoniche di emergenza remote (FMd 2012, FMd 2001).
R3. Prese per il collegamento tra controller VAC 2006 (fino a 6).
R4. Ingresso per il collegamento delle postazioni microfoniche di chiamata broadcast (MBt 1106, MBt 1112). 
R5. Ingresso bilanciato per microfono o sorgente esterna / Morsettiera per il collegamento del contatto di precedenza.
R6. Ingresso per microfono esterno.
R7. Ingresso per il collegamento di una sorgente musicale esterna.
R8. N°7 ingressi digitali monitorati per controllo da perifiche esterne.
R9. N°6 linee d’uscita per collegamento ad amplificatore Serie DPU e/o Sistemi compatti VAIE 2250 e/o Router VAR 2006.
R10. Presa di collegamento per Local Area Network con protocollo TCP/IP di rete Ethernet 10/100.
R11. N°3 uscite a relè per segnalazione verso periferiche esterne. 
R12. Morsettiera per alimentazione esterna in corrente continua 24Vcc. 
R13. Connessione di terra del telaio. 
R14. Spina per alimentazione di rete 230Vca con fusibile integrato.

Vedi dettagli del pannello comandi a pag. 16.
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2.2 RoutER VAR 2006  
F4. LED segnalazione guasti.
F5. LED di stato router/sistema.
F6. LED di stato zone d’uscita.
F7. Pulsanti di selezione zone diffusione BGM.
F8. LED di stato alimentazioni/chiamate.
R1. Interruttore d’accensione.
R11. N°2 uscite a relè per segnalazione verso periferiche esterne. 
R12. Morsettiera per alimentazione esterna in corrente continua 24Vcc. 
R13. Connessione di terra del telaio. 
R14. Spina per alimentazione di rete 230Vca con fusibile integrato.
R15. Morsettiera per collegamento alle uscite degli amplificatori.
R16. Morsettiere uscite altoparlanti.
R17. Ingressi/uscite programmabili.
R18. Uscita amplificatore voce  - Uscita amplificatore musica/riserva.
R19. Ingresso/uscita per collegamento a controller VAC 2006.

2.1.1 Caratteristiche principali del controller
 • Microfono frontale d’emergenza supervisionato.
 • Sistema di diffusione sonora a 2 canali.
 • Generatore di messaggi per diffusione di allarmi vocali a doppio canale (EVAC ed ALERT).
 • Ingresso USB come sorgente di musica di sottofondo.
 • Gestione automatica dell’amplificatore di riserva.
 • Ingresso per alimentazione secondaria (24 Vcc).
 • 7 contatti d’ingresso programmabili e controllati.
 • 3 uscite relè.
 • 6 linee di controllo per gli amplificatori digitali Serie dPu e/o router VAR 2006 e/o i sistemi integrati d’evacuazione VAIE 2250.
 • 4 linee ridondabili per il collegamento tra i vari controller (max 6).
 • 2 linee ridondabili per le basi microfoniche d’emergenza Serie FMd (max 7, con 7 livelli di priorità).
 • 2 linee ridondabili per le postazioni di chiamata Serie MBt (max 16, con 7 livelli di priorità).
 • Display grafico monocromatico 128x64 pixel per una facile configurazione e veloce uso delle schermate di controllo.
 • Diagnostica e segnalazione dei vari guasti.
 • Montaggio standard a rack 19” (altezza 2 unità).  

2.2.1 Caratteristiche principali del router
 • 6 uscite di zona altoparlanti a doppia linea A e B.
 • Doppio ingresso 100V per 1 o 2 amplificatori voce (IN 1 zone 1÷3, IN 2 zone 4÷6).
 • Ingresso 100V per amplificatore musica/riserva.
 • Possibilità di attivare/disattivare la musica per ogni zone tramite appositi pulsanti frontali.
 • Prese RJ45 per il collegamento al controller VAC 2006.
 • 7 contatti d’ingresso programmabili e controllati.
 • 6 uscite open-collector.
 • 2 uscite a relè.
 •  Montaggio standard a rack 19” (altezza 1 unità).  
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3. AVVERtEnZE

3.1 ALIMEntAZIonE E MESSA A tERRA
questo apparecchio è predisposto per il funzionamento con tensione di rete a 230 V ± 10% 50/60 Hz. L’interruttore di accensione (R1) agisce 
sulla tensione di rete. In dotazione all’apparecchio è fornito un cavo di alimentazione con filo di terra; il terminale di terra della spina di rete non 
deve essere rimosso in alcun caso. Collegare la spina di rete (R14) dell’apparecchio alla rete elettrica utilizzando esclusivamente l’apposito 
cavo fornito in dotazione, che dispone di opportuno filtro anti-disturbo; assicurarsi che la presa di corrente sia dotata di collegamento di terra a 
norma di legge. Il circuito d’alimentazione del VAC 2006 è protetto da un fusibile situato sulla spina di rete dell’apparecchio.

3.3 InStALLAZIonE
Tutti gli apparecchi FBt sono costruiti nel rispetto delle più severe normative internazionali di sicurezza ed in ottemperanza ai requisiti della 
Comunità Europea. Per un corretto ed efficace uso dell’apparecchio è importante prendere conoscenza di tutte le caratteristiche leggendo 
attentamente le presenti istruzioni ed in particolare le note di sicurezza. Durante il funzionamento dell’apparecchio è necessario assicurare 
un’adeguata ventilazione, lasciando libera soprattutto la griglia superiore d’aerazione per le ventole di raffreddamento. Evitare di racchiudere 
l’apparecchio in un mobile privo di aerazione o di tenerlo in prossimità di sorgenti di calore. Gli apparecchi possono essere montati in rack 
standard da 19”. 

3.2 notE dI SICuREZZA
Ogni intervento all’interno dell’apparecchio, quale operazioni di manutenzione od altro, deve essere effettuato solo da personale specializzato: la 
rimozione del coperchio rende accessibili parti con rischio di scosse elettriche. Prima di rimuovere il coperchio accertarsi sempre che il cavo di 
rete sia staccato. Nel caso di accidentale caduta di liquidi sull’apparecchio, staccare immediatamente la spina di rete ed interpellare il centro di 
assistenza FBt più vicino. Nel caso di installazione a rack si prescrive di collegare al telaio del rack la connessione (R13) per mezzo di un cavo 
più corto possibile (~20cm). È possibile anche collegare le altre apparecchiature presenti per la sola funzione di schermatura dei segnali a basso 
livello e d’immunità alle interferenze indotte: questa presa non deve essere utilizzata per il collegamento di sicurezza del  telaio alla terra.

Avvertenze per lo smaltimento del prodotto ai sensi della direttiva Europea 2002/96/EC 
Alla fine della sua vita utile il prodotto non deve essere smaltito insieme ai rifiuti urbani, ma deve essere consegnato presso gli appositi 
centri di raccolta differenziata predisposti dalle amministrazioni comunali, oppure presso i rivenditori che forniscono questo servizio. 
Smaltire separatamente un rifiuto elettrico e/o elettronico (RAEE) consente di evitare possibili conseguenze negative per l’ambiente e per 
la salute derivanti da un suo smaltimento inadeguato e permette di recuperare i materiali di cui è composto al fine di ottenere un importante 
risparmio di energia e di risorse. Su ciascun prodotto è riportato a questo scopo il marchio del contenitore di spazzatura barrato.

Questo prodotto è conforme alle direttive della Comunità Europea sotto le quali lo stesso ricade.
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4. ConnESSIonI
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A) CoLLEGAMEnto tRA ContRoLLER
Utilizzare un cavo CAT.5e SF/UTP nelle prese ‘VAC 2006 LINk’ (R3) per collegare tra di loro i controller del sistema (max 6).

B) CoLLEGAMEnto LInEE d’uSCItA 
Utilizzare le prese ‘SLAVE LINk OUTPUTS’ (R9) per collegare al controller:
B1) Router VAR 2006.
B2) Sistema d’emergenza compatto VAIE 2250.
B3) Amplificatori Serie dPu. 

 
B1) Router VAR 2006
Utilizzare un cavo CAT.5e SF/UTP per collegare le prese ‘SLAVE LINk OUTPUTS’ (R9) alle prese ‘IN/OUT SLAVE LINk’ sul router. 
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B2) Sistema d’emergenza compatto VAIE 2250
Utilizzare un cavo CAT.5e SF/UTP per collegare una delle prese ‘SLAVE LINk OUTPUTS’ (R9) alla presa ‘REMOTE LINk’ del sistema compatto 
VAIE 2250. 

B3) Amplificatori Serie dPu
Utilizzare cavi CAT.5e SF/UTP per collegare una delle prese ‘SLAVE LINk OUTPUTS’ (R9) alla presa ‘IN/OUT’ dell’amplificatore 
(DPU 1125C, DPU 1250C o DPU 1500C).
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d1) Sorgenti Musicali BGM, canale d’amplificazione “musica” 
Collegamento di esempio di sorgenti sonore a livello linea o microfonico, bilanciate o sbilanciate, selezionabili dal pannello MUSIC e indirizzabili 
alle zone desiderate tramite i tasti di attivazione zona. Per dettagli sulle impostazioni fare riferimento alle relative sezioni indicate in menu MUSIC 
ed AUDIO SETTING.
A - Sorgente musicale con uscita sbilanciata a livello di linea collegata all’ingresso AUX IN.
 Per l’ascolto selezionare dal Menu MUSIC la sorgente BGM “AUX”
B - Ricevitore del kit radio-microfonico con uscita bilanciata a livello microfonico collegata all’ingresso IN.1.
 Per l’ascolto selezionare dal Menu MUSIC la sorgente BGM “INPUT 1”
 Impostare al Pannello INPUT 1: >MODE: OFF
   >PH: OFF
   >I parametri Chime, Priority e Zone list non hanno effetto
C - Mixer con uscita bilanciata a livello Linea collegata all’ingresso IN.2 LINE.
 Per l’ascolto selezionare dal Menu MUSIC la sorgente BGM “INPUT 2”
 Impostare al Pannello INPUT 2: >MODE: OFF
   >PH: OFF
   >I parametri Chime, Priority e Zone list non hanno effetto

Attenzione! non collegare altre apparecchiature alla presa MIC dell’ingresso In.2.

d) CoLLEGAMEnto InGRESSI AudIo 
Per dettagli sulle impostazioni fare riferimento alle relative sezioni indicate in menu MUSIC ed AUDIO SETTING.

C) CoLLEGAMEnto PoStAZIonI d’EMERGEnZA 
Utilizzare un cavo CAT.5e SF/UTP per collegare le prese ‘EMERGENCY 
UNITS’ (R2) del controller alle prese ‘IN/OUT’ delle postazioni FMD 2001 
e/o FMD 2012. 



Manuale di sistema | 2013 VAIE 2000 | Voice Alarm Integrated Systems

I

13

VAC 2006 • VAR 2006

d2)  Sorgenti PA di varia tipologia a priorità scalare, canale d’amplificazione “voce”
Collegamento di esempio di 1 postazione microfonica da tavolo, non pre-amplificata, con contatto di precedenza; di 1 microfono ad impugnatura 
con attivazione automatica VOX sulla musica; di 1 centralino telefonico con uscita audio per annuncio automatico sull’impianto diffusione sonora 
e postazioni digitali serie MBT per annunci di servizio con selezione a zone. Per dettagli sulle impostazioni fare riferimento alle relative sezioni 
indicate in AUDIO SETTING.

A - Base da tavolo con microfono elettrete, uscita bilanciata collegata 
all’ingresso IN.1– MIC e contatto di precedenza collegato all’ingresso 
PREC.
L’annuncio sarà indirizzato sul gruppo di zone riferite alla ZONE LIST secondo 
la priorità impostata.
Impostare al Pannello INPUT 1: >MODE: PRECEDENCE
  >PH: ON
  >Priority: 3 
  >Zone list come desiderato
  >VOL.: come desiderato
Impostare al Pannello CHIME: > MIC 1: ON 

B - Microfono dinamico a impugnatura, uscita bilanciata collegato all’ingresso 
IN.2– MIC con funzione VOX.
L’annuncio sarà indirizzato sul gruppo di zone riferite alla ZONE LIST secondo 
la priorità impostata.
Impostare al Pannello INPUT 2: >MODE: VOX
  >PH: OFF
  >Priority: 1 
  >Zone list come desiderato
  >VOL.: come desiderato
Impostare al Pannello CHIME: > MIC 2: OFF 

Attenzione! non collegare altre apparecchiature ai morsetti LInE 
dell’ingresso In.2.

C - Postazioni microfoniche digitali collegate in cascata all’ingresso PAGING 
UNITS). L’annuncio sarà indirizzato sulle zone riferite alla programmazione dei 
tasti delle basi stesse secondo la priorità impostata per ciascuna base.
Impostare Pannello PAGING UNITS: 
  >VOL.: come desiderato (volume generale
     della linea per tutte le basi)
Impostare al Pannello CHIME: > UNIT: ON

dimensionamento: Per ciascuna unità VAC 2006 possono essere collegate fino a massimo 16 postazioni serie PAGING UNITS. Utilizzare il cavo di 
collegamento tipo CAT. 5e SF/UTP, con trecciola di schermo. Possono essere mantenuti i seguenti limiti di collegamento:
N. 1 postazione collegata su 1 linea lunga 800m.
N. 8 postazioni distribuite su 2 linee lunghe 200m ciascuna (4 postazioni per linea).

Per impianti che prevedono distanze superiori o più postazioni collegate, sarà opportuno alimentare le postazioni con l’alimentatore aggiuntivo collegato 
alla presa locale della base. La lunghezza massima della linea di collegamento, sommando le linee collegate alle 2 prese RJ45 è di 1km; per ulteriori 
dettagli sul tipo di alimentazione, sulla formazione del cavo, sulla programmazione dei tasti di selezione, sull’impostazione delle priorità e degli indirizzi, 
fare riferimento al manuale istruzioni della postazione serie MBT.

Le unità PAGING UNITS collegabili al VAC 2006 sono di seguito elencate:
• MBt 1106: postazione di chiamata a 6 zone.
• MBt 1112: postazione di chiamata a 12 zone.

I collegamenti tra VAC 2006 e postazioni microfoniche sono da effettuarsi esclusivamente con cavi di tipo CAT. 5e SF/UTP.
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F) CoLLEGAMEnto ALIMEntAZIonE EStERnA
Ai morsetti (R12) è disponibile la connessione per un’alimentazione 
esterna a 24Vcc.

E) ContAttI d’InGRESSo Rj45 “ContRoL InPutS”
Alla presa CONTROL INPUTS (R8) sono disponibili 7 contatti, di cui 6 controllati (1÷6): in figura un esempio di collegamento.

Nota: Nell’esempio, i contatti da 1 a 6 sono controllati, mentre il contatto 7 non lo è.
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5. oPERAtIVItÀ E noMEnCLAtuRA

5.1 dEFInIZIonI GEnERALI
Di seguito un elenco delle modalità di segnalazioni delle condizioni operative del sistema e di definizioni utilizzate nei successivi paragrafi del 
manuale, completate da indicazioni di carattere generale:

5.1.1  Segnalazione delle condizioni operative
Il controller VAC 2006 è strutturato per segnalare le differenti condizioni operative come da seguenti definizioni:

“Stato di Quiete” (Led ALARM – FAuLt – dIS – SYS spenti)
Condizione operativa normale, senza guasti o emergenze in corso. Consente la gestione delle sorgenti musicali e delle sorgenti voce per 
annunci di servizio.

“Stato di Allarme” (Led ALARM acceso)
Condizione operativa che segnala la presenza di almeno un segnale di allarme, pre-registrato o a viva-voce, in corso su almeno una zona 
d’uscita. Lo “Stato di Allarme” può essere attivato da una Emergenza Automatica attivata da una periferica esterna collegata agli ingressi di 
controllo “Control Inputs” oppure da una Emergenza Manuale tramite operatore autorizzato. Durante lo “Stato di Allarme” le funzioni delle sorgenti 
musicali e delle sorgenti voce riferite allo Stato di quiete non sono operative. 

“Stato di Guasto” (Led FAuLt)
Condizione operativa che segnala la presenza di almeno un guasto in corso, rilevato dal sistema di diagnosi interna con l’accensione fissa del 
LED FAULT. 
In caso di guasto di un controller remoto, il LED FAULT lampeggia.
È accompagnato dalla segnalazione acustica di guasto (buzzer). Se le cause del guasto lo permettono, il sistema può svolgere comunque le 
funzioni relative agli stati di “quiete” e di “Allarme”. 

“Guasto di sistema” (Led SYS acceso)
Condizione operativa che segnala il blocco del sistema causato da un malfunzionamento temporaneo o permanente della CPU, rilevato dal 
watchdog di supervisione. E’ accompagnato dalla segnalazione acustica di guasto (buzzer). Durante il guasto di sistema, le funzioni riferite agli 
stati di “quiete” e di “Allarme” non sono operative.

“Stato di disabilitazione” (Led dIS acceso)
Condizione operativa che segnala l’impostazione della Disabilitazione dei segnali di Allarme per almeno una zona di uscita. Il sistema può 
svolgere comunque le funzioni riferite allo “Stato di “quiete” per tutte le zone, e, per le sole zone non disabilitate, le funzioni riferite allo “Stato 
di Allarme”. 

“Emergenza Automatica” (display ContRoL InPut StAtuS con zone attive)
sequenza di operazioni svolte da periferica esterna, collegata agli ingressi di controllo (Control Inputs), che, in base alla programmazione degli 
stessi ingressi, attiva la condizione di “Stato di Allarme” o il Reset degli allarmi.

“Emergenza Manuale” (Led del pulsante EMERGEnCY acceso/lampeggiante)
procedura di intervento sui controlli manuali del sistema, da parte di operatore autorizzato, per l’attivazione di Sorgenti d’Emergenza o il Reset degli 
Allarmi (Reset Alarm Manuale). Le operazioni svolte in Emergenza Manuale hanno priorità superiore a quelle attivate dall’Emergenza Automatica. 
Il controller VAC 2006 o la postazione d’emergenza con il led EMERGENCY acceso è abilitata all’uso per l’attivazione di Sorgenti d’Emergenza 
o il Reset degli Allarmi. Il controller VAC 2006 o la postazione d’emergenza con il led EMERGENCY lampeggiante, segnala che l’Emergenza 
Manuale è stata attivata da una postazione remota.

5.1.2  Glossario
Di seguito un elenco di definizioni utilizzate nei successivi paragrafi del manuale e completate da indicazioni di carattere generale.

“Sorgente BGM”: 
una delle seguenti sorgenti audio che impegnano il canale di amplificazione “musica” (BackGround Music):
- Sorgente audio collegata all’ingresso AUX.
- Sorgente audio collegata all’ingresso IN 1 (Microfonico) con modalità impostata MODE: IN OFF.
- Sorgente audio collegata all’ingresso IN 2 (Microfonico oppure di Linea) con modalità impostata MODE: IN OFF. 
Durante lo “Stato di Allarme” le sorgenti BGM non sono operative.

“Sorgente PA”: 
una delle seguenti sorgenti audio che impegnano il canale di amplificazione “voce” per annunci di servizio, (Public Address):
- Sorgente sonora collegata all’ingresso IN 1 (Microfonico) con modalità impostata MODE: ON o PRECEDENCE.
- Sorgente sonora collegata all’ingresso IN 2 (Microfonico oppure di Linea) con modalità impostata MODE: ON, VOX o PRECEDENCE.
- Sorgente sonora collegata all’ingresso IN 3 (Linea) con modalità impostata MODE: ON o VOX.
- Postazione d’emergenza (EMERGENCY UNITS) in modalità broadcast, postazione microfonica digitale di chiamata (PAGING UNITS).
Durante lo “Stato di Allarme” le sorgenti PA non sono operative.
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“Sorgente d’Emergenza”:
una delle seguenti sorgenti audio che impegnano i canali di amplificazione “voce” e/o “musica” per annunci di emergenza vocale (Voice 
Evacuation System): 
- Messaggio pre-registrato di Allerta (ALERT).
- Messaggio pre-registrato di Evacuazione (EVAC).
- Microfono di Emergenza (P.T.T.) collegato alla presa frontale MICROPHONE.
- Postazione Microfonica di Emergenza collegata alla presa posteriore EMERGENCY UNITS.
L’attivazione di una “Sorgente d’Emergenza” genera la condizione operativa di “Stato di Allarme”. 

“Priorità”:
L’impegno delle zone di uscita, da parte di una segnale audio o di un comando di reset è regolato gerarchicamente dal livello di priorità assegnato 
a ciascuna sorgente attiva. 
Una attivazione in corso sulla zona, può essere interrotta solo da un’altra a priorità superiore.

Il sistema VAC 2006 gestisce le priorità come da seguenti tabelle:

Priorità Condizione 
del sistema

Ambiente
operativo

Livello
Priorità

Sorgente
attiva

Per impostazioni vedi  
MEnu

alta

bassa

“Stato d’Allarme”

Emergenza 
Manuale

15 VAC 2006 con microfono d’emergenza a bordo Impostazione fissa

da 8 a 14 Postazioni microfoniche d’emergenza Vedi manuale postazioni FMD 2001, FMD 2012

Emergenza 
Automatica

7 CONTROL INPUT per funzione Reset Impostazione fissa

6 CONTROL INPUT per messaggio EVAC Impostazione fissa

5 CONTROL INPUT per messaggio ALERT Impostazione fissa

Priorità Condizione 
del sistema

Ambiente
operativo

Livello
Priorità

Sorgente
attiva

Per impostazioni vedi  
MEnu

alta

 

bassa

“Stato di Quiete”

Sorgente
PA

da 8 a 14 Postazioni d’Emergenza in modalità broadcast Vedi manuale postazioni

da 1 a 7

Ingressi IN 1 - IN 2 con funzione
PRECEDENZA o VOX Vedi sezione AUDIO SETTING

PAGING UNITS  Postazioni microfoniche Vedi manuale MBT 1106, MBT 1112

Sorgente
BGM 0 Sorgente musicale Impostazione fissa

Le sorgenti attive in condizione di “Stato d’Allarme” hanno sempre priorità superiore a quelle attive in “Stato di Quiete”, indipendentemente dal livello di 
priorità impostato.
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5.2  dotAZIonI E CARAttERIStICHE FunZIonALI

5.2.1 Controller VAC 2006

Pannello frontale
F1. Pulsante Emergency con Led (rosso)
 Pulsante incassato per l’attivazione della modalità di Emergenza Manuale. Permette l’accesso al sistema, con priorità assoluta, dallo 

“Stato di quiete” o durante l’Emergenza Automatica in corso, precedentemente attivata da periferiche esterne. Il LED, normalmente 
spento, sarà acceso durante la modalità di Emergenza Manuale attivata dalla propria unità; il led lampeggiante indica lo stato d’Emergenza 
Manuale attivata da una postazione microfonica d’emergenza o da un controller remoto. Il pulsante EMERGENCY sarà utilizzato anche 
per l’uscita dall’Emergenza Manuale. Il pulsante è controllato dal sistema di diagnosi interno.

F2. Microfono d’emergenza
 Microfono palmare con tasto di attivazione Push to Talk (P.T.T.) per annunci di emergenza a viva-voce. Il microfono è operativo solo in 

condizioni di Emergenza Manuale ed è prioritario sui messaggi pre-registrati di emergenza. La capsula del microfono è controllata dal 
sistema di diagnosi interno. Utilizzare esclusivamente il microfono fornito in dotazione, collegato senza prolunghe alla presa XLR sul pannello 
frontale del VAC 2006.

F3. dISPLAY grafico
 Display grafico retroilluminato monocromatico da 128x64 pixel, per la visualizzazione delle molteplici finestre di gestione, che saranno a 

contenuto variabile in base alle condizioni operative di riposo o di emergenza del sistema. In abbinamento alla Manopola (+/-) e ai tasti 
multifunzione, aiuta la navigazione fra i menu, la regolazione dei parametri di lavoro, la gestione delle funzioni avanzate e l’indicazione 
aggiuntiva di tutte le informazioni richieste, per gli stati di Guasto, Disabilitazione e Voice Alarm, che non sono completamente segnalate 
dai led di stato previsti.

Pannello posteriore
R1. Interruttore PoWER
 Interruttore di accensione del sistema VAC 2006. In posizione O (OFF) il sistema è spento, in posizione I (ON) il sistema è acceso. L’interruttore 

è operativo solo sull’alimentazione principale 230Vca (consultare i paragrafi “Alimentazione e messa a terra” e “Note di sicurezza” per 
dettagli sulla sicurezza).

R2. EMERGEnCY unItS 
Ingressi per il collegamento delle postazioni microfoniche di emergenza remote. Utilizzare esclusivamente le postazioni microfoniche 
FBT FMD 2001 e/o FMD 2012. Prese RJ45 per collegamento con cavo CAT.5e SF/UTP con calza di schermo e connettore schermato 
STP (per i dettagli di collegamento far riferimento al manuale delle postazioni cod. FBT 37359).  Il collegamento delle EMERGENCY 
UNITS deve essere realizzato a catenella (daisy-chain): le 2 linee di collegamento A e B possono essere lunghe, sommate in totale, fino 
a 1 km (ognuna).

R3. VAC 2006 LInK Prese per il collegamento tra controller VAC 2006 (fino a 6)  
 Connessioni per collegamento tra più controller. Utilizzando sia il LINk A che il LINk B si ottiene una connessione ridondante che mantiene 

operativo il sistema anche se viene a mancare una delle due connessioni. In caso di più controller all’interno dello stesso rack, è possibile 
utilizzare una sola connessione LINk (A o B): a tal proposito, è necessario disattivare il remote link test non utilizzato:

  o Percorso: HOME / CONFIGURATION / set> BACkGROUND TEST / 2-Voice Alarms / 6-Remote Link > Link Test
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R4. PAGInG unItS
 Ingresso per il collegamento di postazioni microfoniche di chiamata (MBT 1106, MBT 1112) per le funzioni di servizio broadcast. Possono 

essere collegate in totale fino a 16 Unità di Paging. Prese RJ45 (n.2) per collegamento con cavo CAT.5e SF/UTP con calza di schermo e 
connettore schermato STP. Il collegamento delle Paging Units deve essere realizzato a catenella (daisy-chain) le 2 linee di collegamento 
possono essere lunghe, sommate in totale, fino a 1 km.

R5. In. 2 – MIC. / LInE e MoRSEtto dI PRECEdEnZA
 Ingresso INPUT 2 bilanciato per microfono o sorgente esterna, programmabile come sorgente Musica o come sorgente Voce. Utilizzare 

l’ingresso MIC. Per il collegamento di microfoni dinamici o elettrete abilitando l’alimentazione phantom, oppure in alternativa, l’ingresso a 
morsettiera per sorgenti a livello linea tipo mixer o postazioni microfoniche preamplificate. La programmazione della modalità di funzionamento 
permette molteplici impostazioni dell’ingresso: 

 - come sorgente voce abilitato da contatto di precedenza (PREC.), con CHIME attivabile/disattivabile. 
 - come sorgente voce ad attivazione automatica VOX con regolazione della soglia di intervento, del tempo di rilascio, ed eventuale CHIME 

attivabile/disattivabile.
 quando utilizzato come sorgente voce può essere impostata la priorità, regolabile su 7 livelli, e il gruppo delle zone di chiamata. 
 Non utilizzare contemporaneamente gli ingressi MIC. e LINE dell’ingresso IN. 2, bensì:
 -  La presa XLR-F per il collegamento di segnale bilanciato fino a 100mV, oppure
 -   La presa con 3 morsetti per fili a spelare, HOT-COM-GND per il collegamento di segnale bilanciato fino a 1.8V.
 In entrambi i casi, utilizzare cavo microfonico bilanciato schermato. Per i dettagli sulle impostazioni dell’ingresso IN. 2, fare riferimento alle 

indicazioni riportate nei Menu MUSIC ed AUDIO SETTING > INPUT 2 e CHIME. 
MoRSEttIERA dI PRECEdEnZA
Morsettiera per il collegamento del contatto di precedenza sulla musica in corso, per attivazione dell’ingresso IN. 1 o IN. 2 e del tono di preavviso 
(CHIME) se abilitato. La funzione di precedenza può essere utilizzata nel MIC 1 o nel MIC 2 se abilitata nei rispettivi pannelli: per i dettagli 
sulle impostazioni della precedenza, fare riferimento alle indicazioni riportate nei pannelli INPUT 1, INPUT 2 e dal Menu AUDIO SETTING.
L’attivazione si effettua mantenendo collegato il morsetto +12V al morsetto PR. tramite la chiusura di un contatto pulito o collegando il contatto 
di precedenza disponibile sui microfoni da tavolo.

R6. In. 1 – MIC 1
 Ingresso INPUT 1 per microfono esterno, programmabile come sorgente Musica o come sorgente Voce. Possono essere collegati microfoni 

dinamici o elettrete abilitando l’alimentazione phantom. La programmazione della modalità di funzionamento ne permette l’utilizzo come 
sorgente voce abilitato da contatto di precedenza (PREC.), con CHIME attivabile/disattivabile. 

 quando utilizzato come sorgente voce può essere impostata la priorità di intervento, regolabile su 7 livelli, e il gruppo delle zone di chiamata. 
La presa XLR-F permette il collegamento di segnale bilanciato fino a 100mV, da realizzare con cavo microfonico bilanciato schermato. 
Per i dettagli sulle impostazioni dell’ingresso IN. 1, fare riferimento alle indicazioni riportate nel pannello INPUT 1 (par. 8.3.4).

R7. AuX In
 Ingresso per il collegamento di una sorgente musicale esterna. N. 1 coppia di prese RCA, con conversione in monofonia, per sorgenti con 

uscite sbilanciate a livello linea. Per le regolazioni audio dell’ingresso AUX, fare riferimento alle indicazioni riportate nel Menu MUSIC.

R8. ContRoL InPutS
 n. 7 ingressi digitali monitorati per controllo da periferiche esterne. Permette l’attivazione di eventi programmati, compresa la commutazione 

del controller VAC 2006 nelle condizioni di Emergenza Vocale, che richiedono l’invio automatico di messaggi preregistrati di emergenza. 
L’attivazione è possibile tramite contatti di stato Normalmente Aperto o Normalmente Chiuso, con riporto della tensione +24Vcc fornita 
dalla presa CONTROL INPUT. E’ possibile abilitare la diagnosi della tratta di collegamento, provvedendo all’installazione di 2 resistenze 
di bilanciamento da 10kOhm in prossimità del contatto di attivazione della periferica remota (vedi schema a pag. 14).

R9. SLAVE LInK outPutS
 N. 6 linee di uscita per collegamento ad amplificatori DPU e/o sistemi d’emergenza compatti VAIE 2250 e/o router VAR 2006. 

R10. LAn
 Presa di collegamento per Local Area Networkcon protocollo TCP/IP di rete Ethernet 10/100. 

R11. RELAY 1 – RELAY 2 – RELAY 3
 n. 3 uscite a relè per segnalazione verso periferiche esterne. Il controller VAC 2006 permette la programmazione delle uscite logiche 

abbinando l’attivazione dell’uscita ad eventi di stato del sistema o per funzioni di override in emergenza o per la segnalazione dei guasti, 
dell’emergenza in corso e della disabilitazione. Tutte le uscite possono essere programmate per stato Normalmente Attivo o Normalmente 
Disattivo.  Il collegamento prevede n. 3 morsetti a vite per fili a spelare per ciascun relè, riferiti ai contatti N.O. - N.C. - Scambio. 
Nota: nel router VaR 2006 le uscite a disposizione sono 2.

R12. Morsetti per alimentazione esterna in corrente continua 24Vcc
 Morsetti per il collegamento del sistema di alimentazione ausiliaria a corrente continua 24Vcc. quando è presente l’alimentazione principale 

a 230Vac, l’alimentazione a 24Vcc non viene utilizzata. L’ingresso è protetto contro l’inversione della polarità. Consultare la sezione 
“Alimentazione e messa a terra” e “Note di sicurezza” per dettagli sulla sicurezza. N.B. Le batterie ed il caricabatterie devono essere 
installati nello stesso rack in cui è montato il controller VaC 2006. 

R13. Morsetto di terra del telaio
 Connessione di terra del telaio, permette di collegare il riferimento a telaio di altre apparecchiature per la funzione di schermatura dei 

segnali di basso livello. Non deve essere utilizzata per il collegamento di sicurezza del telaio a terra. (Consultare la sezione “Alimentazione 
e messa a terra” e “Note di sicurezza” per dettagli sulla sicurezza).

R14. Spina per alimentazione di rete 230Vac con fusibile integrato
 Spina per il collegamento dell’alimentazione di rete principale 230Vac/50-60Hz, utilizzare il cavo di rete fornito in dotazione. Il fusibile di 

rete da 500mAL, del tipo cilindrico da 20mm miniatura, deve essere sostituito solo con un altro di caratteristiche identiche (consultare 
la sezione “Alimentazione e messa a terra” e “Note di sicurezza” a pag. 8).
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5.2.2 Router VAR 2006

Pannello frontale
F4. LEd FAuLtS
 I LED FAULTS danno le seguenti indicazioni:
 • COM-SYS Se lampeggia, indica la mancanza di connessione con il controller.
 • CTRL IN  Indica un guasto degli ingressi controllati.
 • MAINS  Indica un guasto dell’alimentazione interna.
 • BATTERY Indica la mancanza di alimentazione dalla batteria.
 • GND  Ground Fault.
 • SP. Z1-3  Guasto dell’amplificatore collegato alle zone Z1 ÷ Z3.
 • SP. Z4-6  Guasto dell’amplificatore collegato alle zone Z4 ÷ Z6.
 • MUS.-SPARE Guasto dell’amplificatore musica/riserva.

F5. LEd StAtuS
 I LED STATUS danno le seguenti indicazioni:
 • ALARM  Indica la presenza di un messaggio d’emergenza vocale e/o registrato in corso (generico).
 • CTRL IN  Indica messaggio d’emergenza vocale e/o registrato in corso proveniente da uno dei contatti d’ingresso.
 • DISABLE Indica la presenza di almeno una zona per cui non è prevista la diffusione di messaggi d’emergenza.
 • FAULT  Indica la presenza di un guasto in almeno una delle 6 linee d’uscita.

F6. LEd ZonE outPut
 I LED rossi MSG indicano in tempo reale la/e zona/e in cui viene diffuso il segnale d’emergenza vocale:
 Se lampeggianti Messaggio d’allerta in corso.
 Se accesi fissi Messaggio d’evacuazione o vivavoce in corso.

 I LED gialli LInE A/B indicano:
 Se lampeggianti Guasto di zona: l’impedenza misurata sulla zona è al di fuori dei limiti impostati.
 Se accesi fissi Indica le zone in cui non è prevista la diffusione di messaggi d’emergenza (funzione DISABLE).

F7. PRoGRAM InSERtIon
 I LED danno le seguenti indicazioni:
 Se lampeggianti La zona in cui è in corso la diffusione di una chiamata broadcast (NON emergenza).
 Se accesi fissi Nella zona è attivata la musica di sottofondo (funzione possibile solo se è presente anche l’amplificatore. 

   MUS.-SPARE).
 I pulsanti permettono l’inserzione della musica di sottofondo nelle zone corrispondenti (funzione possibile solo se è presente anche  
 l’amplificatore MUS.-SPARE).

F8. LEd di stato
 LED di stato alimentazioni/chiamate:
 • EMERG.  Indica che il sistema è in stato d’emergenza.
 • CALL  Indica che è in corso una chiamata broadcast.
 • ON  Indica la presenza dell’alimentazione 230Vca.
 • BATT.  Indica la presenza dell’alimentazione esterna 24Vcc.
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5.2.3 Pannello comandi controller

Pannello posteriore
R1. Interruttore PoWER
 Vedi pagina 17.

R11. RELAY 1 – RELAY 2
 n. 2 uscite a relè per segnalazione verso periferiche esterne (vedi pagina precedente).

R12. Morsetti per alimentazione esterna in corrente continua 24Vcc
 Vedi pagina 18.

R13. Morsetto di terra del telaio
 Vedi pagina 18.

R14. Spina per alimentazione di rete 230Vac con fusibile integrato
 Vedi pagina 18.

R15. Morsetti MuSIC SPARE / SPEECH
 Morsettiera per collegamento alle uscite degli amplificatori voce e musica/spare. È possibile impostare quattro diverse configurazioni di 

collegamento.

R16. Morsetti Z1A/B÷Z6A/B
 Uscite di potenza per linee diffusori sonori. Utilizzare solo diffusori sonori con traslatore di linea a 100V tensione costante. Sono disponibili 

n. 6 zone di uscita e ciascuna zona è divisa in 2 linee A e B per la realizzazione della rete altoparlanti a doppia linea ridondante. In caso di 
corto-circuito di una linea, il sistema VAIE 2250 disattiverà l’uscita per la linea guasta, e continuerà ad alimentare l’altra linea della stessa 
zona, attivando la segnalazione di Guasto in corso. Per il collegamento delle linee 0V-100V sono disponibili n. 12 coppie di morsetti a 
vite per cavi di sezione fino a 2,5 mm2.

R17. Prese ContRoL
 • n. 7 ingressi digitali monitorati per controllo da periferiche esterne. Permette l’attivazione di eventi programmabili, nelle condizioni di 

Emergenza Vocale, che richiedono l’invio automatico di messaggi preregistrati di emergenza. L’attivazione è possibile tramite contatti di 
stato Normalmente Aperto o Normalmente Chiuso, con riporto della tensione +24Vcc fornita dalla presa CONTROL. È possibile abilitare la 
diagnosi della tratta di collegamento, provvedendo all’installazione di 2 resistenze di bilanciamento da 10kOhm in prossimità del contatto 
di attivazione della periferica remota. Il collegamento prevede una presa RJ45 con cavo CAT.5e SF/UTP.

 • n. 6 uscite open collector per il pilotaggio di relè esterni o periferiche generiche. Il sistema VAIE 2000 permette la programmazione 
delle uscite logiche abbinando l’attivazione dell’uscita ad eventi di stato del sistema o per funzioni di override in emergenza o per la 
segnalazione dei guasti dell’emergenza in corso e della disabilitazione. Le uscite possono essere programmate per stato Normalmente 
Aperto o Normalmente Chiuso e dispongono della tensione 24Vcc interna con protezione auto-ripristinante. Il collegamento prevede una 
presa RJ45 con cavo CAT.5e SF/UTP.

R18. Spine microfoniche SPEECH e MuSIC/SPARE
 • SPEECH  Collegamento agli amplificatore/i voce.
 • MUSIC/SPARE Collegamento all’amplificatore musica/spare. 

R19. Prese SLAVE LInK In/out
 Ingresso/uscita per collegamento alle corrispondenti prese del controller VAC 2006 (presa RJ45 con cavo CAT.5e SF/UTP).

C1. Altoparlante monitor/beep
 Altoparlante integrato per la segnalazione acustica di guasto rilevato (beep). Il tono di segnalazione, verrà silenziato automaticamente 

se le condizioni di guasto terminano. Inoltre, al fine di evitare inneschi per effetto Larsen, sarà tacitato dal sistema durante l’utilizzo del 
Microfono di Emergenza.

C2. Pulsante RESEt
 Tasto per il silenziamento manuale dei messaggi pre-registrati di Emergenza, operativo in ambito di Emergenza Manuale. Tasto per il 

sislenziamento del buzzer e per l’annullamento della segnalazione del guasto, operativo in condizioni di guasto in corso o guasto rientrato. 
In modalità di riposo, il tasto non è operativo.
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C3. Pulsante ALERt
 Tasto per l’invio manuale del messaggio pre-registrato di Allerta, operativo in ambito di Emergenza Manuale. In modalità di riposo, il tasto 

non è operativo.

C4. Pulsante EVAC
 Tasto per l’invio manuale del messaggio pre-registrato di Evacuazione, operativo in ambito di Emergenza Manuale. In modalità di riposo, 

il tasto non è operativo.

C5. tasto MEnu
 Tasto multifunzione per accesso alla Home, per navigazione fra i menu e per funzioni specifiche dei sottomenu indicate sul display.

C6. tasto oK
 Tasto multifunzione per conferma della selezione, per navigazione fra i menu e per funzioni specifiche dei sottomenu indicate sul 

display.

C7. tasto ESC
 Tasto multifunzione per ritorno al Menu Musica, per navigazione fra i menu e per funzioni specifiche dei sottomenu indicate sul display.

C8. tasti numerici da 1 a 6
 Tasti multifunzione, operativi in tutti gli ambiti del sistema. Sono assegnati alla selezione delle zone da zona 1 a zona 6 per il controller 

VAC 2006 in uso. Consentono di inserire la password di accesso oppure applicare le specifiche funzioni indicate sulla barra di stato del 
display.

C9. Indicazioni di stato
 • Led ALARM (rosso)
 Led di segnalazione dello “Stato di Allarme” in corso (VOICE ALARM). La condizione di VOICE ALARM può essere stata attivata sia 

automaticamente da una periferica esterna, sia manualmente dall’operatore del VAC 2006 o di una postazione microfonica di emergenza. 
Durante la condizione di VOICE ALARM, le funzioni standard di riproduzione musicale e il servizio delle sorgenti voce sono disabilitate. 
In “Stato di quiete” il led ALARM è spento.

 •  Led FAuLt (giallo)
 Led di segnalazione dello “Stato di Guasto” in corso. Indica che il sistema di diagnosi ha rilevato almeno una condizione di guasto, per 

il controller VAC 2006 in uno o per gli elementi diagnosticati collegati ad essa. In caso di condizione di guasto terminata, il led FAULT si 
spegne automaticamente e la scritta “RES”  viene riportata nel display dei Guasti (FAULTS) a segnalare che è stato rilevato un guasto 
successivamente rientrato (RESUMED); la segnalazione di FAULT RESUMED verrà spenta dopo aver completato la procedura di RESET 
FAULT MANUALE. La segnalazione di FAULT può essere attiva anche durante le funzioni standard di riproduzione musica e voce (Stato 
di quiete), e di Emergenza (Stato di Allarme), se la tipologia del guasto lo permette.

 •  Led dIS. (giallo)
 Led di segnalazione della condizione attiva di Disabilitazione delle zone di emergenza (DISABLING). La segnalazione di DISABLING 

indica che almeno una zona è stata disattivata dall’emergenza prevista in configurazione impianto e può essere attiva anche durante le 
funzioni standard di riproduzione musicale e di servizio delle sorgenti voce.

 •  Led SYS (giallo)
 Led di segnalazione della condizione di “Guasto di Sistema” (System CPU Fault) in corso. quando il led SYS è acceso, tutte le funzioni 

operative, sia standard che di emergenza sono disabilitate. 
 •  Led BAtt. (verde)
 Led di segnalazione dell’alimentazione ausiliaria 24Vcc. Il led BATT. acceso indica che l’alimentazione a tensione continua 24Vcc è 

collegata al sistema.

 •  Led on (verde)
 Led di segnalazione del controller VAC 2006 acceso e operativo. 
 Il led ON rimane acceso in caso di:
 - alimentazione 230Vac presente e interruttore POWER in ON.
 Il led ON rimane lampeggiante in caso di:
 - alimentazione 230Vac assente ed alimentazione 24Vcc presente.
 Il Led ON rimane spento nel caso di:
 - alimentazione 230Vac assente e alimentazione 24Vcc assente, oppure
 - alimentazione 230Vac presente, alimentazione 24Vcc assente ed interruttore POWER in OFF. 

C10. Manopola +/-
 Comando rotativo senza fine corsa, multifunzionale in base allo specifico menu operativo; permette lo spostamento del cursore, la 

selezione e la regolazione dei valori. In condizione di riposo, nel menu musica, è utilizzato come regolazione diretta del volume master 
di uscita del la Sorgente BGM.

C11. Presa uSB “EXt.”
 Presa USB alimentata di tipo A, per il collegamento di memorie flash esterne (previsione). 

C12. Presa uSB “to PC”
 Presa USB di tipo B, predisposizione per il collegamento del PC di gestione per uso del Software di Sistema.
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6. ConFIGuRAZIonE dELL’IMPIAnto

6.1 IntRoduZIonE
Il software Controller Manager consente di compilare e configurare l’intero sistema che si vuole realizzare. Cliccare due volte sul file “controller.
exe” per avviare il programma.

Nota: per il corretto funzionamento del programma, è necessario che il pc sia dotato di Sistema Operativo Windows 7® o superiore. 

6.2 CREAZIonE dI un nuoVo FILE PRoGEtto
Una volta avviato il programma è già possibile creare una nuova configurazione d’impianto. 
Per creare il nuovo file, selezionare File > new Project dalla barra dei menu.
Per aggiungere una descrizione al progetto, selezionare Project > Edit description e digitare nell’apposito campo (max 22 caratteri).
Per salvare il nuovo progetto, selezionare File > Save Project As: tramite la finestra di dialogo assegnare un nome al progetto ed individuare, o 
creare, la cartella di destinazione. La conferma della riuscita dell’operazione sarà indicata dalla barra di stato inferiore della finestra.

Una volta effettuate queste operazioni, è possibile iniziare la configurazione del sistema.
Per salvare il progetto aperto è sufficiente selezionare la voce File > Save Project*.

 
6.3 APERtuRA dI un PRoGEtto ESIStEntE
Per aprire un progetto precedentemente salvato, selezionare File > open Project; dalla finestra di dialogo selezionare la cartella ed il file *.prg 
desiderato.

* In qualsiasi momento è possibile passare alla compilazione di un nuovo progetto selezionando File > New Project; ovviamente, tutti i dati 
precedentemente inseriti andranno persi, in quanto il programma ripartirà da un progetto vuoto. 
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6.4 InSERIMEnto dEI ContRoLLER
Tramite il menu tools > Insert Controller aggiungere il numero di VAC 
2006 previsti nel sistema (nel nostro esempio, le unità sono 2).
Per impostazione di fabbrica, il controller con indirizzo 0 viene denominato 
“Master” e deve necessariamente esistere in ogni progetto.
 

6.5 ConFIGuRAZIonE dEL ContRoLLER
Passiamo ora alla configurazione delle singole linee per ciascun 
controller, a cominciare proprio dal Master di cui impostiamo i parametri 
per la linea 1.
Premere il pulsante LInE 1 > Configure: si apre una schermata in cui 
è possibile selezionare quale apparecchio è collegato a questa linea 
(nessuno, router VAR 2006, amplificatori DPU o sistema compatto 
VAIE 2250).

Selezionare l’opzione desiderata e cliccare su Continue >.
Ogni opzione porta ad una specifica schermata dedicata, tranne la 
voce “NONE” che riporta la linea alla condizione di non utilizzo. 

• VAR 2006 - router
Selezionando questa voce, si apre la schermata Line 1 configuration, dove è possibile selezionare caratteristiche di zone, contatti d’ingresso e 
contatti d’uscita del router. Inoltre, può essere indicata la presenza di amplificatori collegati. Una volta impostati i parametri, premere il pulsante 
End (oppure Cancel per uscire senza salvare le modifiche apportate). 

Un breve sunto delle impostazioni effettuate sarà disponibile cliccando su LInE 1 > Report. 
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• dPu - amplifiers

IMPoRtaNtE!
tutti gli amplificatori collegati ad una linea devono tassativamente essere dotati di indirizzi progressivi, dal n°1 in avanti (max 16 per 
linea); per impostare l’indirizzo di ogni singolo amplificatore, consultare il Capitolo “Impostazioni” sul libretto istruzioni della Serie 
DPU (cod. FBt 37784).

Supponiamo di impostare sulla linea 2 il collegamento agli amplificatori Serie DPU: dopo aver premuto il pulsante LInE 2 > Configure ed aver 
selezionato la voce DPU - amplifiers si apre la finestra Line 2 configuration. 

In questa finestra è possibile elencare gli amplificatori (con relativi modelli) connessi alle linee in oggetto, oltre ad indicarne la valenza di 
amplificatore di riserva; sono evidenziate, inoltre, le associazioni dei vari amplificatori alle riserve, così come selezionato in “Configurazione degli 
amplificatori di riserva” (pag. 27). Il programma guida la compilazione con lo scopo di seguire alcune regole:
- L’immissione è sequenziale a partire dall’indirizzo 1. Di conseguenza, eliminando un amplificatore a metà della lista (ovvero selezionando 

modello = “none”) verranno rimossi anche gli amplificatori di indirizzo successivo.
- Una linea può gestire fino ad un massimo di due riserve: la prima riserva inserita è di tipo “globale”, ovvero può sostituire amplificatori di 

qualsiasi altra linea del controller. La seconda riserva può essere:
 • “globale” nel caso in cui nelle linee vi siano solo due riserve;
 • “locale” nel caso in cui sulle linee vi siano ulteriori amplificatori. In questo caso la riserva può sostituirsi solo ad amplificatori appartenenti 

alla stessa linea della riserva.
Il programma effettua controlli incrociati per mantenere la compilazione corretta.

Una volta compilato quando desiderato, premere sul pulsante End per salvare la configurazione, che verrà riportata in corrispondenza della linea 
2 sulla finestra principale. In alternativa, premere Cancel per uscire senza salvare le modifiche apportate. 

• VAIE 2250 - compact
Impostiamo ora sulla linea 3 il collegament o ad un sistema compatto VAIE 2250: 
dopo aver premuto il pulsante LInE 3 > Configure ed aver selezionato la voce 
VAIE 2250 - compact si apre la finestra Line 3 configuration.

Una volta impostati i parametri di tutte le linee, passiamo alla compilazione degli 
altri quattro collegamenti riportati nella finestra principale: CTR INPUT, CTR 
OUTPUT, EMERGENCY UNITS e BROADCAST UNITS.
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• CtR InPut
Premere sul pulsante CtR InPut > Configure, si apre la 
schermata di configurazione degli ingressi del controller 0, 
dove è possibile abbinare i parametri desiderati a ciascuno 
dei 7 contatti.

Premere End per salvare la configurazione, oppure  
Canc. per annullarla e ritornare alla schermata principale.

• CtR outPut
Premere sul pulsante CtR outPut > Configure, si apre la schermata 
di configurazione delle uscite del controller 0, dove - come per gli ingressi 
- è possibile abbinare i parametri desiderati a ciascuno dei 3 contatti.

Premere End per salvare la configurazione, oppure  
Canc. per annullarla e ritornare alla schermata principale.

• EMERGEnCY unItS
Premere sul pulsante EMERGEnCY unItS > Configure, si apre 
la schermata di configurazione delle postazioni d’emergenza 
collegabili.

Per impostare una configurazione specifica ai tasti di ciascuna 
postazione d’emergenza, premere il relativo pulsante Key Conf: 
è possibile richiamare una configurazione già definita (vedi par. 
“Configurazione gruppi di zone”) oppure applicare manualmente 
modifiche alla configurazione di default che viene proposta nel 
riquadro ‘Unit key list’.

Premere End per salvare la configurazione, oppure  
Canc. per annullarla e ritornare alla schermata 
principale.
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• PAGInG unItS
Premere sul pulsante PAGInG unItS > Configure, si apre la schermata 
di configurazione delle postazioni di chiamata broadcast collegabili.
Per impostare una configurazione specifica ai tasti di ciascuna postazione 
d’emergenza, premere il relativo pulsante Key Conf: è possibile 
richiamare una configurazione già definita (vedi par. “Configurazione 
gruppi di zone”) oppure applicare manualmente modifiche alla 
configurazione di default che viene proposta nel riquadro ‘Unit key list’. 
Per fare questo, selezionare nell’elenco di destra il tasto di cui si vuole 
modificare l’impostazione, selezionare dall’elenco di sinistra la zona o 
la configurazione che si voglio abbinare e cliccare sulle frecce centrali. 
Nell’elenco di destra apparirà immediatamente il nuovo abbinamento 
selezionato.

Premere End per salvare la configurazione, oppure  
Canc. per annullarla e ritornare alla schermata 
principale.

• Configurazione gruppi di zone
Selezionare dal menu la voce View > Key configuration per aprire il prospetto completo delle zone in relazione ai controller installati nel sistema. 
La schermata evidenzia con sfondo bianco il numero di unità e zone impostate; per ciascun controller sono riportate le zone attive (colore rosso). 
Lo stato delle zone è modificabile semplicemente cliccando sul numero relativo (il numero diventa di colore verde). 
Dopo aver impostato le zone desiderate, cliccare su Save per salvare la configurazione. Per creare il successivo file di configurazione, selezionarne 
il nome dal menu a tendina e procedere come fatto precedentemente. Da questa finestra è possibile impostare fino a 64 file di configurazione, 
che possono poi essere richiamati nelle schermate di configurazione delle postazioni (vedi paragrafi precedenti).
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• Configurazione degli amplificatori di riserva
Selezionare dal menu la voce View > Spare 
configuration per aprire il prospetto completo 
degli amplificatori installati nel sistema. 

Nella colonna sinistra della schermata sono indicati 
gli amplificatori DPU inseriti precedentemente nel 
file di configurazione come riserve. Per ciascuno 
di questi è possibile indicare gli amplificatori 
che andranno a sostituire in caso di guasto: per 
fare questo, selezionare dal menu a tendina 
l’amplificatore e cliccare ‘Add’ per abbinarlo alla 
riserva.

Una volta caricato il file, è possibile indicare se 
si tratta di un messaggio che verrà inviato in 
situazioni di allerta (Alert) od evacuazione (Evac).
È inoltre possibile aggiungere una breve 
descrizione di ciascun messaggio inserito (max 
25 caratteri).

Oltre ai messaggi vocali, può essere inserito con 
la stessa procedura anche un tono di preavviso 
(Chime).

Premere End per salvare la configurazione, 
oppure chiudere la finestra per ritornare alla 
schermata principale.

• Compilazione messaggi vocali / segnale di preavviso
Selezionare dal menu la voce View > Message Compiler per aprire la schermata che consente la gestione dei messaggi vocali pre-registrati e 
dell’eventuale segnale di preavviso. Cliccare su Path > Add file e caricare il file *.wav desiderato.

Importante! I file da utilizzare devono tassativamente essere registrati e/o convertiti in formato audio *.WAV 48 ksample 16bit. 

Una volta conclusa la configurazione del CONTROLLER 0, salvare il progetto e cliccare sul tab “CONTROLLER 1” per procedere alla 
configurazione relativa.
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• Creazione della Sd card
Una volta terminate tutte le operazioni di configurazione, è necessario riversare tutte le informazioni su una SD card che verrà poi inserita nel 
rispettivo controller. dovranno essere create tante Sd quanti controller presenti nel sistema: ogni card conterrà le informazioni relative 
al controller specifico ed al resto del sistema.

Dopo aver verificato che il CONTROLLER 0 sia spento, utilizzare un cacciavite per svitare e rimuovere il piccolo pannellino presente al centro 
del pannello posteriore.

A questo punto la schermata principale del programma mostra la maggior parte delle impostazioni effettuate:  

È possibile ottenere un report completo e stampabile di tutte le impostazioni semplicemente cliccando sui pulsanti ‘Ctr configuration report’, ‘Zone 
configuration report’ e ‘Spare configuration report’.

Inserire la SD nell’apposito lettore del PC e selezionare quindi la schermata del CONTROLLER 0. Dal menu principale selezionare la voce tools 
> Create SD: la scheda verrà formattata e quindi automaticamente programmata con i dati necessari.
Terminata la scrittura, estrarre la SD card dal PC ed inserirla nell’apposita slot sul pannello posteriore del CONTROLLER 0; riposizionare il 
pannellino di copertura e fissarlo nuovamente con le viti precedentemente rimosse.

Ripetere queste operazioni per tutti gli altri controller (nel nostro esempio, il CONTROLLER 1).
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7.   StRuttuRA dEI MEnu

Il VAC 2006 permette l’accesso alle funzioni del sistema tramite una serie di Pannelli di Gestione raggruppati, secondo tipologia operativa e 
destinazione d’uso, in Menu Opzioni accessibili dalla HOME; inoltre i seguenti Menu Opzioni sono stati assegnati a differenti livelli d’accesso, 
in riferimento alle varie circostanze che richiedono diversi gradi di competenza e di autorizzazione del personale preposto.

• Menu < MuSIC >
Finestra di default per l’utilizzo del sistema nelle normali condizioni dello Stato di quiete, permette i controlli delle sorgenti BGM e la regolazione 
dei volumi della sezione musica. Il menu resta inaccessibile durante lo Stato di Allarme. In questo livello di base, i tasti RESET, ALERT e EVAC 
non sono operativi.

• Menu < AudIo SEttInG >
Gruppo di opzioni di livello base per condizioni operative standard. Dedicato all’utenza generica, per le impostazioni e le regolazioni delle sorgenti 
PA. In questo livello di base, i tasti RESET, ALERT e EVAC non sono operativi.

• Menu < InSPECtIon >  
Primo livello d’accesso, per ispezione dello stato del sistema. Dedicato al personale responsabile della verifica iniziale delle cause che hanno 
provocato lo stato di guasto o d’emergenza. In questo livello di primo accesso, il tasto RESET ha la funzione di silenziamento del cicalino di 
segnalazione FAULT. I tasti ALERT e EVAC non sono operativi.

• Menu < oPERAtoR > 
Secondo livello d’accesso, per il personale istruito ed autorizzato a gestire il sistema in condizioni d’emergenza, guasto e disabilitazione. 
Per accedere a questo menu è necessario inserire la password d’accesso relativa.

• Menu < ConFIGuRAtIon > 
Terzo livello d’accesso, per il personale istruito ed autorizzato ad operare sulle funzioni avanzate del sistema e modificare i parametri di 
configurazione, per avviamento e modifica impianto. Per accedere a questo menu è necessario inserire la password d’accesso relativa.

• Menu < SERVICE >
quarto livello d’accesso, incluso nelle opzioni del menu CONFIGURATION, per le operazioni d’assistenza tecnica, aggiornamento firmware e 
modifica dei parametri di funzionamento del sistema VAC 2006. L’utilizzo è consentito solo al personale di service tecnico fornito di opportuna 
password d’accesso.

• Menu < EMERGEnCY >
Ambiente operativo per la gestione, con priorità massima, della Emergenza Manuale. Accessibile in qualsiasi momento con il tasto espressamente 
dedicato “Emergency”, deve essere utilizzato esclusivamente da personale autorizzato e opportunamente istruito sul Piano di Emergenza ed 
Evacuazione (PEE).

Le funzioni legate a livelli con restrizioni d’accesso, per le quali può essere impostata la password, verranno evidenziate dal simbolo   

7.1 FunZIonI “HoME” -  ACCESSo AI MEnu oPZIonI
7.1.1  Livello Base - Menu MuSIC
Dopo l’accensione del sistema, viene visualizzato direttamente il Pannello di gestione MUSIC. Per accedere alla HOME premere il tasto MENU, dalla 
HOME si potranno selezionare i vari Menu Opzioni per le funzioni avanzate del sistema. Dalla pagina HOME premere il tasto ESC per tornare al 
Pannello di gestione MUSIC. 

Le funzioni legate a livelli con restrizioni d’accesso, per le quali può essere impostata la password, verranno evidenziate dal simbolo   

MEnu

ESC
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7.1.2 Livello Base - Menu AudIo SEttInG
Sulla schermata HOME, premere il tasto Ok per selezionare la voce AUDIO SETTING ed accedere al menu relativo.
Dal Menu AUDIO SETTING utilizzare la manopola a lato del display per scorrere tra le opzioni elencate e selezionare quella desiderata utilizzando 
il tasto Ok. Premere ESC per tornare al Menu MUSIC o MENU per tornare alla HOME. Per le caratteristiche specifiche di ciascun pannello di 
gestione del menu AudIo SEttInG, fare riferimento alle schede relative nella Sezione 8.3 uSo dEL SIStEMA/< Menu AudIo SEttInGS >.

7.1.3 Livello di Sistema - Menu InSPECtIon
Sulla schermata HOME, ruotare la manopola e quindi premere il tasto Ok per selezionare la voce INSPECTION ed accedere al menu relativo.
Dal Menu INSPECTION utilizzare la manopola a lato del display per scorrere tra le opzioni elencate e selezionare quella desiderata utilizzando il 
tasto Ok. Premere ESC per tornare al Menu MUSIC o MENU per tornare alla HOME. Per le caratteristiche specifiche di ciascun pannello di 
gestione   del menu InSPECtIon, fare riferimento alle schede relative nella Sezione 8.4 uSo dEL SIStEMA / < Menu InSPECtIon >.

7.1.4   Livello di Sistema - Menu oPERAtoR
 Sulla schermata HOME, ruotare la manopola e quindi premere il tasto Ok per selezionare la voce OPERATOR: per accedere al menu 

relativo è necessario inserire una password e quindi premere nuovamente il tasto Ok. In alternativa premere ESC per tornare al Menu 
MUSIC. 

 Sulla schermata 

Dal Menu OPERATOR utilizzare la manopola a lato del display per scorrere tra le opzioni 
elencate e selezionare quella desiderata utilizzando il tasto Ok. Premere ESC per tornare 
al Menu MUSIC o MENU per tornare alla HOME. Per le caratteristiche specifiche di 
ciascun pannello di gestione del menu oPERAtoR, fare riferimento alle schede 
relative nella Sezione 8.5 uSo dEL SIStEMA / < Menu oPERAtoR >.
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7.1.5   Livello di Sistema - ConFIGuRAZIonE
 Sulla schermata HOME, ruotare la manopola e quindi premere il tasto Ok per selezionare la voce CONFIGURATION: per accedere 

al menu relativo è necessario inserire una password e quindi premere nuovamente il tasto Ok. In alternativa premere ESC per tornare 
al Menu MUSIC. 

 Sulla schermata 

Dal Menu  CONFIGURATION  utilizzare la manopola a lato del display per scorrere 
tra le opzioni elencate e selezionare quella desiderata utilizzando il tasto Ok. 
Premere ESC per tornare al Menu MUSIC o MENU per tornare alla HOME. 
Per le caratteristiche specifiche di ciascun pannello di gestione del menu 
ConFIGuRAtIon/SERVICE, fare riferimento alle schede relative nella Sezione
8.6 uSo dEL SIStEMA / < Menu ConFIGuRAtIon >.

7.1.6   Livello di Sistema - SERVICE
 Accedere al Menu CONFIGURATION quindi utilizzare la manopola a lato del display per scorrere fino all’opzione <SERVICE> e premere 

Ok per selezionare: per accedere al menu relativo è necessario inserire una ulteriore password e quindi premere nuovamente il tasto 
Ok. In alternativa premere ESC per tornare al Menu MUSIC. 

 Accedere al Menu CONFIGURATION quindi utilizzare la manopola a lato del display per scorrere fino all’opzione <

Le caratteristiche funzionali dei pannelli di gestione del menu 
SERVICE sono di competenza del personale di servizio 
tecnico ed esulano dagli scopi istruttivi del presente manuale 
d’uso, pertanto non verranno di seguito illustrate.
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8. uSo dEL SIStEMA
Dopo aver effettuato tutti le connessioni, rispettando le indicazioni riportate 
nei paragrafi Dimensionamento e Collegamenti,  avviare il VAC 2006 
portando l’interruttore POWER (R1) in posizione ON; il display si illumina e 
visualizza il pannello del Menu MUSIC, dal quale è possibile accedere alla 
pagina HOME premendo il tasto MENU. 
Se il sistema è al primo utilizzo, o sono state apportate modifiche alla 
configurazione, procedere con le indicazioni riportate nella sezione 
8.1  Inizializzazione dell’impianto; se invece la procedura di inizializzazione 
è stata completata, continuare con le indicazioni di utilizzo riportate nelle 
sezioni successive:
• Per il normale utilizzo di diffusione sonora musicale e annunci microfonici gli 

utenti possono limitarsi ai menu MUSIC e AUDIO SETTING.
• Per la gestione delle funzioni avanzate in condizione di guasto, emergenza 

e configurazione, consultare i successivi Menu INSPECTION, OPERATOR, 
CONFIGURATION e EMERGENCY.

• Per il reset del “beep” consultare la Sezione OPERATOR (par. 8.5.3.1, 
pag. 49)

• Per l’invio di messaggi d’emergenza consultare la sezione EMERGENZA 
MANUALE (par. 8.7, pag. 54).

Le funzioni legate a livelli con restrizioni d’accesso, per le 
quali è necessaria una password, verranno evidenziate 
da questo simbolo. 

MENU

ESC
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8.1 InIZIALIZZAZIonE dELL’IMPIAnto
Il progetto dell’impianto audio deve essere realizzato tramite l’ausilio dell’apposito software (vedi Sezione 6. “Configurazione dell’impianto”, pag. 
22).

• Password
Dalla schermata HOME selezionare il menu CONFIGURATION e confermare con Ok, se la restrizione di accesso con password è abilitata, 
apparirà la schermata di “CONFIGURATION ACCESS”: digitare il codice a 4 cifre della password e confermare con Ok (per default la password 
è 3333, vedi pag.50).

• Silenziamento BEEP
Durante la procedura di inizializzazione, possono verificarsi segnalazioni di guasto, causate dalle differenze tra la configurazione dell’impianto 
collegato e i valori impostati di default. Per silenziare, di volta in volta, il tono di segnalazione acustica (beep) accedere al menu “report> FAULT” 
e premere il tasto RESET. Per dettagli consultare il paragrafo “FAULT” (vedi par. 8.5.3.1, pag. 49). 
 o Percorso: HOME / CONFIGURATION / report> FAULT (premere tasto RESET).
• Acquisizione impedenze
Dal menu MUSIC, impostare tutte le zone di uscita con musica “OFF”. Per dettagli consultare il paragrafo “Menu MUSIC” (vedi par. 8.2.4, pag. 
34).
Acquisire le nuove impedenze di carico delle linee diffusori, come indicato nel paragrafo “IMP. ACqUISITION” e abilitare i test impostando la 
tolleranza di misura
 o Percorso: HOME / CONFIGURATION / set> TOLERANCE / SET TOLERANCE
 o Percorso: HOME / CONFIGURATION / acquire> IMPEDANCE / IMP. ACqUISITION (premere tasto Ok)

• diagnosi alimentazione 24Vcc
Se è stata collegata l’alimentazione ausiliaria a 24Vcc, abilitare il test di diagnosi impostando “24Vdc P.S. ON” come da indicazioni riportate nel 
paragrafo “BACkGROUND TEST” (vedi par. 8.5.2.3, pag. 48). 
 o Percorso: HOME / CONFIGURATION / set> BACkGROUND TEST / 4-Power supplies

• Messaggi d’emergenza
I messaggi d’emergenza sono memorizzati nella SD card tramite software dedicato (vedi pag. 27)

• Contatti d’ingresso
In base a quanto previsto dal Piano d’Emergenza ed Evacuazione (PEE) programmare opportunamente i contatti d’ingresso tramite tramite 
software dedicato (vedi pag. 25).
 o Percorso: HOME / CONFIGURATION / set> CONTROL INPUTS

• Contatti d’uscita
In base a quanto eventualmente previsto dalle specifiche di impianto, programmare opportunamente i contatti di uscita tramite software dedicato 
(vedi pag. 25).
 o Percorso: HOME / CONFIGURATION / set> CONTROL OUTPUT

• Regolazione volume
Regolare opportunamente il volume di uscita delle sorgenti d’Emergenza al fine di ottenere la migliore intelligibilità del messaggio. Il livello 
impostato verrà utilizzato per lo ”Stato di Allarme” e sarà lo stesso per tutte le zone. Per la regolazione del volume del Microfono d’emergenza e 
dei messaggi ALERT ed EVAC seguire le indicazioni riportate nel paragrafo “ALARM LEVEL” (vedi par. 8.6.4, pag. 53).
 o Percorso: HOME / CONFIGURATION / set> ALARM LEVEL

• Reset dei guasti
Al termine della configurazione di impianto, è opportuno cancellare le segnalazioni di guasto memorizzate e rientrate (Resumed). Effettuare 
pertanto il RESET dei FAULTS come indicato nel paragrafo “FAULTS” (vedi par. 8.5.3.1, pag. 49). 
 o Percorso: HOME / CONFIGURATION / report> FAULT, accedere ai subpannelli di visualizzazione guasti 

• termine dell’inizializzazione
Dopo aver completato la procedura di inizializzazione impianto, effettuare il LOGOUT al fine di ripristinare l’eventuale restrizione di accesso con 
password (vedi par. 8.5.5, pag. 49).
 o Percorso: HOME / CONFIGURATION / Exit> Logout (premere tasto Ok).
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8.2 MEnu <MuSIC>
 Impostazione dei parametri audio delle sorgenti BGM
Pannello di controllo delle sorgenti musica, visualizzato dal VAC 2006 in condizioni di normale operatività dello “Stato di quiete”.

•  Indicazioni display
A) Volume generale d’uscita della sorgente BGM
B) Etichette di stato di ciascuna delle 6 linee:
 oFF Musica disabilitata
 ndB Musica abilitata e relativo volume d’uscita 
 CALL Chiamata in corso da parte di una sorgente “voce” (sorgente PA).
 nA  Linea non attiva.
C) Sorgente BGM selezionata per il canale “musica”.
D) Sorgente PA attiva sul canale “voce” per annunci di servizio.

nota: Il controller VAC 2006 permette di effettuare annunci di servizio da parte di una sorgente PA sulle zone desiderate, mantenendo la 
diffusione della musica sulle altre zone non interessate dalla chiamata. Durante un’annuncio in corso, il display visualizzerà quale sorgente sta 
impegnando il canale voce (E) e l’etichetta di stato di ciascuna zona selezionata (B) visualizzerà la scritta CALL. 
Gli annunci di servizio saranno diffusi al volume impostato per l’ingresso della sorgente PA (vedi menu AUDIO SETTING) e saranno 
eventualmente inviati anche alle zone con musica disattivata (OFF).

•  tasti di navigazione
MENU: accesso al pannello HOME
Ok: selezione sorgente musicale BGM
TASTI 1÷6: Selezione linee
RESET: non operativo
ALERT: non operativo
EVAC: non operativo

8.2.1  Selezione sorgente BGM canale “musica”
Premere il tasto oK per selezionare la sorgente musicale desiderata tra:
• AUX Sorgente a livello linea collegata alla presa LINE AUX IN (R7).
• REMOTE Sorgente selezionata dal VAC 2006 secondario tramite la presa REMOTE LINk.
• INPUT 1 Sorgente microfonica collegata all’ingresso IN 1 (R6).
• INPUT 2 Sorgente microfonica collegata all’ingresso IN 2 (prese LINE o MIC) (R5).
• NO INPUT Nessun ingresso selezionato. 

8.2.2  Regolazione del volume generale della sorgente BGM canale “musica”
• Per regolare il volume, agire sulla manopola +/-.
Il valore di attenuazione impostato è visibile direttamente sul display (A) con variazioni di 1dB. 
Il volume impostato viene memorizzato per ciascuna sorgente BGM selezionata. 

8.2.3  Regolazione del volume della musica per ciascuna uscita di zona
• Tenere premuto il tasto numerico della zona desiderata (da 1 a 6) e ruotare la manopola +/-.
Il volume d’uscita è regolabile su 5 livelli d’attenuazione rispetto al volume generale master (A); i passi d’attenuazione sono:
-15dB (attenuazione massima), -9dB, -6dB, -3dB, 0dB (attenuazione nulla).
Il volume impostato è riferito esclusivamente al canale “musica”. 

Nota: La regolazione non è disponibile sulle linee in cui è collegato un router VAR 2006. 

8.2.4  Attivazione e disattivazione della musica per ciascuna uscita di zona
• Premere e rilasciare il tasto numerico della zona desiderata (da 1 a 6). 
L’etichetta di stato (B) commuterà l’indicazione tra oFF (musica disabilitata) e ndB (musica ON e relativo volume d’uscita). 
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8.3    MEnu < AudIo SEttInG >
Impostazione dei parametri audio delle sorgenti PA
Menu di accesso ai pannelli di gestione dei parametri riguardanti l’audio delle 
sorgenti musica e voce.
Ruotando la manopola, scorrere tra le voci in elenco per selezionare la voce 
desiderata e confermare premendo il tasto Ok, oppure
- Premere MENU per tornare alla schermata HOME.
- Premere ESC per tornare al menu MUSICA.

Le opzioni del menu AUDIO SETTING permettono l’accesso ai seguenti pannelli:

8.3.1 set> SPEECH LEVEL
Regolazione volume delle sorgenti voce collegate al VAC 2006.

8.3.2   set> CHIME
Regolazione volume ed assegnazione alle sorgenti voce per il segnale di preavviso.

8.3.3 InPut 1 
Regolazione volume ed impostazione della modalità di funzionamento dell’ingresso IN 1 (MIC.).

8.3.4 InPut 2
Regolazione volume ed impostazione della modalità di funzionamento dell’ingresso IN 2 (MIC. o LINE).

8.3.1 Set> SPEECH LEVEL
 Gestione delle sorgenti voce
Pannello per l’impostazione dei livelli delle sorgenti voce collegate al VAC 2006:

1- Emerg.unit Postazioni d’emergenza Serie FMD.
2-Broad. unit Postazioni broadcast Serie MBT.
3-Mic 1 input Microfono collegato alla presa MIC 1 IN.
4-Mic 2 input Microfono collegato alla presa MIC 2 IN.
5-From remote Altri controller collegati alle prese VAC 2006 LINk.

•   Regolazione del volume:
Tenere premuto il tasto numerico corrispondente alla sorgente e ruotare la manopola 
+/- per regolare il volume (range -80÷0 dB).

8.3.2 set> CHIME
 Gestione del segnale di preavviso (din-don)
Pannello per l’impostazione del din-don che viene emesso all’attivazione di una sorgente 
voce.

•   Attivazione del tono di Chime: 
Premere e rilasciare i tasti 2,3,4 per impostare il segnale di preavviso delle rispettive 
sorgenti:
2-Emerg. unit call: Postazioni d’emergenza FMD 2001 e FMD 2012 per gli annunci 

broadcast collegate alla presa “EMERGENCY UNITS”.

3-Brd. unit call:  Postazioni microfoniche serie MBT 1106 e MBT 1112 collegate 
alla presa “PAGING UNITS” 

4-Preced. call: Ingressi programmati per attivare l’annuncio tramite contatto di 
Precedenza o VOX.

Valori di riferimento:
on=Chime attivo
oFF=Chime disattivo

•   Regolazione del volume tono di Chime:
Tenere premuto il tasto 1 e regolare il volume con la manopola +/- nella gamma di valori da 0 a 255; il volume è comune per i tutti gli ingressi ed 
è indipendente dalle regolazioni di volume assegnate alle sorgenti.

•   Caricamento del tono di Chime:
Il file audio del Chime è gestito dal software dedicato (vedi pag. 27). 
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8.3.4 InPut 1 
 Gestione della sorgente all’ingresso In 1
Tenere premuto il tasto numerico corrispondente alla funzione e ruotare la 
manopola +/- per regolare l’impostazione.
• 1-Mode: impostazione della modalità di funzionamento dell’ingresso per 

l’impegno del canale voce come sorgente PA. 
  Tenere premuto il tasto 1 (Mode) e ruotare la manopola +/- per 

selezionare la modalità desiderata fra le seguenti:
  >  on:
   l’ingresso è collegato direttamente come sorgente voce ed è 

operativo in base alla priorità ed alla lista zone selezionata.

I tasti RESET, ALERT, EVAC, MENU ed Ok non sono operativi.
Premere ESC per tornare al menu AUDIO SETTING.

   > VoX lev. 1÷7:
   l’ingresso è impostato come sorgente voce a precedenza automatica attivata dalla presenza del segnale audio in ingresso.  

La precedenza si attiva quando il segnale audio supera il livello di soglia impostato. Possono essere scelti fino a 7 livelli crescenti 
della soglia d’intervento. La regolazione accurata della soglia permetterà di ottenere una pronta diffusione del segnale, evitando 
che il rumore indotto sul cavo attivi involontariamente la precedenza.

   > Precedence:
   l’ingresso è abilitato alla diffusione come sorgente voce tramite contatto di consenso collegato ai morsetti di precedenza.

  > off: ingresso disabilitato per funzione di annuncio PA, la sorgente collegata resta disponibile per la selezione come sorgente 
BGM.

• 2-Zone call: impostazione della modalità di funzionamento dell’ingresso per l’impegno del canale voce come sorgente PA. 
 Tenere premuto il tasto 2 (Zone call) e ruotare la manopola +/- per selezionare la modalità desiderata fra le seguenti:

    > Z. 1 ÷ Z. 216:  selezione della zona specifica su cui inviare la diffusione sonora.
    > All:  seleziona l’invio della diffusione su tutte le zone del sistema.
    > C. 1 ÷ Z. 64: selezione di una configurazione di gruppi di zone predeterminata (creata tramite software controller.exe) su 

cui inviare la diffusione sonora.
• 3-Hold on: impostazione del tempo di rilascio, a termine del segnale in ingresso, quando viene selezionata la modalità VOX. 
  Tenere premuto il tasto 3 (Hold on) e ruotare la manopola +/- per scegliere la durata tra 1sec e 99sec. 

• 4-Priority: priorità assegnata all’ingresso quando utilizzato come sorgente voce per annuncio di servizio. Sono disponibili 7  livelli di priorità; 
l’ingresso è soggetto al muting da parte di un’altra sorgente voce a priorità superiore. Tenere premuto il tasto 4 (Priority) e ruotare 
la manopola +/- per scegliere il livello desiderato.

• 5-Sensitivity: regolazione della sensibilità. Premere il tasto 5 (Sensitivity) per scegliere il livello desiderato (tra 0, 6, 12 o 18 dB).

• 6-Phantom: Condizione impostata dell’alimentazione Phantom (OFF=disattiva / ON=attiva). Per cambiare impostazione, premere e rilasciare 
il tasto 6 (Phantom).

8.3.3 set> REMotE MuSIC
 Gestione della musica verso altri controller
Pannello che consente l’abilitazione/disabilitazione della diffusione di musica 
su altri controller collegati alle linee LINk A e B. Si consiglia di attivare questa 
funzione su di un solo controller all’interno del sistema.

Valori di riferimento:
on=Funzione attiva
oFF=Funzione disattiva

I tasti RESET, ALERT, EVAC, MENU ed Ok non sono operativi.
Premere ESC per tornare al menu AUDIO SETTING.
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8.3.4 InPut 2 
 Gestione della sorgente all’ingresso In 2
Tenere premuto il tasto numerico corrispondente alla funzione e ruotare la 
manopola +/- per regolare l’impostazione.
• 1-Mode: impostazione della modalità di funzionamento dell’ingresso per 

l’impegno del canale voce come sorgente PA. 
  Tenere premuto il tasto 1 (Mode) e ruotare la manopola +/- per 

selezionare la modalità desiderata fra le seguenti:
  >  on:
   l’ingresso è collegato direttamente come sorgente voce ed è 

operativo in base alla priorità ed alla lista zone selezionata.

I tasti RESET, ALERT, EVAC, MENU ed Ok non sono operativi.
Premere ESC per tornare al menu AUDIO SETTING.

   > VoX lev. 1÷7:
   l’ingresso è impostato come sorgente voce a precedenza automatica attivata dalla presenza del segnale audio in ingresso.  

La precedenza si attiva quando il segnale audio supera il livello di soglia impostato. Possono essere scelti fino a 7 livelli crescenti 
della soglia d’intervento. La regolazione accurata della soglia permetterà di ottenere una pronta diffusione del segnale, evitando 
che il rumore indotto sul cavo attivi involontariamente la precedenza.

   > Precedence:
   l’ingresso è abilitato alla diffusione come sorgente voce tramite contatto di consenso collegato ai morsetti di precedenza.

  > off: ingresso disabilitato per funzione di annuncio PA, la sorgente collegata resta disponibile per la selezione come sorgente 
BGM.

• 2-Zone call: impostazione della modalità di funzionamento dell’ingresso per l’impegno del canale voce come sorgente PA. 
 Tenere premuto il tasto 2 (Zone call) e ruotare la manopola +/- per selezionare la modalità desiderata fra le seguenti:

    > Z. 1 ÷ Z. 216: selezione della zona specifica su cui inviare la diffusione sonora.
    > All:  seleziona l’invio della diffusione su tutte le zone del sistema.
    > C. 1 ÷ Z. 64: selezione di una configurazione di gruppi di zone predeterminata (creata tramite software controller.exe) su 

cui inviare la diffusione sonora.
• 3-Hold on: impostazione del tempo di rilascio, a termine del segnale in ingresso, quando viene selezionata la modalità VOX. 
  Tenere premuto il tasto 3 (Hold on) e ruotare la manopola +/- per scegliere la durata tra 1sec e 99sec. 

• 4-Priority: priorità assegnata all’ingresso quando utilizzato come sorgente voce per annuncio di servizio. Sono disponibili 7  livelli di priorità; 
l’ingresso è soggetto al muting da parte di un’altra sorgente voce a priorità superiore. Tenere premuto il tasto 4 (Priority) e ruotare 
la manopola +/- per scegliere il livello desiderato.

• 5-Sensitivity: regolazione della sensibilità. Premere il tasto 5 (Sensitivity) per scegliere il livello desiderato (tra 0, 6, 12 o 18 dB).

• 6-Phantom: Condizione impostata dell’alimentazione Phantom (OFF=disattiva / ON=attiva). Per cambiare impostazione, premere e rilasciare 
il tasto 6 (Phantom).
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8.4 MEnu < InSPECtIon >
Pannello di selezione opzioni, per ispezione dello stato del sistema. Dedicato al 
personale responsabile alla verifica iniziale delle cause che hanno provocato lo 
stato di guasto o d’emergenza. 

Ruotando la manopola, scorrere tra le opzioni in elenco:

• report > FAuLtS   
• report > IMPEdAnCE
• report > ConFIG.
• status > ContRoL InP.
• test > IndICAtoRS
< oPERAtoR >
< ConFIGuRAtIon >

Selezionare la voce desiderata premendo il tasto Ok oppure
- premere ESC per tornare alla schermata MUSIC.
- premere MENU per tornare alla schermata HOME.

Le opzioni del menu INSPECTION permettono l’accesso ai seguenti pannelli di gestione:

8.4.1 pannello FAuLtS (da opzione report> FAuLtS)
Interrogazione sullo stato dei guasti in corso o accaduti e rientrati.

8.4.2 pannello IMP. REAL tIME (da opzione report> IMPEdAnCE)
Visualizzazione delle impedenze di linea rilevate dal sistema in tempo reale, con indicazione percentuale dello scostamento dal valore 
memorizzato in fase di acquisizione durante l’installazione dell’impianto.

8.4.3 pannello CtR ConFIGuRAtIon (da opzione report> ConFIG)
Visualizzazione della configurazione di sistema.

8.4.4 pannello ContRoL InPut StAtuS (da opzione status> ContRoL InPut)
Visualizzazione in tempo reale dello stato dei contatti di ingresso a bordo del VAC 2006 che possono attivare l’Emergenza Automatica.

8.4.5 pannello IndICAtoRS tESt (da opzione test> IndICAtoRS)
Verifica della funzionalità degli elementi di segnalazione visivi e sonori per le operazioni che interessano l’emergenza (altoparlante BEEP, 
display e LED).

< oPERAtoR >
Passaggio diretto al menu OPERATOR vedere par. 8.5, pag. 46.

< ConFIGuRAtIon >
Passaggio diretto al menu CONFIGURATION vedere par. 8.6, pag. 50.
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8.4.1 FAuLtS
 Visualizzazione degli elementi in guasto 
Vengono elencati 6 gruppi con indicazione generica dello stato di guasto.
Le categorie degli elementi in guasto e la segnalazione generica di stato sono 
riportati nella tabella sottostante.
Premere il tasto  numerico (1-6) corrispondente per selezionare il sub-pannello di 
opzione e visualizzare il dettaglio del guasto come da paragrafi successivi
oppure 
premere ESC per tornare al pannello INSPECTION.

8.4.1.1 Silenziamento automatico del segnale sonoro (beep) per guasto rientrato
quando la causa del guasto termina prima che il buzzer venga silenziato manualmente (vedi Menu OPERATOR, par. 8.5.3.1, pag. 49) il VAC 
2006 spegne automaticamente il buzzer, spegne il Led FAULT e riporta la scritta RES (Resumed) nell’etichetta dell’elemento che era in FAULT 
. La segnalazione di Resumed rimarrà in memoria fino a quando verrà effettuato il RESET MANUALE della segnalazione di guasto accedendo 
al pannello FAULTS da Menu OPERATOR.

Etichetta Categorie di diagnosi Vedi pannello Segnalazione Causa

1-Loudspk Line Linee diffusori LOUDSPk. LINE FAULT

TU
TT

I

Ok Nessun guasto2-Voice Alarms Sorgenti d’emergenza VOICE ALARMS FAULT

3-Amplifiers Amplificatori di potenza
Ground fault linee altoparlanti AMPLIFIER FAULTS

4-Power Supply Alimentazioni primaria e secondaria
Memoria gestione display POWER SUPPLY FAULTS FAULT Almeno 1 guasto rilevato  

in corso

5-Control Input Contatti d’ingresso locali CONTROL INPUT FAULT
RES Almeno 1 guasto rientrato  

e nessun guasto in corso6-Communication Comunicazione dati interna  
al VAC 2006 COMMUNICATION FAULT

Tab. 8.4.1.1
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8.4.1.2 LoudSPK. LInE FAuLt
 diagnosi delle linee diffusori sonori
Dal Pannello FAULTS (par. 8.4.1) premere il tasto numerico 1 ed accedere al 
pannello di visualizzazione della diagnosi delle linee diffusori: per ciascuna 
linea di uscita viene segnalato lo stato di diagnosi come da seguente 
tabella.

Premere ESC per tornare al pannello FAULTS.

Etichetta Elementi in 
diagnosi Segnalazione Causa operazione richiesta

TU
TT

I

OK Nessun guasto -

Line 1 Diffusori 
Linea 1 Short A Corto circuito per la linea collegata all’uscita A

Eliminare il corto circuito ed 
effettuare il RESET MANUALE della 
segnalazione di GUASTO (da Menu 
OPERATOR)

Line 2 Diffusori 
Linea 2 Short B Corto circuito per la linea collegata all’uscita B

Line 3 Diffusori 
Linea 3 Short A+B Corto circuito per entrambe le linee della zona 

(nota1)

Line 4 Diffusori 
Linea 4 Impedance Hi

Impedenza rilevata con valore superiore 
al valore acquisito ed oltre la tolleranza 
impostata in fase di configurazione (nota2)

Verificare il collegamento dei diffusori 
sonori ed eventualmente ripetere la 
procedura d’acquisizione delle linee 
(ACQUIRE IMPEDANCE)Line 5 Diffusori 

Linea 5 Impedance Low
Impedenza rilevata con valore inferiore 
al valore acquisito ed oltre la tolleranza 
impostata in fase di configurazione (nota2)

Line 6 Diffusori 
Linea 6 Res. imp. Hi Guasto rientrato per precedente segnalazione 

di “Impedance Hi”
Accedere al pannello report > FAULTS 
da Menu OPERATOR ed effettuare il 
RESET MANUALE della segnalazione 
di GUASTORes. imp. Low Guasto rientrato per precedente segnalazione 

di “Impedance Low”

Nota1:
Per azzerare lo short A+B e quindi ripristinare l’amplificatore sulla linea, è sufficiente premere il tasto RESET.

Nota2:
I guasti “Impedance Hi” ed “Impedance Low” non vengono segnalati se la tolleranza di controllo impostata è superiore alla variazione dell’impedenza 
misurata o se il test è disabilitato. Per dettagli sulla programmazione vedere il pannello SET TOLERANCE (par. 8.6.2, pag. 51).

8.4.1.3 VoICE ALARMS FAuLt
 diagnosi delle sorgenti d’Emergenza
Dal Pannello FAULTS (par. 8.4.1) premere il tasto numerico 2 ed accedere 
al pannello di visualizzazione della diagnosi delle sorgenti d’Emergenza. 
Per ogni elemento sorvegliato viene segnalato lo stato di diagnosi come da 
seguente tabella.

Per accedere ai sub-pannelli, premere i tasti numerici corrispondenti.

Premere ESC per tornare al pannello FAULTS.

Tab. 8.4.1.2
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Etichetta Elementi in diagnosi display Causa operazioni richieste

Tutti Tutti

Ok Nessun guasto -

N.T.

NO TEST. Diagnosi disabilitata 
in fase di configurazione (vedi  
Menu set> BACkGROUND 
TEST)

-

Res. Guasto rientrato per precedente 
segnalazione di Fault

Accedere al pannello report> FAULTS da Menu 
OPERATOR ed effettuare il RESET MANUALE 
della segnalazione di GUASTO.

1-Local emerg. Microfono palmare guasto e 
Pulsante d’Emergenza Fault Microfono palmare guasto o 

Pulsante d’Emergenza guasto

Verificare che il microfono sia inserito 
correttamente nella presa frontale.  
Se il guasto permane, contattare l’Assistenza.

2-Configuration SD card Fault Errore della SD card o 
Errore nella lettura dei messaggi

Verificare che la SD card sia inserita 
correttamente nell’apposito vano sul pannello 
posteriore del controller.

3-Emerg. Unit Postazioni microfoniche 
d’emergenza Fault Almeno una postazione 

microfonica d’emerg. in guasto.

Verificare che il microfono della postazione sia 
inserito correttamente. Se il guasto permane, 
contattare l’Assistenza 

4-Messages

Registratore/riproduttore del 
Messaggio d’Emergenza di
EVACUAZIONE ed
ALLERTA

Fault Presenza di due o più guasti.
Verificare che la SD card sia inserita 
correttamente nell’apposito vano sul pannello 
posteriore del controller.

5-Line connect.

Connessione CAT5 con: 
- DPU 
- VAR 
- AMP
 

Fault

Errore di comunicazione

Verificare le connessioni. Se il guasto permane, 
contattare l’Assistenza

6-Remote Link Intercomunicazione con 
VAC 2006 remoti Fault

Premere il tasto 6 per accedere al sub-pannello 
dedicato “LINK FAULTS”. Verificare i cavi di 
collegamento fra i VAC 2006 per la connessione 
VAC 2006 LINK. 
Se il guasto permane, contattare l’Assistenza.

Tab. 8.4.1.3
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8.4.1.4 AMPLIFIER FAuLtS
 diagnosi degli amplificatori di potenza e Gnd fault
Dal Pannello FAULTS (par. 8.4.1) premere il tasto numerico 3 ed accedere 
al pannello di visualizzazione della diagnosi degli amplificatori di potenza e 
ground fault linee altoparlanti. 
Per ogni elemento sorvegliato viene segnalato lo stato di diagnosi come da 
seguente tabella. 

Premere ESC per tornare al pannello FAULTS.

Etichetta Elementi in 
diagnosi display Causa operazioni richieste

Tutti Tutti

Ok Nessun guasto -

N.T.

NOT TEST. Diagnosi 
disabilitata in fase di 
configurazione (vedi Menu 
set> BACkGROUND TEST)

-

Res.
Guasto rientrato per 
precedente segnalazione di 
Fault

Accedere al pannello report> FAULTS da 
Menu OPERATOR ed effettuare il RESET 
MANUALE della segnalazione di GUASTO.

Amplifier n

Amplificatori Serie DPU 
collegati al controller o 
Amplificatori MPA 
5240/48 collegati al router

Amp ok -

Input 20kHz 
Verifica l’integrità del 
collegamento tra controller ed 
amplificatore

Verificare i collegamenti tra controller, 
amplificatpre e router siano effettuati 
correttamente.
Se il guasto permane, contattare l’Assistenza.

Out 20kHz 
Verifica la presenza di 
segnale in uscita alla linea

Verificare che l’amplificatore sia collegato 
alla rete ed acceso.
Se il guasto permane, contattare l’Assistenza.

Gnd Fault 
Verifica l’isolamento tra le 
linee altoparlanti e la terra.

Verificare le connessioni delle linee 
altoparlanti. Se il guasto permane, contattare 
l’Assistenza.

Tab. 8.4.1.4
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8.4.1.5 PoWER SuPPLY FAuLtS
 diagnosi delle alimentazioni
Dal Pannello FAULTS (par. 8.4.1) premere il tasto numerico 4 ed accedere 
al pannello di visualizzazione della diagnosi delle alimentazioni primaria, 
secondaria e della memoria di gestione del Display.

Per ogni elemento sorvegliato viene segnalato lo stato di diagnosi come da 
seguente tabella.

Premere ESC per tornare al pannello FAULTS.

Etichetta Elementi in diagnosi Causa operazioni richieste

Tutti Tutti

Ok Nessun guasto -

N.T.

NOT TEST. Diagnosi disabilitata 
in fase di configurazione (vedi 
Menu set> BACkGROUND 
TEST)

-

Res. Guasto rientrato per precedente 
segnalazione di Fault

Accedere al pannello report> FAULTS 
da Menu OPERATOR ed effettuare il 
RESET MANUALE della segnalazione di 
GUASTO.

  Contr. mains
Alimentazione primaria 
controller
@230Vca

Fault

Alimentazione primaria del 
controller non rilevata

Controllare l’alimentazione 230Vca, il cavo 
di collegamento ed il fusibile di rete.
Se il guasto permane, chiamare 
l’Assistenza.

  Contr. 24VDC
Alimentazione 
secondaria controller
@24Vcc

Alimentazione secondaria 
del controller non rilevata

Controllare il sistema d’alimentazione 
esterna a 24Vcc.
Se il guasto permane, chiamare 
l’Assistenza.

  3-Rtr/VAI mains
Alimentazione primaria 
router/VAIE 2250
@230Vca

Alimentazione primaria del 
router o del VAIE 2250 non 
rilevata

Controllare l’alimentazione 230Vca, il cavo 
di collegamento ed il fusibile di rete.
Se il guasto permane, chiamare 
l’Assistenza.

  4-Rtr/VAI 24VDC
Alimentazione 
secondaria router/VAIE 
2250 @24Vcc

Alimentazione secondaria del 
router o del VAIE 2250 non 
rilevata

Controllare il sistema d’alimentazione 
esterna a 24Vcc.
Se il guasto permane, chiamare 
l’Assistenza.

 Ctr display Display del controller Fault Rilevata anomalia sul display Contattare l’Assistenza.

 VAIE display Display del VAIE 2250 Fault Rilevata anomalia sul display Contattare l’Assistenza.

Tab. 8.4.1.5
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8.4.1.6 InPut ERRoR
 diagnosi degli ingressi di controllo locali 
Dal Pannello FAULTS (par. 8.4.1) premere il tasto numerico 5 e accedere al pannello di visualizzazione della 
diagnosi degli ingressi di controllo locali. Per ogni elemento sorvegliato viene segnalato lo stato di diagnosi 
come da seguente tabella. Premere ESC per tornare al pannello FAULTS.

8.4.2 IMP. REAL tIME  | Impedenze delle linee in tempo reale 
Pannello di verifica delle impedenze misurate in tempo reale, e variazione in percentuale rispetto al valore memorizzato durante l’avviamento, 
tramite la procedura di “Acquisizione impedenza linee”. Vengono elencate le linee impegnate e, selezionando il tasto numerico relativo, si accede 
al rispettivo pannello indicante l’impedenza misurata in ohm, riferita al parallelo delle linee A e B collegate alla linea in oggetto. 

8.4.1.7 CoMMunICAtIon FAuLt
 diagnosi della Comunicazione dati interna al VAC 2006
Dal Pannello FAULTS (par. 8.4.1) premere il tasto numerico 6 ed accedere al pannello di visualizzazione della 
diagnosi della comunicazione dati fra le sezioni interne al VAC 2006. Per ogni elemento sorvegliato viene 
segnalato lo stato di diagnosi come indicato nella tabella. Premere ESC per tornare al pannello FAULTS.

Etichetta Elementi in diagnosi display Causa operazioni richieste

I2C bus Comunicazione dati tra la CPU e tasti e 
LED del frontale Tutti Fault Guasto comunicazione interna. Chiamare l’Assistenza.

SPI Comunicazione dati tra CPU. Tutti Fault Guasto comunicazione interna. Chiamare l’Assistenza.

Tab. 8.4.1.7

Etichetta Elementi in diagnosi display Causa operazioni richieste

No input  
fault found

Contatti d’ingresso 
da 1 a 8

Lista 
vuota

Nessun guasto, oppure 
sorveglianza non abilitata per alcun 
contatto d’ingresso

-

Input in fault:

Lista 
n°ingressi

Linea di collegamento del contatto 
interrotta od in corto-circuito

Verificare l’integrità della linea di collegamento 
delle resistenze di bilanciamento e del contatto 
d’attivazione. 
Se il problema permane, scollegare la linea 
di collegamento d’attivazione e collegare una 
resistenza da 20 kW tra i morsetti di servizio +24V e 
l’ingresso di controllo.
Se il problema persiste, contattare l’Assistenza.

Inputs fault 
resumed:

Guasto rientrato per precedente 
segnalazione di fault

Accedere al pannello report> FAULTS da Menu 
OPERATOR ed effettuare il RESET MANUALE 
della segnalazione di GUASTO.

General Input 
Fault:

Lista 
vuota

Guasto di comunicazione interna fra 
CPU e stadio ingressi controllato Se il problema persiste, contattare l’Assistenza.

General Fault 
resumed:

Guasto rientrato per precedente 
segnalazione di fault

Accedere al pannello report> FAULTS da Menu 
OPERATOR ed effettuare il RESET MANUALE 
della segnalazione di GUASTO.

Tab. 8.4.1.6

Se la percentuale di variazione supera il valore di tolleranza impostato in fase di configurazione impianto, verrà segnalato il guasto “LOUDSPk 
LINE FAULT” per impedenza troppo alta o troppo bassa (Impedance Hi o Impedance Low).

Premere ESC per tornare al pannello INSPECTION.
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Nota: in caso di attivazione contemporanea di più contatti di ingresso, 
con diversa programmazione dei messaggi sulle zone, il sistema 
abiliterà, per ciascuna uscita di zona, l’evento associato avente la 
priorità superiore (vedi tabella).

Premere ESC per tornare al pannello INSPECTION.

Priorità massima Reset generale dei messaggi (RESET)

Priorità alta Messaggio pre-registrato di Evacuazione (EVAC)

Priorità bassa Messaggio pre-registrato di Allerta (ALERT)

Priorità minima Nessun evento associato (NONE)

8.4.4 ContRoL InPutS StAtuS
 Stato dei contatti di ingresso locali 
Pannello di visualizzazione dello stato dei contatti di ingresso locali (CONTROL 
INPUTS). Viene elencata la lista dei contatti di ingresso che risultano in stato di 
attivazione da periferica esterna.
Il pannello CONTROL INPUT STATUS visualizza gli ingressi attivi, sia se  ad essi 
non è associato alcun evento, sia se in fase di configurazione è stato associato un 
evento di messaggi in uscita. 
Nel caso di attivazione di un CONTROL INPUT programmato, il sistema avvierà 
lo “Stato di Allarme”, accenderà il Led ALARM e visualizzerà automaticamente il 
Pannello INPUT EMERGENCY che indicherà quale ingresso del controller ha 
attivato l’emergenza (vedi par. 8.8, pag. 56).

La funzionalità degli ingressi è definita dal firmware controller.exe.

8.4.5 IndICAtoRS tESt
 Verifica della funzionalità degli elementi di segnalazione visivi e sonori
Pannello di verifica della funzionalità dell’altoparlante BEEP, del display e dei LED di segnalazione per le operazioni che interessano l’emergenza. 
Ad eccezione del LED “ON” che rimane acceso fisso, vengono attivati in modalità lampeggiante tutti i LED del pannello frontale, compreso il 
LED del tasto EMERGENCY. Viene altresì attivata una barra orizzontale che scorre su tutto il display e viene riprodotto per circa 3 secondi 
il segnale sonoro BEEP di avvertimento. Verificare l’operatività dell’altoparlante a bordo, di tutti i LED e di tutti i pixel del display. In caso di 
malfunzionamento contattare l’Assistenza. Premere ESC per tornare al pannello INSPECTION.

8.4.3 CtR ConFIGuRAtIon
 Configurazione sistema 
Pannello di visualizzazione della configurazione del sistema, nel quale viene elencata 
una lista di tutte le unità presenti nel sistema, oltre all’indirizzo del controller:

Ctr address (indirizzo del controller in oggetto): 0 ÷ 5
System Ctr (numero di controller nel sistema): 1 ÷ 6
Emerg. unit (numero di postazioni emergenza) 1 ÷ 7
Broad. unit (numero di postazioni broadcast) 1 ÷ 16
used ctr lines (numero di linee del controller in uso utilizzate): 0 ÷ 6
confCtr v. (versione del file di configurazione del sistema) 0.n
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8.5   MEnu < oPERAtoR >
Pannello di selezione opzioni di pertinenza del 
personale istruito ed autorizzato a gestire il sistema in 
condizioni d’emergenza, guasto e disabilitazione.

Le opzioni del menu OPERATOR permettono l’accesso ai seguenti pannelli di gestione:

8.5.1 pannello SPEECH LEVEL (da opzione set > SPEECH LEVEL)
Regolazione di livello delle sorgenti voce collegate al controller.

8.5.2 pannello BACKGRound tESt (da opzione set > BACKGRound tESt)
Abilitazione e disabilitazione dei test di sorveglianza applicati agli elementi che interessano la funzionalità del sistema in condizioni di 
emergenza.

8.5.3 pannello FAuLtS (da opzione report > FAuLtS)
Interrogazione sullo stato dei guasti in corso, accaduti e rientrati come da stesse funzioni descritte alla sezione INSPECTION, in 
aggiunta questo livello consente il RESET MANUALE DELLA SEGNALAZIONE DI GUASTO. 

8.5.4 pannello FIRMWARE VERSIon (da opzione Firmware Version)
Visualizzazione della versione del firmware installato nel sistema.

< InSPECtIon >
Passaggio diretto al menu INSPECTION.

< ConFIGuRAtIon >
Passaggio diretto al menu CONFIGURATION.

8.5.5 opzione Exit > Logout
Uscita dal livello di servizio e ritorno al livello base con ripristino della password di accesso.

Se in fase di configurazione è stata abilitata la password d’accesso, verrà 
visualizzato il pannello di oPERAtoR ACCESS:
- immettere la password a 4 cifre e premere Ok per procedere, oppure 
- premer ESC per tornare alla HOME.

Per default la password è 2222.
 
Ad accesso avvenuto nel menu OPERATOR,
ruotando la manopola +/- scorrere tra le opzioni in elenco:
• set > SPEECH LEVEL
• set > BACKGRound tESt
• report> FAuLtS
• report> IMPEDANCE
• report > FAULTS
• report> CONFIG. 
• status> CONTROL INP.
• test> INDICATORS
• Firmware Version
< InSPECtIon >
< ConFIGuRAtIon >
• Exit > Logout 

Selezionare la voce desiderata premendo il tasto Ok, oppure
- premere ESC per tornare al Pannello MUSIC,
- premere MENU per tornare alla HOME.
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8.5.1 SPEECH LEVEL
 Regolazione di livello delle sorgenti voce
Pannello per la regolazione di livello delle sorgenti voce collegate al controller 
VAC 2006. Per effettuare la regolazione, premere il tasto numerico relativo alla 
sorgente desiderata e ruotare la manopola +/- .

È possibile selezionare valori nel range 0 ÷ -80dB.

Premere ESC per tornare al pannello OPERATOR.

8.5.2 BACKGRound tESt
 Impostazione dei test di sorveglianza
Pannello di abilitazione e disabilitazione dei test di sorveglianza applicati 
alle sorgenti critiche che interessano la funzionalità del sistema in condizioni 
di emergenza. Vengono elencate le categorie per la scelta dell’elemento 
sottoposto a diagnosi come da figura a lato.
•   Premere il tasto numerico corrispondente per selezionare il sub-pannello 

di opzione e visualizzare il dettaglio dell’elemento:

 > 2-Voice Alarms vedere par. 8.5.2.1
 > 3-Amplifiers vedere par. 8.5.2.2
 > 4-Power Supply vedere par. 8.5.2.3
 > 5-Control Input vedere par. 8.5.2.4
 > 6-Communication vedere par. 8.5.2.5
oppure
premere ESC per tornare al pannello OPERATOR.

8.5.2.1 VoICE ALARMS
 Impostazione dei test per sorgenti d’emergenza
Pannello di abilitazione e disabilitazione dei test di sorveglianza.
•  Premere il tasto numerico corrispondente per selezionare la voce 

desiderata per aprire il sub-menu e quindi per abilitare o disabilitare il test 
di diagnosi (on = test abilitato / off = test disabilitato):

> 1-Local Emerg. > 1-Microphone 
 > 2-Emerg. button

> 2-Configuration > 1-SD card 
 > 2-Msg table

> 3-Emerg. unit > 1-Ctr unit <1> 

> 4-Messages > 1-Evac message
 > 2-Alert message

> 5-Line connect. > 1÷6-Line n connect. 

> 6-Remote Link: > 1-Remote link A
 > 2-Remote link B
 > 3-Remote ctr

Nota: il display visualizza lo stato di programmazione impostato.
Premere ESC per tornare al pannello BACkGROUND TEST.
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8.5.2.2 AMPLIFIERS
 Impostazione dei test per amplificatori
Pannello di abilitazione e disabilitazione dei test di sorveglianza applicati 
agli amplifcatori voce e musica.
•   Premere il tasto numerico corrispondente per abilitare o 
 disabilitare il test di diagnosi (on = test abilitato / off = test disabilitato):

> 1-Ampli Line 1 (on = test abilitato / off = test disabilitato)
> 2-Ampli Line 2 (on = test abilitato / off = test disabilitato)

Nota: il display visualizza lo stato di programmazione impostato.
Premere ESC per tornare al pannello BACkGROUND TEST.

8.5.2.3 PoWER SuPPLY
 Impostazione dei test per alimentazioni
Pannello di abilitazione e disabilitazione dei test di sorveglianza applicati 
all’alimentazione primaria 230Vca, all’alimentazione secondaria 24Vcc.
•   Premere il tasto numerico corrispondente per abilitare o 
 disabilitare il test di diagnosi:

> 1-Mains P.S. (on = test abilitato / off = test disabilitato) 
> 2-24Vdc P.S. (on = test abilitato / off = test disabilitato)
> 4-Display (on = test abilitato / off = test disabilitato)

Nota: il display visualizza lo stato di programmazione impostato.
Premere ESC per tornare al pannello BACkGROUND TEST.

8.5.2.5 CoMMunICAtIon
 Impostazione test per comunicazione interna dati
Pannello di abilitazione e disabilitazione dei test di sorveglianza applicati 
alla comunicazione dei dati fra le sezioni interne al VAC 2006.
•   Premere il tasto numerico corrispondente per abilitare o 
 disabilitare il test di diagnosi:

> 1-Communication (on = test abilitato / off = test disabilitato) 

Nota: il display visualizza lo stato di programmazione impostato.
Premere ESC per tornare al pannello BACkGROUND TEST.

8.5.2.4 ContRoL InPut
 Impostazione test per ingressi controllati
Pannello di abilitazione e disabilitazione dei test di sorveglianza applicati 
agli ingressi controllati.
•   Premere il tasto numerico corrispondente per abilitare o 
 disabilitare il test di diagnosi:

> 1-Controller IN (on = test abilitato / off = test disabilitato)
> 2-Rtr/PA IN (on = test abilitato / off = test disabilitato) 

Nota: il display visualizza lo stato di programmazione impostato.
Premere ESC per tornare al pannello BACkGROUND TEST.
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8.5.3 FAuLtS 
 Visualizzazione guasti (da menu oPERAtoR)
Il menu OPERATOR consente l’accesso al pannello “FAULTS” come da 
caratteristiche illustrate nella stessa sezione del menu <INSPECTION>. La 
funzionalità aggiuntiva consentita accedendo al pannello “report> FAULTS” 
dal livello OPERATOR è il “Reset manuale della segnalazione di guasto”.

8.5.3.1 Reset manuale della segnalazione di guasto (RES)
Il Reset Manuale è necessario nei seguenti casi:
• Per cancellare la segnalazione memorizzata di RES (Resumed), in caso 

di guasto rilevato e successivamente risolto, per tutti gli altri elementi 
sorvegliati.

• Per ammutolire il buzzer.

8.5.5  Exit > Logout 
 uscita dal livello di Sistema
Al temine delle operazioni svolte, prima di tornare al Livello Base del Menu 
MUSIC, è opportuno eseguire il Logout dal Livello di Sistema del Menu 
in corso, al fine di ripristinare la password di richiesta per i futuri accessi, 
e impedire che il personale non autorizzato possa accedere alle funzioni 
avanzate del sistema.

Dall’elenco opzioni del MENU OPERATOR:

• ruotare la manopola +/- per selezionare l’opzione

 Exit> Logout
 
• premere il tasto oK

Il sistema torna al Livello Base e visualizza il pannello del Menu MUSIC. 
La richiesta della password di accesso sarà ripristinata anche per gli altri 
livelli che eventualmente erano stati visitati.
 

8.5.4 FIRMWARE VERSIon
 Visualizzazione della versione del Firmware
Pannello di visualizzazione della versione del firmware installato nel sistema. 
Vengono indicati i firmware delle 3 seguenti sezioni:

> Units software
 Software principale installato sulla CPU per la gestione delle unità.
> Zones software
 Software principale installato sulla CPU per la gestione delle zone.
> Matrix firmware
 Firmware di gestione dei segnali audio.

Per effettuare il RESET MANUALE DELLA SEGNALAZIONE DI GUASTO, dal pannello di visualizzazione generale FAULTS.
 • Premere il tasto RESEt

Al termine della procedura premere ripetutamente il tasto ESC per tornare al menu OPERATOR.
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8.6   MEnu < ConFIGuRAtIon >
Pannello di selezione opzioni di pertinenza del personale 
espressamente istruito ed autorizzato ad operare sulle funzioni 
avanzate del sistema e modificare i parametri di configurazione, 
ai fini di avviamento e manutenzione impianto. Può essere 
aggiunta una password d’accesso.

Le opzioni del menu ConFIGuRAtIon permettono l’accesso ai seguenti pannelli di gestione:
8.6.1 pannello ACQuIRE IMPEdAnCE (da opzione acquire > IMPEdAnCE)
Acquisizione e memorizzazione delle impedenze delle linee diffusori sonori. Necessario per l’inizializzazione e diagnosi del sistema.
8.6.2 pannello SEt toLERAnCE (da opzione set > IMP. toLERAnCE)
Impostazione della tolleranza di controllo dell’impedenza delle linee. quando il sistema di diagnosi rileva un’impedenza di valore oltre la 
tolleranza consentita, viene attivato lo “Stato di Guasto” (Fault Warning Condition).
8.6.3 pannello 20KHZ LEVEL SEttInGS (da opzione set > 20KHZ LEVELS)
Impostazione dei livelli di segnale di test a 20kHz nei vari canali audio.

8.6.4 pannello ALARM LEVEL (da opzione set > ALARM LEVEL)
Pannello per la regolazione del volume di uscita delle sorgenti d’Emergenza: Microfoni di Emergenza e Messaggi di Allarme.

8.6.5 pannello AMPLIFIER tESt tIME (da opzione set > AMP SEt tIME)
Impostazione dell’intervallo tra un test e l’altro negli amplificatori DPU.

8.6.6 pannello PASSWoRd (da opzione Password)
Pannello di abilitazione, disabilitazione e personalizzazione della password di accesso ai livelli di servizio del sistema.

8.6.7 pannello BEEP oPERAtIon (da opzione Beep operation)
Pannello di abilitazione, disabilitazione e personalizzazione del ‘beep’ di sistema.
 
< SERVICE > Collegamento al menu SERVICE dedicato al personale tecnico fornito di opportuna chiave d’accesso, per la modifica dei 
parametri di funzionamento del sistema VAC 2006, aggiornamento firmware e assistenza tecnica.
nota: le impostazioni del menu Service non verranno trattate nel presente Manuale.

Se in fase di configurazione è stata abilitata la password d’accesso, verrà 
visualizzato il pannello di ConFIGuRAtIon ACCESS:
- immettere la password a 4 cifre e premere Ok per procedere, oppure 
- premere ESC per tornare alla HOME.

Per default, la password d’accesso è 3333.

Ad accesso avvenuto nel menu CONFIGURATION saranno elencate 
tutte le opzioni precedentemente illustrate nei Menu “AUDIO SETTING”, 
“INSPECTION” e “CONFIGURATION” e le seguenti nuove opzioni dello 
specifico menu CONFIGURATION:

ruotando la manopola, scorrere tra le opzioni in elenco
• acquire > IMPEdAnCE
• set > IMP. toLERAnCE
• set > 20KHZ LEVELS
• set > ALARM LEVEL
• set > SPEECH LEVEL
• set> AMP SEt tIME
• set > BACKGROUND TEST
• set > CHIME
• report > FAULTS
• report > IMPEDANCE
• status > CONTROL INP.
• test > INDICATORS
INPUT 1
INPUT 2
Firmware Version
Password
Beep operation
< SERVICE >
• Exit > Logout
Selezionare la voce desiderata premendo il tasto Ok, oppure
- premere ESC per tornare al Pannello MUSIC.
- premere MENU per tornare alla HOME. 
Nei paragrafi successivi verranno illustrate le caratteristiche dei pannelli specifici del menu ConFIGuRAtIon, per le altre opzioni disponibili fare 
riferimento a quanto illustrato nelle relative sezioni precedenti. 
Al termine delle operazioni di configurazione, effettuare il logout selezionando “Exit> Logout” come descritto al paragrafo 8.5.5, pag. 49.
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8.6.1 ACQuIRE IMPEdAnCE 
 Acquisizione delle impedenze di linea
Pannello per l’acquisizione e memorizzazione delle impedenze delle linee 
diffusori sonori. Necessario per l’inizializzazione e diagnosi del sistema.

8.6.1.1 Acquisizione delle impedenze delle linee diffusori
Premessa
Prima di procedere con l’acquisizione delle impedenze accertarsi di aver 
completato i seguenti passi:
• Controllo preventivo dell’impedenza delle linee con idoneo strumento di  

misura (IMPEDENZIMETRO) e verifica delle condizioni di carico.
• Collegamento delle linee dei diffusori sonori come indicato nella sezione 

4. CONNESSIONI.

Le nuove impedenze acquisite vengono automaticamente memorizzate nel sistema e riportate nell’etichetta di ciascuna zona; l’indicazione del 
valore è in ohm e si riferisce al parallelo di entrambe le linee A e B collegate all’uscita di ciascuna zona.
I valori di impedenza residenti in memoria, saranno confrontati dal sistema di sorveglianza con i valori successivamente misurati nella routine di 
diagnosi.
Nota: Per misurare l’impedenza delle linee dei diffusori sonori, il sistema di sorveglianza previsto nel VAC 2006 utilizza un tono inudibile a 20kHz; a causa 
dell’induttanza della bobina degli altoparlanti, l’impedenza riferita a 20kHz* potrà essere notevolmente diversa da quella misurata con l’impedenzimetro 
il quale, generalmente, utilizza un tono di misura a 1kHz. Pertanto il valore acquisito dal VAC 2006 è indicativo solo come confronto per la diagnosi e 
si consiglia, invece, di attenersi al valore misurato con l’impedenzimetro per il calcolo della potenza assorbita dalle linee dei diffusori sonori ai fini del 
dimensionamento dell’impianto.
* Gli amplificatori della Serie DPU utilizzano un tono a 30Hz.
Premere ESC per tornare al menu CONFIGURATION.
Al termine della procedura, effettuare il RESET MANUALE DELLA SEGNALAZIONE DI GUASTO come descritto nel par. 8.5.3.1, pag. 49.

Dopo aver selezionato l’opzione “acquire> IMPEDANCE” dal Menu CONFIGURATION, il pannello “ACqUIRE IMPEDANCE” visualizza le 
impedenze memorizzate nell’ultima acquisizione delle linee:
    
 • premere il tasto oK

8.6.2 SEt toLERAnCE 
 Impostazione della tolleranza di controllo linee
Pannello per l’impostazione della tolleranza di controllo della impedenza 
delle linee. Nel caso in cui il sistema di diagnosi, nel confronto fra 
l’impedenza misurata in tempo reale e quella memorizzata nel sistema, rilevi 
una variazione superiore alla tolleranza impostata: verrà attivato lo “Stato 
di Guasto” (Fault Warning Condition) PER GUASTO “Impedance Low” o 
“Impedance Hi”. Per dettagli sulla segnalazione di guasto, vedi pannello 
“LOUDSPk. LINE FAULT” (par. 8.4.1, pag. 40).

8.6.2.1 Impostazione della tolleranza di misura delle linee
Premessa: L’impostazione della tolleranza di misura dovrà essere fatta dopo 
aver completato l’acquisizione delle impedenze di linea (vedi par.8.6.1).
Il valore di default è 30%.

 • premere il tasto numerico della linea relativa  
 • tenere premuto il tasto numerico della zona relativa (1÷6)
   ruotando la manopola +/- per scegliere il valore desiderato.

>Valori da 10% a 100%: tolleranza di variazione in + e in - rispetto al 
valore memorizzato
>test disabled: controllo dell’impedenza disabilitato. Verrà comunque 
effettuato il test delle linee per corto circuito e GND fault.
É possibile inoltre disabilitare il test dell’impedenza impostando la tolleran-
za a 0% (Not Tested).
Premere ESC per tornare al menu CONFIGURATION.
Al termine della procedura, effettuare eventualmente il RESET MANUALE 
DELLA SEGNALAZIONE DI GUASTO come descritto nel par.8.5.3.1, pag. 
49.

Dopo aver selezionato l’opzione “set> IMP. TOLERANCE” dal Menu 
CONFIGURATION, il pannello “SET TOLERANCE” visualizza le tolleranze 
attualmente impostate per ciascuna zona di uscita.
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8.6.3 20KHZ LEVEL SEttInGS
 Impostazioni di livello 20kHz
Pannello per l’mpostazione dei livelli di segnale di test a 20kHz nei vari canali 
audio del controller VAC 2006.

> 1-Master level 
Livello generale del livello di test a 20kHz.

 • Premere il tasto 1 e ruotare la manopola +/-
 

> 2-Link music lev.
Livelli di uscita segnale musica a 20kHz inviato verso gli altri controller collegati.
 > 1-Link A level   >Premere tasto 1 e ruotare la manopola +/-

 > 2-Link B level   >Premere tasto 2 e ruotare la manopola +/-

> 3-Link speech lev. 
Livelli di uscita segnale voce a 20kHz inviato verso gli altri controller collegati. 
 > 1-Link A level   >Premere tasto 1 e ruotare la manopola +/-
 > 2-Link B level   >Premere tasto 2 e ruotare la manopola +/-

 

> 4-Line music lev. 
Livelli di test del canale musica. 
 > 1-Line 1 level   >Premere tasto 1 e ruotare la manopola +/-
 > 2-Line 2 level   >Premere tasto 2 e ruotare la manopola +/-
 > 3-Line 3 level   >Premere tasto 3 e ruotare la manopola +/-
 > 4-Line 4 level   >Premere tasto 4 e ruotare la manopola +/-
 > 5-Line 5 level   >Premere tasto 5 e ruotare la manopola +/-
 > 6-Line 6 level   >Premere tasto 6 e ruotare la manopola +/-

> 5-Line speech lev.
Livelli di test del canale voce. 
 > 1-Line 1 level   >Premere tasto 1 e ruotare la manopola +/-
 > 2-Line 2 level   >Premere tasto 2 e ruotare la manopola +/-
 > 3-Line 2 level   >Premere tasto 3 e ruotare la manopola +/-
 > 4-Line 2 level   >Premere tasto 4 e ruotare la manopola +/-
 > 5-Line 2 level   >Premere tasto 5 e ruotare la manopola +/-
 > 6-Line 2 level   >Premere tasto 6 e ruotare la manopola +/-
 
Nota: il display visualizza lo stato di programmazione impostato in fabbrica.

Premere ESC per tornare al pannello 20kHZ LEVEL SETTINGS.
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8.6.4 ALARM LEVEL
 Regolazione del volume delle sorgenti d’emergenza
Pannello per la regolazione del volume di uscita delle sorgenti d’emergenza ai fini di 
taratura del sistema. 
Per regolare il volume  della sorgente desiderata: 
• tenere premuto il tasto numerico corrispondente (1 ÷ 5) 
  e
• regolare il volume con la manopola +/-. 
Nota: Il volume impostato sarà lo stesso per tutte le linee di uscita.

Al termine dell’operazione premere ESC per tornare al menu CONFIGURATION.

1-Volume d’uscita delle postazioni microfoniche d’emergenza FMd collegate alla propria unità VAC 2006 locale: il range di regolazione per 
EMERGENCY UNITS è compreso fra -80 dB e 0 dB.

2-Volume d’uscita del microfono palmare d’emergenza: il range di regolazione per FIRE MICROPHONE è compreso fra -80 dB e 0 dB. 
Si suggerisce per la maggior parte dei casi di non superare il valore di +16 dB.

3-Volume d’uscita del messaggio preregistrato d’ALLERtA: Il range di regolazione per ALERT MESSAGE è compreso fra -80 dB e 0 dB.

4-Volume d’uscita del messaggio preregistrato d’EVACuAZIonE: Il range di regolazione per EVAC MESSAGE è compreso fra -80 dB e 0 
dB.

5-Volume del segnale d’emergenza proveniente da controller VAC 2006 remoto: il range di regolazione per VAC 2006 LINk è compreso fra -80 
dB e 0 dB.

8.6.6 PASSWoRd
 Impostazione del codice password
Pannello di abilitazione, disabilitazione e personalizzazione della password di 
accesso ai livelli di servizio del sistema.
•  Con la manopola +/- posizionare il cursore sui numeri corrispondenti alla 

password da modificare.
• Utilizzare i tasti numerici (1÷6) per scrivere la nuova password.
• Premere il tasto Ok per abilitare o disabilitare la password impostata.

nota: il display visualizza lo stato di programmazione impostato.

8.6.7 BEEP oPERAtIon
 Gestione del “beep” di sistema
Pannello di abilitazione e disabilitazione del “beep” di sistema.
• Utilizzare il tasto 1 per abilitare o disabilitare l’emissione del segnale sonoro.

nota: il display visualizza lo stato di programmazione impostato.

Al termine dell’operazione premere ESC per tornare al menu CONFIGURATION.

8.6.5 AMPLIFIER tESt tIME
 Impostazione dell’intervallo di test degli amplificatori Serie dPu
• Tenere premuto il tasto numerico corrispondente (1 ÷ 3) e regolare ed impostare 
tramite la manopola +/-:
1-Line Linea  (1 ÷ 6)
2-Amp Amplificatore (1 ÷ 16 / ALL)
3-Time Durata del test (5s ÷ 18h / no test) 

Al termine dell’operazione premere ESC per tornare al menu CONFIGURATION.
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8.7   EMERGEnZA MAnuALE - Menu < EMERGEnCY >
di seguito verrà descritta la procedura per la gestione delle emergenze con intervento manuale da parte di operatore 
autorizzato.

8.7.1   Informazioni generali
L’emergenza manuale è accessibile in qualunque momento, ha la priorità sui messaggi pre-registrati eventualmente in corso, attivati dalla 
periferica esterna collegata agli ingressi di controllo “CONTROL INPUTS” e sulle eventuali postazioni d’emergenza che hanno facoltà di operare 
sulle 6 linee d’uscita del controller in uso. 

8.7.2   Gestione manuale dell’emergenza
Il controller VAC 2006, grazie al funzionamento a doppio canale, consente un gestione articolata dei messaggi di allarme, del silenziamento 
degli stessi e della selezione delle zone come approfondito nei paragrafi successivi, di seguito viene riportato un elenco di operazioni per un 
rapido approccio all’emergenza manuale.

A) Invio dell’emergenza dal controller
-  Premere 1 volta il tasto EMERGEnCY, che si accende in modo 

fisso. L’avvenuta messa in stato d’emergenza viene visualizzata 
anche su router, postazioni ed eventuali controller collegati.

- Inviare un messaggio vocale (tramite il microfono palmare) o 
messaggio d’allerta (tasto ALERt) o messaggio d’evacuazione 
(tasto EVAC) su tutte le zone.

 Il display visualizza la tipologia di messaggio in corso.
 Nota: il messaggio inviato tramite microfono palmare ha 

priorità assoluta su evacuazione ed allerta pre-registrati.

Per terminare il messaggio d’emergenza in vivavoce, rilasciare il pulsante P.T.T. e premere nuovamente il pulsante EMERGEnCY, avendo cura 
di richiudere lo sportellino.

B) Invio dell’emergenza da postazioni remote Serie FMd
-  Sollevare il coperchietto di sicurezza sulla postazione e premere 1 volta il pulsante EMERGEnCY, che si accende in modo fisso. L’avvenuta 

messa in stato d’emergenza da parte della postazione viene visualizzata anche su router e sul/i controller collegati tramite display e tasto 
lampeggiante.

- Selezionare le zone dove si desidera inviare il messaggio
- Parlare al microfono tenendo premuto il tasto P.T.T. fino al termine del messaggio.
 Nota: Il tasto P.t.t. ha la priorità su eventuali messaggi pre-registrati in corso.

• Invio di messaggi d’allerta e/o evacuazione pre-registrati
- Selezionare le zone dove si desidera inviare il messaggio.
- Premere il tasto ALERt (allerta) od EVAC (evacuazione) per 

inviare i messaggi pre-registrati sulle zone selezionate.

Per terminare i messaggi d’emergenza in vivavoce, i messaggi d’allerta e/o evacuazione, premere nuovamente il pulsante EMERGEnCY.

Per terminare il messaggio d’emergenza in vivavoce, rilasciare il 
pulsante P.T.T. e premere nuovamente il pulsante EMERGEnCY, 
avendo cura di richiudere lo sportellino.
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C) uSCItA dEL SIStEMA dALLA GEStIonE MAnuALE dELL’EMERGEnZA
Al termine della procedura di gestione dell’Emergenza Manuale, premere il tasto rosso EMERGENCY, che si spegnerà e: 

 - Se non ci sono attivazioni in corso da periferiche esterne collegate ai contatti d’ingresso “Control Inputs”, il sistema ritorna automaticamente 
allo stato di Riposo visualizzando il Menu <MUSIC>. Il Led ALARM resta spento ad indicare la condizione di VOICE ALARM disattiva.

 - Se ci sono attivazioni in corso da periferiche esterne collegate ai contatti di ingresso “Control Inputs”:
  il sistema ritorna allo stato di Emergenza Automatica, visualizzando il Menu INPUT ALARM STATUS e riprendendo la diffusione dei messaggi 

di emergenza in base alla programmazione prevista per gli ingressi attivati, con eventuale Led ALARM acceso ad indicare la condizione di 
VOICE ALARM attiva.
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8.8.1 Attivazione dell’emergenza automatica
Nel caso di attivazione di un contatto di ingresso locale programmato, il 
controller VAC 2006 interrompe la normale attività dello “Stato di quiete”, 
silenzia la musica in diffusione, blocca la funzionalità delle sorgenti PA per 
annunci broadcast e visualizza il pannello “INPUT EMERGENCY” che indica 
nello specifico quale ingresso esterno ha attivato l’emergenza.
Se il contatto è stato programmato per inviare almeno un messaggio di 
emergenza su almeno una zona d’uscita, il sistema avvia l’Emergenza 
Automatica abilitando lo “Stato di Allarme” (VOICE ALARM) e accendendo il 
Led ALARM. Il pannello INPUT EMERGENCY riporterà il tipo di messaggio 
pre-registrato presente in uscita su ciascuna linea.

Visualizzazione dello stato operativo
LED ALARM: led acceso che segnala la condizione di VOICE ALARM attiva 
quando è presente l’annuncio microfonico a viva-voce o il messaggio pre-
registrato in corso, in uscita su almeno una zona. 

8.8.2 operatività del sistema durante l’emergenza automatica
Fino a quando i contatti di ingresso rimangono attivi, il pannello MUSIC rimane disattivato, è possibile tuttavia navigare fra i vari menu di opzione per 
accedere alle funzioni avanzate del sistema e ispezionare o modificare le impostazioni.

- Lo “Stato di Allarme” in corso per emergenza automatica può essere modificato dall’operatore autorizzato che interviene sul sistema per attivare i 
controlli manuali di gestione dell’emergenza, al fine di silenziare i messaggi (RESET), cambiare i messaggi in corso o  inviare annunci a viva-voce con 
il microfono predisposto.

Per dettagli sulla gestione dell’emergenza manuale consultare la sezione EMERGENZA MANUALE, par. 8.7, pag. 54.

8.8.3 uscita dall’Emergenza Automatica
 • Disattivare il contatto che ha attivato l’emergenza 
   o
 • Premere il pulsante EMERGENCY e tenere premuto per almeno 2 secondi il tasto RESET e rilasciarlo.

Al fine di segnalare all’operatore che l’attivazione dell’allarme proviene da contatti esterni, il controller mantiene visualizzato sul display l’avviso dell’avvenuta 
emergenza (lampeggiante).
 

Il sistema torna allo Stato di quiete visualizzando il pannello MUSIC.

8.8 EMERGEnZA AutoMAtICA - Stato di allarme attivato da periferica esterna
Di seguito verrà descritta la modalità operativa del sistema in caso di Emergenza automatica avviata da periferica esterna che attiva i contatti 
di ingresso programmati per abilitare lo “Stato di Allarme”.

Barra di stato delle linee
- Etichetta vuota: zona senza messaggio in corso.
- RESET: zona muta per contatto di reset generale.
- EVAC: zona con messaggio di EVACUAZIONE in corso.
- ALERT: zona con messaggio di ALLERTA in corso.
- DIS: zona disabilitata dagli allarmi.
- FAIL: zona in condizione di guasto della linea diffusori. Etichetta visualizzata anche se il tipo di guasto non compromette la diffusione del 

segnale in uscita. Nella condizione di funzionamento a singolo canale, per guasto amplificatore, indica che la zona non può diffondere il 
segnale previsto.
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9.       StAto dI GuASto
Il controller VAC 2006 dispone di una routine di diagnostica che monitora continuamente la disponibilità delle sorgenti d’emergenza, e l’integrità 
del percorso critico dei segnali adibiti alla funzionalità in condizioni di emergenza.

9.1   oPERAtIVItÀ E SEGnALAZIonI dEL SIStEMA In CondIZIonE dI GuASto GEnERICo
9.1.1  Segnalazione del sistema per “Stato di Guasto”  in corso
quando il sistema di sorveglianza, durante la normale operatività dello “Stato di quiete”, rileva una causa di guasto, attiva tempestivamente la 
segnalazione dello “Stato di Guasto” come segue:
• accensione del Led FAULT (segnalazione visiva).
• accensione del BEEP sull’altoparlante monitor (segnalazione sonora).
• attivazione dei contatti di uscita locali CONTROL OUTPUTS eventualmente programmati (segnalazione remota).
• visualizzazione della condizione di guasto (FAULT) nell’etichetta di stato del pannello di Report FAULT.

9.1.2  Segnalazione del sistema per “Stato di Guasto”  rientrato (RES)
Se la causa del guasto rientra automaticamente, senza alcun intervento dell’operatore,  il sistema ritorna automaticamente allo “Stato di quiete”, 
disattivando tutte le segnalazioni sopra descritte e mantenendo in memoria l’ultimo guasto occorso mediante:
• visualizzazione della scritta RES nell’etichetta di stato del pannello Report FAULT per Guasto Rientrato (Resumed). 

9.1.3  Cancellazione della Segnalazione di Guasto rientrato (RESEt FAuLt)
Per cancellare la segnalazione del guasto memorizzato e non più in corso:  
• accedere al pannello FAULTS dal menu OPERATOR (vedi par. 8.5.3, pag. 49)
• effettuare il RESET MANUALE della segnalazione di guasto come indicato al par. 8.5.3.1, pag. 49.
Nota: in caso di guasto della linea diffusori sonori per corto circuito (Short), quando la linea viene riparata, è necessario effettuare il RESET MANUALE 
DEL GUASTO da menu Operator, al fine di riattivare il segnale audio sull’uscita della linea interessata.

9.1.4  Procedura suggerita in condizione di guasto in corso
La procedura con “stato di Guasto” in corso è la seguente:
• accedere al pannello FAULTS dal menu INSPECTION (vedi par. 8.4.1, pag. 39)
• verificare qual è la categoria di diagnosi in FAULT ed accedere al sub-pannello specifico.
• verificare la causa del guasto e, se possibile, ripristinare la corretta operatività seguendo le operazioni richieste nella tabella riferita al sub-

pannello (vedi par. da 8.4.1.2 a 8.4.1.7).
Se il ripristino dell’anomalia è andato a buon fine, il termine della condizione di Guasto viene segnalato come segue:
• spegnimento del Led FAULT
• disattivazione dell’eventuale contatto di uscita
• visualizzazione della scritta RES nell’etichetta di stato del pannello Report FAULT per Guasto Rientrato (Resumed)
A completamento della procedura è opportuno cancellare la segnalazione del guasto memorizzato e non più in corso (vedi par. 9.1.3).

9.2 oPERAtIVItÀ E SEGnALAZIonI dEL SIStEMA In CondIZIonE dI GuASto LInEA dIFFuSoRI
Il guasto della linea diffusori può essere dovuto a varie cause, le modalità di segnalazione e le operazioni richieste sono descritte nel par. 8.4.1.2 
Pannello LOUDSPk. LINE  FAULT. Se si tratta di una variazione di impedenza, il VAC 2006 continua a diffondere il segnale audio in uscita della 
zona, se si tratta di un corto circuito della linea, il sistema scollega la linea in guasto e diffonde il segnale audio sull’altra linea integra della stessa 
zona. 
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CARAttERIStICHE tECnICHE VAC 2006

Display 3” retroilluminato 128x64 punti

Ingressi

uSB-EXt. Ingresso uSB alimentato sul frontale - Presa tipo A

Microfono d’emergenza
• Sensibilità / Impedenza
• Risposta in frequenza / Rapporto S/N

Bilanciato XLR-F su frontale
Livello segnale 20 mV / 10 kW
60 ÷ 20.000 Hz / 72 dB

In.1
Presa (MIC.)
• Sensibilità / Impedenza
• Risposta in frequenza / Rapporto S/N

Programmabile per modalità on / oFF / Precedenza / VoX con A.P.t.
Bilanciato XLR-F (con alimentazione Phantom 24V inseribile)
Livello segnale Min. 3 mV - Max 100 mV / 1,8 kW
240 ÷ 20.000 Hz / 63 dB

In.2
Presa (MIC.)
• Sensibilità / Impedenza
• Risposta in frequenza / Rapporto S/N
Presa (LINE)
• Sensibilità / Impedenza
• Risposta in frequenza / Rapporto S/N

Programmabile per modalità on/ oFF / Precedenza / VoX con A.P.t.
Bilanciato XLR-F (con alimentazione Phantom 24V inseribile)
Livello segnale Min. 3 mV - Max 100 mV / 1,8 kW
240 ÷ 20.000 Hz / 63 dB
Bilanciato a morsetti (HOT-COM-GND)
Livello segnale Max 1800 mV / 31 kW
60 ÷ 20.000 Hz / 84 dB

AuX
• Sensibilità / Impedenza
• Risposta in frequenza / Rapporto S/N

Presa stereo RCA per sorgente sonora (BGM) - Conversione in monofonia
Livello segnale Max 1800 mV / 31 kW
60 ÷ 20.000 Hz / 84 dB

Paging units
• Sensibilità / Impedenza
• Risposta in frequenza / Rapporto S/N

2 Rj45 per unità di chiamata (PA) Serie MBt 1106/MBt 1112.
Livello segnale Max 1400 mV / 85 kW
60 ÷ 20.000 Hz / 83 dB

EMERGEnCY unItS Rj45 per collegamento a postazione microfonica d’emergenza dedicata.

uscite

SLAVE LInK outPut
• Livello d’uscita/ Impedenza

Rj45 per collegamento ad unità VAR 2006  / dPu / VAIE 2250
Max 2000 mV / 400 W

VAC 2006 LInK
• Livello d’uscita/ Impedenza
• Sensibilità / Impedenza d’ingresso

Rj45 per collegamento ad unità VAC 2006
Max 2000 mV / 400 W
2000 mV / 50 kW

Controlli d’emergenza
• Ingressi CONTROL INPUTS
• Uscite CONTROL OUTPUTS

Programmabili per stato normalmente attivo o normalmente disattivo.
7 ingressi con diagnosi.
3 relè per segnalazione stato d’emergenza e guasto, morsetti N.O-N.C.-Scambio.

Precedenza In 1 - In 2 Ingresso precedenza a morsetti con comune +12 Vcc.

LAn Presa LAn Rj45 per collegamento tCP/IP a web server.

Generalità

Alimentazione da rete @230Vca
Consumo @230Vca

230 Vca 50/60 Hz ±10%
10 W

Alimentazione esterna in corrente continua @24Vcc
Consumo @24Vcc 

24 Vcc (min 22Vcc ÷ max 28Vcc)
0,3 A

Condizioni ambientali operative Temperatura: +5°C ÷ +40°C / Umidità relativa: 25%-75% senza condensa

Montaggio Diretto a rack 19” (2U).

Dimensioni prodotto (L x A x P)
Dimensioni imballo (L x A x P)

482 x 88 x 220 mm
522 x 155 x 292 mm

Peso netto
Peso lordo

4,5 kg
5,5 kg

CARAttERIStICHE tECnICHE VAR 2006

Alimentazione da rete @230Vca
Consumo @230Vca

230 Vca 50/60 Hz ±10%
12 W

Alimentazione esterna in corrente continua @24Vcc
Consumo @24Vcc 

24 Vcc
0,5 A

Massima potenza commutabile per singola zona 500 W

Condizioni ambientali operative Temperatura: +5°C ÷ +40°C / Umidità relativa: 25%-75% senza condensa

Montaggio Diretto a rack 19” (1U).

Dimensioni prodotto (L x A x P) 
Dimensioni imballo (L x A x P)

482 x 44 x 220 mm
522 x 155 x 292 mm

Peso netto
Peso lordo

4 kg
5 kg
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LIStA dELLE FunZIonI oPZIonALI 

Clausola descrizione

7.6.2 Silenziamento manuale della condizione di allarme vocale

7.7.2 Reset manuale della condizione di allarme vocale

7.9 Uscita per segnalazione della condizione d’allarme vocale

8.3 Indicazione di guasto relativa ai percorsi di trasmissione

8.4 Indicazione di guasto relativa alle zone d’allarme

9 Disabillitazione dell’allarme vocale in determinate zone/a

10 Controllo manuale degli allarmi vocali

11 Interfaccia per dispositivi di controllo esterni

12 Microfono d’emergenza

13.14 Amplificatori di riserva

LIStA dELLE FunZIonI AuSILIARIE 

Chiamate broadcast

Musica di sottofondo
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1. IntRoduCtIon

1.1 SYStEM oVERVIEW
The new VAIE 2000 product range has been designed and manufactured in order to offer innovative solutions for making systems applied to 
emergency services. It is capable of managing alarm situations and of enabling guided and controlled evacuation, in accordance with 
the applicable standards (En 54-16, ISo 7240-19 and En 60849).

the architecture of the whole system is based on the VAC 2006 controller, management and diagnostics unit, which is particularly suitable 
for both large and small installations in which high levels of safety, flexibility and user-friendliness are required. The simplicity of the connections 
(using Cat. 5e SF/ATP shielded cable) between the various different management units, amplifiers and emergency microphone stations makes 
sound-broadcasting in complex buildings effective and inexpensive, enabling the use of both centralised and/or local equipment.

Each VAC 2006 controller has provisions for managing 6 control lines to which the following units can be connected directly:

•  Digital power amplifiers equipped with diagnostics cards (dPu range), up to a maximum of 16 per line;
•  VAR 2006 router (1 for each line), capable of managing 6 zones with a double 100-V output line (A and B);
•  Compact integrated 6-zone systems (VAIE 2250, maximum 1 for each line);
• Maximum number of zones in the whole system: 216.

It is possible to connect up to a maximum of 6 VAC 2006 controllers with one another.controllers with one another.
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VAC 2006 controllers and digital amplifiers of the dPu range VAC 2006 controller and VAR 2006 router

VAIE 2000 | System featuring a mixed configuration
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See details on page 76.

2. GEnERAL dESCRIPtIon

2.1 VAC 2006 ContRoLLER
F1. Flush-mounted push-button for activating the Manual Emergency mode (EMERGENCY).
F2. Hand-held microphone with a Push-to-Talk (PTT) key for live emergency announcements.
F3. Backlit black-and-white graphic display, 128 x 64 pixels.
R1. ON/OFF switch.
R2. Inputs for connecting remote emergency microphone stations (FMd 2012, FMd 2001).
R3. Sockets for connections between VAC 2006 controllers (up to 6 units).
R4. Input for connecting broadcast paging units (MBt 1106, MBt 1112). 
R5. Balanced input for a microphone or outside source / Terminal block for connecting a precedence contact.
R6. Input for external microphone.
R7. Input for connecting an external source of music.
R8. 7 monitored digital inputs for control via external peripheral units.
R9. 6 output lines for connection to amplifiers of the DPU range and/or VAIE 2250 compact systems and/or VAR 2006 routers.
R10. Socket for connecting a Local Area Network with TCP/IP protocol for an Ethernet 10/100 network.
R11. 3 relay outputs for signalling towards external peripheral units. 
R12. Terminals for 24 VDC external power supply.
R13. Frame earthing connection.
R14. Plug for 230 VAC mains power supply, with built-in fuse.
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2.2 VAR 2006 RoutER
F4. Failure-signalling LED.
F5. Router/system status LED.
F6. Output zone status LED.
F7. Zone-selection buttons for BGM.
F8. Power supply/call status LED.
R1. ON/OFF switch.
R11. 2 relay outputs for signalling towards external peripheral units. 
R12. Terminal block for 24 VDC outside power supply. 
R13. Frame earth connection. 
R14. Plug for 230 VAC mains power supply with built-in fuse.
R15. Terminal block for connection to amplifier outputs.
R16. Loudspeaker output terminal blocks
R17. Programmable inputs/outputs.
R18. Voice amplifier output  - Music/standby amplifier output.
R19. Input/output for connection to a VAC 2006 controller.

2.1.1 Main features of the controller
 • Monitored front-panel emergency microphone.
 • Two-channel sound-broadcasting system.
 • Message generator for broadcasting two-channel voice alarms (EVAC and ALERT).
 • USB input as a source of background music.
 • Automatic management of the stand-by amplifier.
 • Input for 24 VDC secondary power supply.
 • 7 programmable and controlled input contacts.
 • 3 relay outputs.
 • 6 control lines for digital amplifiers of the dPu range and/or VAR 2006 routers and/or VAIE 2250 integrated evacuation systems.
 • 4 redundant lines for connections among the various different controllers (max 6).
 • 2 redundant lines for emergency microphone bases of the FMd range (max 7, with 7 priority levels).
 • 2 redundant lines for call stations of the MBt range (max 16, with 7 priority levels).
 • B/W graphic display, 128x64 pixels, for easy configuration and rapid use of monitoring screen pages.
 • Diagnostics and failure signalling.
 • Can be mounted in a standard 19” rack (height: 2 units).  

2.2.1 Main features of the router
 • 6 two-line (A and B) loudspeaker zone outputs.
 • 100-V double input for 1 or 2 voice amplifiers (IN 1: zones 1 to 3, IN 2: zones 4 to 6).
 • 100-V input for music/standby amplifier.
 • Music can be activated/de-activated separately for each zone by means of the front-panel push-buttons provided for this purpose.
 • RJ45 sockets for connection to the VAC 2006 controller.
 • 7 programmable and controlled input contacts.
 • 6 open-collector outputs.
 • 2 relay outputs.
 •  Can be mounted in a standard 19” rack (height: 1 unit). 
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3. WARnInGS

3.1 PoWER SuPPLY And EARtHInG
This equipment is designed to run on a mains voltage of 230 V ± 10% 50/60 Hz. The ON/OFF switch (R1) switches the mains voltage on and 
off. The equipment is supplied with a power cable that has an earth wire. The earth terminal of the mains plug must not be removed under 
any circumstances. Connect the mains plug (R14) of the device to the power mains using only the cable supplied with the equipment, which is 
equipped with a noise-suppressor. Make sure that the power outlet has an earth connection in accordance with the law. The power circuit of the 
VAC 2006 is protected by a fuse on the mains plug of the device.

3.3 InStALLAtIon
All FBt equipment is made according to the strictest international safety standards and complies with European Community requirements. 
For correct and effective use of the equipment, it is important to be aware of all its characteristics by reading carefully these instructions and 
especially the safety notes. It is necessary to ensure adequate ventilation while the equipment is in use, and to leave the side ventilation slit for 
the cooling fans unobstructed. Do not position the equipment inside a cabinet without ventilation and keep it away from sources of heat. The 
equipment can be mounted in FBT standard 19” racks. 

3.2 SAFEtY notES
Any activities inside the equipment, such as maintenance operations and so on, must be carried out solely by specialised personnel. When 
the cover is removed, parts become accessible that entail a risk of electric shocks. Always make sure that the power cable is unplugged from 
the outlet before removing the cover. If any liquid is accidentally spilt onto the equipment, unplug it immediately from the mains and contact 
the nearest FBt Service Centre. In case of rack installation, it is required to connect the (R13) connection to the to rack frame by means of 
a cable as short as possible (about 20cm). It’s also possible to connect other equipments for the sole purpose of shielding low-level signals.  
This socket must not be used for the safety connection of the frame to earth. 

Important information for correct disposal of the product in accordance with EC directive 2002/96/EC 
This product must not be disposed of as urban waste at the end of its working life. It must be taken to a special waste collection centre 
licensed by the local authorities or to a dealer providing this service. Separate disposal of electric and/or electronic equipment (WEEE) 
will avoid possible negative consequences for the environment and for health resulting from inappropriate disposal, and will enable the 
constituent materials to be recovered, with significant savings in energy and resources. As a reminder of the need to dispose of this 
equipment separately, the product is marked with a crossed-out wheeled dustbin.

this product is in keeping with the relevant European Community directives.
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4. ConnECtIonS
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A) ConnECtIon AMonG ContRoLLERS
Use Cat.5e SF/UTP cables in the ‘VAC 2006 LINk’ sockets (R3) to connect the controllers of the system (max 6) with one another.

B) ConnECtInG tHE outPut LInES 
Use the ‘SLAVE LINk OUTPUTS’ sockets (R9) to connect the following to the controller:
B1) VAR 2006 router.
B2) VAIE 2250 compact emergency system.
B3) Amplifiers of the dPu range.
 
B1) VAR 2006 router
Use Cat.5e SF/UTP cables to connect the ‘SLAVE LINk OUTPUTS’ sockets (R9) to the ‘IN/OUT SLAVE LINk’ sockets on the router. 
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B2) VAIE 2250 compact emergency system
Use a Cat.5e SF/UTP cable to connect one of the ‘SLAVE LINk OUTPUTS’ sockets (R9) to the ‘REMOTE LINk’ socket on the VAIE 2250 
compact system. 

B3) Amplifiers of the dPu range
Use a Cat.5e SF/UTP cable to connect one of the ‘SLAVE LINk OUTPUTS’ sockets (R9) to the ‘IN/OUT’ socket on the amplifier (DPU 1125C, 
DPU 1250C or DPU 1500C).
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d) ConnECtInG tHE AudIo InPutS 
d1) Sources of BGM, “music” amplification channel
Connection of an example of sound sources at line or microphone level, balanced or unbalanced, selectable from the MUSIC panel and addressable 
to the required zones by means of the zone activation keys. For details concerning the settings, refer to the relevant sections indicated in the 
MUSIC and AUDIO SETTING menus.
A - Source of music with unbalanced output at the level of the line connected to the AUX IN input.
 To receive, select the “AUX” BGM source from the MUSIC menu.
B - Receiver of the radio microphone kit with output balanced at the level of the microphone connected to the IN.1 input.
 To receive, select the “INPUT 1” BGM source from the MUSIC menu.
 Set the following, via the INPUT 1 panel: > MODE: OFF
  > PH: OFF
  > The Chime, Priority and Zone list parameters have no effect.
C - Mixer with output balanced at the level of the Line connected to the IN.2 LINE input.
 To receive, select the “INPUT 2” BGM source from the MUSIC menu.
 Set the following, via the INPUT 2 panel: > MODE: OFF
  > PH: OFF
  > The Chime, Priority and Zone List parameters have no effect.

Caution! do not connect any other equipment to the MIC socket of the In.2 input.

C) ConnECtInG tHE EMERGEnCY StAtIonS 
Use CAT. 5e SF/UTP cables to connect the ‘EMERGENCY UNITS’ 
sockets (R2) on the controller to the ‘IN/OUT’ sockets of the FMD 2001 
and/or FMD 2012 stations. 
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d2)  Various types of PA source with progressive degrees of priority, “voice” amplification channel
Connection by way of example of one table-top microphone station, not  pre-amplified, with a precedence contact; of one grip-type microphone 
with automatic VOX activation over music; of one PABX with an audio output for automatic announcements over the sound-broadcasting system 
and digital stations of the MBT range for service announcements with zone selection. For details concerning the settings refer to the relevant 
sections indicated under AUDIO SETTING.

A - Table-top base with electret microphone, balanced output connected to the 
IN.1 input – MIC and precedence contact connected to the PPREC. input.
The announcement will be addressed to the group of zones indicated in the 
ZONE LIST on the basis of the priority set.
Set the via the INPUT 1 panel: >MODE: PRECEDENCE
  >PH: ON
  >Priority: 3 
  >Zone list: as desired
  >VOL.: as desired
Set the via the CHIME panel: > MIC 1: ON  

B - Grip-type dynamic microphone, balanced output connected to the input 
IN.2– MIC with VOX function.
The announcement will be addressed to the group of zones indicated on the 
ZONE LIST according to the priority that is set.
Set the via the INPUT 2 panel: >MODE: VOX
  >PH: OFF
  >Priority: 1 
  >Zone list: as desired
  >VOL.: as desired
Set the via the CHIME panel: > MIC 2: OFF 

Caution! do not connect any other equipment to the LInE terminals 
of the In.2 input.

C - Digital microphone stations connected in cascade formation to the PAGING 
UNIT input. The announcement will be addressed to the zones indicated when 
programming the keys of the bases depending on the priority set for each 
base.Set the PAGING UNITS panel:
  >VOL.: as desired (volume of the whole line
    for all the bases)

Set the CHIME panel: > UNIT: ON

Sizing: For each VAR 2006 unit, up to a maximum of 16 stations of the PAGING UNITS range can be connected. Use the Cat. 5 SF/UTP connecting 
cable, with its shielding plait. The following limits must be observed for the connections:
N. 1 station connected to a line 800 metres long.
N. 8 stations distributed along 2 lines, each 200 metres long (4 stations per line).

For systems calling for greater distances or a higher number of stations to be connected, it is advisable to power the stations by means of the additional 
power supply unit connected to the local socket of the base. The maximum length of the connecting line, adding up the lines connected to the two RJ45 
sockets, is 1 km. For further details concerning the type of power supply, the configuration of the cable, programming of the selection keys and setting 
of the priorities and addresses, refer to the Instruction Manual of the stations of the MBT range.

The following PAGING UNITS can be connected to the VAC 2006:
• MBt 1106: 6-zone paging unit.
• MBt 1112: 12-zone paging unit.

N.B.: The connections between the VAC 2006 and PAGING UNITS must be made solely with CAT. 5e SF/UTP.
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F) ConnECtInG An EXtERnAL PoWER SuPPLY
A connection for a 24 VDC outside power supply is available on the 
terminals provided (R12). 

E) Rj45 InPut ContACtS (ContRoL InPutS)
There are 7 contacts on the CONTROL INPUTS (R8) socket. An example of a connection is shown in the figure.

N.B.: In the example, contacts 1 to 6 are controlled while contact 7 is not.
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5. oPERAtInG CondItIonS And tERMInoLoGY

5.1 GEnERAL dEFInItIonS
Following is a list of the signalling modes of the operating conditions of the system and of definitions used in the rest of the manual, completed 
by indications of a general nature:

5.1.1  Signalling of operating conditions
The VAC 2006 system is structured to signal the different operating conditions on the basis of the following definitions:

“Quiescent condition” (ALARM – FAuLt – dIS – SYS LEds extinguished)
Normal operating condition, with no current failures or emergencies. This status enables the sources of music and voice to be managed for 
service announcements.

“Alarm Condition” (ALARM LEd illuminated)
This operating condition signals the current presence of at least one alarm signal, either pre-recorded or live, on at least one output zone. The 
“Alarm Condition” can be activated in the form of an Automatic Emergency from an external peripheral unit connected to the Control Inputs or of 
a Manual Emergency through an authorised operator. During an “Alarm Condition”, the functions of the music sources and of the voice services 
referred to the quiescent condition are not operational.

“Fault warning condition” (Led FAuLt)
Operating condition signalling the presence of at least one on-going failure, detected by the internal diagnostics system causing the FAULT 
LED to light up steadily. 
In the event of failure of a remote controller, the FAULT LED will flash.
 It is accompanied by an acoustic signal (buzzer) indicating the failure. Depending on the causes of the failure, the system may in any case 
perform the functions relating to the “quiescent” and “Alarm” conditions.

“System Fault” (SYS LEd illuminated)
This operating condition signals that the system is blocked as the result of a temporary or permanent malfunctioning of the CPU, detected by the 
watchdog. It is accompanied by an acoustic signal (buzzer) indicating the failure. During a System Fault, the functions relating to the “quiescent” 
and “Alarm” conditions are not operational.

“disablement condition” (dIS LEd illuminated)
This operating condition signals that the Alarm signals for at least one output zone have been set to a Disablement condition. The system can 
in any case carry on the functions pertaining to the “quiescent” condition for all the zones  and, only for those zones that are not disabled, the 
functions pertaining to the “Voice Alarm Condition”. 

“Automatic Emergency” (ContRoL InPut StAtuS display with zones active)
This indicates a sequence of operations performed from an external peripheral unit connected to the Control Inputs. Depending on how these 
inputs are programmed, the “Voice Alarm Condition” or an Alarm Reset are activated.

“Manual Emergency” (LEd of the EMERGEnCY button on/flashing)
This procedure is performed by an authorised operator using the manual controls, to activate Emergency sources or to reset the Alarms (Manual 
Alarm Reset). The operations carried out in the Manual Emergency mode have a higher priority than those activated by an Automatic Emergency. 
A VAC 2006 unit or an emergency unit on which the EMERGENCY LED is illuminated is enabled for use for activating Emergency sources or 
for resetting the alarms. A VAC 2006 unit or an emergency unit on which the EMERGENCY LED is flashing indicates that a Manual Emergency 
has been activated from a remote station.

5.1.2  Glossary
Following is a list of definitions of terms used in this manual, completed by indications of a general nature.

“BGM Source”: 
One of the following audio sources using the “Music” amplification channel (BackGround Music):
- Audio source connected to the AUX input.
- Flash memory device containing *.mp3 files plugged into to the front-panel USB EXT socket.
- Sorgente audio collegata all’ingresso IN 1 (Microfonico) con modalità impostata MODE: IN OFF.
- Sorgente audio collegata all’ingresso IN 2 (Microfonico oppure di Linea) con modalità impostata MODE: IN OFF. 
During a “Voice Alarm Condition”, the BGM sources are not operational.

“PA Source”: 
One of the following audio sources using the ”Voice” amplification channel for Public Address announcements:
- Source of sound connected to the IN 1 input (Microphone input), set in the ON or PRECEDENCE MODES.
- Source of sound connected to the IN 2 input (Microphone or Line input), set in the ON, VOX or PRECEDENCE MODES.
- EMERGENCY UNIT in the broadcasting mode, PAGING UNITS.
During a “Voice Alarm Condition” the PA sources are not operational.
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“Emergency Source”:
One of the following audio sources, using the “Voice” and/or “Music” channels for emergency voice announcements (Voice Evacuation 
System):  
- Pre-recorded Alert message (ALERT).
- Pre-recorded Evacuation message (EVAC).
- Emergency Microphone (P.T.T.) connected to the front-panel MICROPHONE socket.
- Emergency microphone station connected to the rear-panel EMERGENCY UNITS socket.
Activation of a “Emergency source” generates an operational “Voice Alarm Condition”. 

“Priority”:
Use of the output zones by an audio signal or by a reset command is governed in the hierarchy by the level of priority assigned to each active 
source. A current activation of a zone can be interrupted only by another with a higher priority.

the VAC 2006 system manages priorities as shown in the following tables:

The active sources in the “Voice Alarm” condition always have priority over those active in “Quiescent” condition, regardless of the priority level set.

Priority System 
condition

operating 
enviroment

Priority 
level

Active 
source

For setting see 
MEnu

high

low

“Voice alarm 
condition”

Manual 
Emergency

15 VAC 2006 with emergency microphone Fixed setting

8 to 14 Emergency microphone stations See the manual of FMD 2001 & FMD 2012 stations

Automatic 
Emergency

7 CONTROL INPUT for RESET function Fixed setting

6 CONTROL INPUT for EVAC message Fixed setting

5 CONTROL INPUT for ALERT message Fixed setting

Priority System 
condition

operating 
enviroment

Priority 
level

Active 
source

For setting see 
MEnu

high

 

low

“Quiescent 
condition”

PA 
Source

8 to 14 Emergency units in broadcast mode See Emergency units manual

1 to 7

Inputs IN 1 - IN 2 with the PRECEDENCE  
or VOX functions See AUDIO SETTING section

PAGING UNITS  Microphone stations See the manual of MBT 1106 & MBT 1112 stations

BGM 
Source 0 Music source Fixed setting
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5.2  EQuIPMEnt And FunCtIonAL SPECIFICAtIonS

5.2.1 VAC 2006 controller

Front panel
F1. Emergency button with LEd (red)
 Flush-mounted push-button for activating the Manual Emergency mode. It enables access to the system, with top priority, from the 

“quiescent condition” or during an Automatic Emergency, previously activated from an external peripheral unit. The LED, which is normally 
extinguished, will light up steadily in the Manual Emergency mode activated from the unit in question. If the LED flashes, this indicates 
a Manual Emergency status activated from an emergency microphone station or a remote controller. The Emergency button will also be 
used for exiting the Manual Emergency. The push-button is controlled by the internal diagnostics system.

F2. Emergency microphone
 Hand-held microphone with Push-to-Talk (P.T.T.) key, for live emergency announcements. The microphone is only operational in Manual 

Emergency conditions and has priority over pre-recorded emergency messages. The microphone capsule is controlled by the internal 
diagnostic system. Use only the microphone included in the supply, connected directly, without any extension cable, to the XLR socket on 
the front panel of the VAC 2006.

F3. Graphic dISPLAY
 Backlit black-and-white graphic display, 128x64 pixels, for displaying the many management windows, the contents of which will vary 

depending on the operating conditions of the system (quiescent or emergency). Together with the +/- knob and with the multi-purpose keys, 
it is useful for navigating through the menus, for adjusting working parameters and for managing advanced functions. It will also display 
all the information required concerning Fault, Disablement and Voice Alarm Conditions, that are not all signalled by the status LED’s.

Rear panel
R1. PoWER switch
 ON/OFF switch of the VAC 2006 system. In the O (OFF) position, the system is switched off and in the I (ON) position the system is switched 

on. The switch affects only the main 230 VAC power supply (see the “Power Supply and Earthing” and “Safety Notes” sections for details 
about safety).

R2. EMERGEnCY unItS 
Input for connecting remote emergency microphone stations. Use only the FMD 2001 and/or FMD 2012 microphone stations. RJ45 
socket for connection with Cat. 5e SF/UTP cable with a shielding braid and shielded STP connector (for details of the connection, 
consult the manual of the FBT 37359 stations). The EMERGENCY UNITS must be connected to one another in daisy-chain fashion: 
each of the two connecting lines A and B can reach a total length of up to 1 km.

R3. VAC 2006 LInK Sockets for connections among VAC 2006 controllers (up to 6)  
 Connectors for connections among several controllers. If both LINk A and LINk B are used, a redundant connection is achieved that keeps 

the system in working order even if one of the two links fails. If more than one controller is installed on the same rack, it is possible to use 
a single LINk (A or B). if this is done, it is necessary to de-activate the remote link test not being used:

  o Path: HOME / CONFIGURATION / set> BACkGROUND TEST / 2-Voice Alarms / 6-Remote Link > Link Test
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R4. PAGInG unItS
 Input for connecting paging microphone stations (MBT 1106, MBT 1112) for broadcasting functions. It is possible to connect up to a total of 16 

Paging Units. RJ45 sockets (2 off) for connection with Cat. 5e SF/UTP cable with shielding braiding and shielded STP connector. The connection 
with the Paging Units must be of the daisy-chain type. The two connecting lines can reach a total length between them of up to 1 km.

R5. In. 2 – MIC. / LInE and PRECEdEnCE tERMInAL StRIP
 INPUT 2 is a balanced input for a microphone or an external source, programmable as a Music or Voice source. Use the MIC input to connect 

dynamic or electret microphones, enabling the phantom power supply or, as an alternative, the input on the terminal strip for sources at line 
level such as mixers or pre-amplified microphone stations. The input can be set in many different ways, depending on how the operating 
mode is programmed:  

 - as a Voice source enabled by the precedence contact (PREC.), with a CHIME that can be activated/de-activated. 
 - as a voice source for automatic VOX activation with adjustment of the activation threshold and of the release time and the possibility of  

 an activatable/de-activatable CHIME.
 When used as a voice source, the priority can be set with 7 different levels, and the group of paging zones can be selected. 
 Do not use simultaneously the MIC. and LINE inputs of the IN. 2 input but:
 -   the XLR F socket for connecting a balanced signal of up to 100 mV, or
 -   the socket with 3 terminals, HOT-COM-GND, for stripped wire, for connection of a balanced signal of up to 1.8 V.
 In both cases, use shielded balanced microphone cable. For details concerning the settings of the IN. 2 input, refer to the information 

shown in the Music menu and under AUDIO SETTINGS > INPUT 2 and CHIME. 
PRECEdEnCE tERMInAL StRIP
Terminal strip for connecting the precedence contact to the current music source, for activation of the IN. 1 or IN. 2 inputs and of the CHIME, if 
enabled. The precedence function can be used in either of the 3 following ways. The precedence function can be used with MIC 1 or MIC 2 if 
it is enabled on their control panels. For details of the precedence settings, refer to the indications shown on the INPUT 1 and INPUT 2 panels 
and in the AUDIO SETTING menu. Activation is carried out keeping the +12 V terminal connected to the PR. terminal, by closing a dry contact 
or connecting the available precedence contact to table-top microphones.

R6. In. 1 – MIC 1
 INPUT 1 input for an external microphone, programmable as a Music or Voice source. It is possible to connect dynamic or electret 

microphones to this input, enabling the phantom power supply. Programming of the operating mode enables use as a voice source 
enabled by a precedence contact (PREC.), with the possibility of activating/de-activating a CHIME. 

 When it is used as a Voice source, it is possible to set priority, to 7 different levels, and the group of paging zones. The XLR -F socket 
enables a balanced signal of up to 100 mV to be connected, by means of shielded balanced microphone cable. For details concerning 
the settings of the IN. 1 input, refer to the indications contained in the INPUT 1 panel (point 8.3.4).

R7. LInE AuX In
 Input for connecting an external source of music. It has one pair of RCA sockets, with conversion to mono, for sources with unbalanced 

outputs at line level. For the audio settings of the AUX input, refer to the information contained in the MUSIC menu.

R8. ContRoL InPutS
 7 digital inputs for monitoring via external peripheral units. They enable programmed events to be activated, including switching of the 

VAC 2006 system to a Voice Emergency condition, requiring automatic sending of pre-recorded emergency messages. Activation is 
possible by means of Normally Open or Normally Closed contacts, relaying the +24 VDC voltage supplied from the service sockets. It 
is possible to enable diagnostics of the connecting stretch, arranging to install two 10-kOhm balancing resistors in the proximity of the 
contact for activating the remote peripheral unit. (see page 70).

R9. SLAVE LInK outPutS
 6 output lines for connection to DPU amplifiers and/or VAIE 2250 compact emergency systems and/or VAR 2006 routers. 

R10. LAn
 Socket for connecting an Ethernet 10/100 Local Area Network using the TCP/IP protocol. 

R11. RELAY 1 – RELAY 2 – RELAY 3
 3 relay outputs for signalling to external peripheral units. The VAC 2006 system enables the logical outputs to be programmed to link 

activation of the output with system status events or for override functions in connection with emergency conditions, or for signalling 
failures, emergencies and disabling. All the outputs can be programmed to be either Normally Active or Normally De-activated.  The 
connection calls for 3 screw-down terminals for stripped wires for each relay, referred to N.O. and N.C. contacts - Changeover. 
N.B.: two outputs are available on the VaR 2006 router.

R12. terminals for external 24 VdC power supply
 Terminals for connecting the auxiliary 24 VDC power supply. This is not used when the 230 VAC mains power supply is available.  The 

input is protected against inversion of the poles. Consult the “Power supply and earthing” and “Safety Notes” sections for details about 
safety. N.B.: the batteries and the battery-charger must be installed on the same rack on which the VaC 2006 controller is 
mounted.  

R13. Frame connection
 The frame connection may be used to connect other equipment only for the purpose of shielding the low signals. This terminal may not 

be used to connect the frame to earth for safety purposes. (Consult the “Power supply and earthing” and “Safety Notes” sections for 
details about safety).

R14. Plug for 230 VAC mains power with built-in fuse
 Plug for connecting the equipment to the 230 VAC/50-60Hz mains power using the power cable supplied with it. If it is necessary to 

replace the mains fuse, this must be done with one of the same type, i.e. 500 mA fuse, of the miniature 20 mm cylindrical type. (consult 
the “Power supply and earthing” and “Safety Notes” sections on page 64 for details about safety).
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5.2.2 VAR 2006 Router

Front panel
F4. FAuLtS LEds
 The FAULT LEDs provide the following information:
 • COM-SYS Flashing indicates the absence of a connection with the controller.
 • CTRL IN This indicates a failure of the controlled inputs.
 • MAINS This indicates a failure of the internal power supply.
 • BATTERY This indicates the lack of power from the battery.
 • GND Ground Fault.
 • SP. Z1-3 Failure of the amplifier connected to zones Z1 to Z3.
 • SP. Z4-6 Failure of the amplifier connected to zones Z4 to Z6.
 • MUS.-SPARE Failure of the music/spare amplifier.

F5. StAtuS LEds
 The STATUS LEDs provide the following information:
 • ALARM This indicates the presence of a (generic) emergency voice and/or recorded message being sent out.
 • CTRL IN This indicates the presence of a emergency voice and/or recorded message from one of the input contacts being sent out.
 • DISABLE This indicates the presence of at least one zone for which broadcasting of emergency messages is not envisaged.
 • FAULT This indicates the presence of a failure on at least one of the 6 output lines.

F6. ZonE outPut LEds
 The red MSG LEDs indicate in real time the zone(s) in which the emergency voice signal is being broadcast:
 Flashing Warning message being sent out.
 Steady ON Evacuation or live message being sent out.

 The yellow LInE A/B LEDs indicate the following:
 Flashing Zone failure: impedance measured on the zone is out of specifications.
 Steady ON This indicates the zones in which broadcasting of emergency messages is not envisaged (DISABLE function).

F7. PRoGRAM InSERtIon
 The LEDs indicate the following:
 Flashing The zone in which a broadcast call (NOT an emergency call) is being sent out.
 Steady ON Background music is activated for this zone (this function is only possible if there is also an amplifier MUS.-SPARE).
 The push-buttons allow background music to be activated in the corresponding zones (this function is only possible if there is also a  
 MUS.-SPARE amplifier).

F8. Status LEds
 Power supply/call status LEDs:
 • EMERG. This indicates that the system is in a state of emergency.
 • CALL This indicates that a broadcast call is being sent out.
 • ON This indicates the presence of the 230 VAC power supply.
 • BATT. This indicates the presence of the 24 VDC external power supply.
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5.2.3 Controller control panel

Rear panel
R1. PoWER switch
 See page 73.

R11. RELAY 1 – RELAY 2
 2 relay outputs for signalling to external peripheral units (see page 74).

R12. terminals for external 24 VdC power supply
 See page 74.

R13. Frame connection
 See page 74.

R14. Plug for 230 VAC mains power with built-in fuse
 See page 74.

R15. MuSIC SPARE / SPEECH terminals
 Terminal block for connection to the outputs of the voice and music/spare amplifiers. It is possible to set four different connection 

configurations.

R16. terminals Z1A/B to Z6A/B
 Power outputs for lines to speaker units. Use only speaker units with 100-V constant-voltage line repeating coils. Six output zones are 

available and each zone is split up into two lines, A and B, to create a loudspeaker network featuring double redundant lines. In the event 
of a short-circuit on one line, the VAIE 2250 system will de-activate the output for the failed line and will continue to power the other 
line of the same zone, activating a Failure signal. 12 pairs of screw-down terminals for wires having cross-sections of up to 2.5 mm2 are 
available for connecting the 0V-100V lines.

R17. ContRoL sockets
 • 7 monitored digital inputs for control via external peripheral units. These enable activation of programmable events, in Voice Emergency 

conditions, requiring pre-recorded emergency messages to be sent out automatically. Activation is possible via Normally Open or Normally 
Closed contacts, relaying the +24 VDC power supplied via the CONTROL socket. It is possible to enable diagnostics for the connecting 
line by installing two 10-kOhm balancing resistors in the proximity of the contact for activating the remote peripheral unit. This connection 
calls for a RJ45 socket with Cat. 5e SF/UTP cable.

 • 6 open-collector outputs for driving generic external or peripheral relays. The VAIE system enables the logical outputs to be programmed 
to link activation of the output with system status events or for override functions in emergency conditions or for signalling failures relating 
to the current emergency and to the disablement. These outputs can be programmed as Normally Open or Normally Closed and they 
have internal 24 VDC voltage with automatically resetting protection devices. This connection calls for a RJ45 socket with Cat. 5e SF/UTP 
cable.

R18. SPEECH and MuSIC/SPARE microphone sockets

 • SPEECH  Connection to the voice amplifier(s).
 • MUSIC/SPARE Connection to the music/spare amplifier. 

R19. SLAVE LInK In/out sockets
 Input/output for connection to the corresponding sockets on the VAC 2006 controller (RJ45 socket with Cat. 5e SF/UTP cable).

C1. Monitoring/beep loudspeaker
 Built-in loudspeaker for signalling detection of failures (beep). The signalling tone will be automatically muted if the failure conditions cease 

to exist. Furthermore, in order to avoid triggering acoustic feedback, it will be muted by the system while the Emergency Microphone is 
being used.

C2. RESEt button
 key for resetting the pre-recorded emergency messages manually, operational during Manual Emergencies. key for resetting the buzzer 

and for cancelling signalling of the failure, operational when there is a failure present or after a failure has been cleared. In the idle condition, 
this key is not operational.
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C3. ALERt button
 key for sending pre-recorded Alert messages manually, operation during Manual Emergencies. In the idle condition this key is not 

operational.

C4. EVAC button
 key for sending pre-recorded Evacuation messages manually, operational during Manual Emergencies. In the idle condition this key is 

not operational.

C5. MEnu key
 Multi-purpose key for accessing the Main Page, for navigating among the menus and for specific functions of the submenus indicated on 

the displays.

C6. oK key
 Multi-purpose key for confirming selections, for navigating among the menus and for specific functions of the submenus indicated on the 

displays.

C7. ESC key
 Multi-purpose key for returning to the Music menu, for navigating among the menus and for specific functions of the submenus indicated 

on the displays.

C8. numerical keys from 1 to 6
 Multipurpose keys, operational throughout the system. These keys are used to select the zones, from 1 to 6. For the VAC 2006 unit being 

used. They enable the access password to be entered or the specific functions indicated on the status bar on the display to be applied.

C9. Status signalling
 • ALARM LEd (red)
 LED for signalling the existence of a “Voice Alarm Condition”. A VOICE ALARM condition can be activated both automatically from an 

external peripheral unit, and manually by the operator of the VAC 2006 or of an emergency microphone station. During the VOICE ALARM 
condition, the standard functions for playing out music and the voice source service are disabled. In the “quiescent condition” the ALARM 
LED is extinguished.

 •  FAuLt LEd (yellow)
 LED for signalling the existence of a “Fault condition”. This indicates that the diagnostic system has detected at least one failure in the 

VAC 2006 unit or in one of the items of equipment connected to it and covered by the diagnostic procedure. When the fault condition is 
cleared, the FAULT LED extinguishes automatically and the wording “RES” is shown on the FAULTS display, to show that a failure has 
been detected and subsequently remedied (RESUMED). The LED signalling that the fault has been cleared will extinguish once the 
MANUAL FAULT RESET procedure has been completed. The FAULT signalling can be active during the standard functions of music and 
voice reproduction (quiescent Condition) and Emergency (Alarm Condition).

 •  dIS. LEd (yellow)
 LED for signalling activation of the disablement of the emergency zones (DISABLING). The DISABLING signal indicates that at least one 

zone has been disabled by the emergency envisaged when configuring the system. Activation of the DISABLING signal does not prevent 
normal operation of the system in a “quiescent Condition”.

 •  SYS LEd (yellow)
 LED for signalling an existing “System Fault” (System CPU Fault) condition. When the SYS LED is illuminated, all the operational functions, 

whether of the standard or emergency type, are disabled. 

 •  BAtt. LEd (green)
 This LED refers to the 24 VDC auxiliary power supply. The BATT. LED lights up to indicate that the 24 VDC power supply is connected 

to the system.

 •  on LEd (green)
 This LED signals that the VAC 2006 system is switched on and operational.
 The ON LED continues to be illuminated when:
 - 230 VAC power supply present and POWER switch in the ON position.
 The ON LED will flash continuously when:
 - there is no 230 VAC power supply but the 24 VDC power supply is available.
 The ON LED will be Off in the following cases:
 - no 230 VAC and no 24VDC power supply, or
 - 230 VAC power supply in order, no 24 VDC power supply and POWER switch in the OFF position. 

C10. +/- knob
 This is a rotary control with no end-of-travel. It is a multi-purpose control that depends on the specific menu that is operational. It is used 

to move the cursor to select and adjust values. In an idle condition, in the Music menu it is used to control directly the master output 
volume of the BGM.

C11. “EXt.” uSB socket
 Powered type A USB socket for connecting external flash memory devices (for future use).

C12. “to PC” uSB socket
 Type B USB socket, provisions for connecting the management PC in order to use the system software.
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6. ConFIGuRAtIon oF tHE SYStEM

6.1 IntRoduCtIon
The Controller Manager software enables the whole system you wish to create to be compiled and configured. To start running the programme, 
click twice on the “controller.exe” file.

N.B.: In order for the programme to work correctly, the operating system of the PC must be Windows 7® or higher.

6.2 CREAtInG A nEW PRojECt FILE
Once you have started the programme. You can already create a new system configuration. 
To create the new file, select File > new Project on the menu bar.
To add a description to the project, select Project > Edit description and enter it in the field provided (max 22 digits).
To save the new project, select File > Save Project As: use the dialogue box to assign a name to the project and identify or create a destination 
folder. The status bar at the bottom of the window will show that the operation has been completed successfully.

Once this has been done, you can start to configure the system.
To save an open project simply select File > Save Project*.

 
6.3 oPEnInG An EXIStInG PRojECt
To open a previously saved project, select File > open Project; in the dialogue box, select the folder and the desired *.prg file.

* It is possible at any time to compile a new project by selecting File > New Project. Of course all the previously entered data will be lost since 
the programme will start again from an empty project. 
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6.4 InSERtInG tHE ContRoLLERS
From the Tools menu, select tools > Insert Controller and add the 
number of VAC 2006 units in the system (in the example, there are two 
of them).
The controller with the address “0” is factory-set as the “Master”, and 
there must be one in each project. 

6.5 ConFIGuRInG tHE ContRoLLER
Now configure the single lines for each controller, starting from the 
Master and setting the parameters for line 1.
Press LInE 1 > Configure: A window will open in which you can select 
the equipment that is connected to this line (none, VAR 2006 router, 
DPU amplifiers or a VAIE 2250 compact system).

Select the required option and click on Continue >.
Each option leads to a specific dedicated window, except for “NONE”, 
which returns the line to an unused condition. 

• VAR 2006 - router
If you select this item, the Line 1 configuration window will open, in which you can select the features of the zones and the input and output 
contacts of the router. You can also indicate the presence of amplifiers connected to it. Once you have set the parameters, press End (or Cancel 
to exit without saving the changes made). 

You can find a brief summary of the settings made by clicking on LInE 1 > Report. 
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• dPu amplifiers

IMPoRtaNt NotICE!
all the amplifiers connected to a line must necessarily have progressive addresses, from number 1 onwards (max 16 for each line). to 
set the address of each single amplifier, consult the “Settings” section in the instruction booklet of the DPU range (FBt code number 
37784).

Supposing you wish to set line 2 for connection to amplifiers of the DPU range: after pressing LInE 2 > Configure and selecting DPU - amplifiers 
the Line 2 configuration window will open. 

In this window it is possible to list the amplifiers (and their models) connected to the lines in question, in addition to indicating whether they are 
stand-by amplifiers. The associations between the various different amplifiers and the standby units as selected under the heading “Configuring 
the standby amplifiers” (Page  83) are also highlighted. The programme will guide you through the procedure in order to ensure that several rules 
are followed:
- The entries are sequential, starting from address 1. If an amplifier half-way down the list is deleted by selecting model = “none” as the model, 

therefore, all the amplifiers with the next addresses will also be removed.
- One line can manage up to a maximum of two standby units. The first of these is “global”, that is to say it can replace the amplifiers of any other 

line of the controller. The second standby unit can be either:
 • “global” if there are only two standby units on the lines; or
 • “local” if there are additional amplifiers on the line. In this case, the standby unit can only replace amplifiers belonging to the same line as 

the unit itself.
The programme carries out cross-checks to ensure that the compilation is correct.

Once you have completed the compilation, press End to save the configuration, which will appear associated with line 2 in the main window. As 
an alternative, you may press Cancel to exit without saving the changes made. 

• VAIE 2250 compact system
For line 3, set a connection to a VAIE 2250 compact system: after pressing  
LInE 3 > Configure and selecting the item VAIE 2250 - compact the Line 3 
configuration window will open.

Once you have set the parameters for all the lines, go on to compile the other 
four connections shown in the main window: CTR INPUT, CTR OUTPUT, 
EMERGENCY UNITS and BROADCASTING UNITS.
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• CtR InPut
Press CtR InPut > Configure.  The Controller 0 input 
configuration window will open, in which you can associate 
the required parameters with each of the 7 contacts.

Press End to save the configuration, or press Canc. to 
cancel it and return to the main window.

• CtR outPut
Press CtR outPut > Configure. The Controller 0 output configuration 
window will open, in which – as already seen for the inputs – you can 
associate the required parameters with each of the 3 contacts.

Press End to save the configuration, or press Canc. to cancel it and 
return to the main window.

• EMERGEnCY unItS
Press EMERGEnCY unItS > Configure. The window for 
configuring the emergency stations that can be connected will 
open.

To set a specific configuration for the keys associated with each 
emergency station, press the relevant Key Conf.: It is possible 
to call up a configuration that has already been defined (see 
“Configuring groups of zones”) or to make changes manually to 
the default configuration prompted in the ‘Unit key list’ box.

Press End to save the configuration, or press Canc. to 
cancel it and return to the main window.
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• PAGInG unItS
Press PAGInG unItS > Configure. The broadcasting call station 
configuration window will open.
To set a specific configuration for the keys associated with each 
emergency station, press the relevant Key Conf: It is possible to call up 
a configuration that has already been defined (see “Configuring groups 
of zones”) or to make changes manually to the default configuration 
prompted in the ‘Unit key list’ box. To do this, from the list on the right-
hand side, select the key for which you wish to change the setting. 
From the list on the left-hand side, select the zone or the configuration 
you wish to associate with it, then click on the central arrows. The new 
combination selected by you will appear immediately on the list on the 
right-hand side.

Press End to save the configuration, or press Canc. to 
cancel it and return to the main window.

• Configuring groups of zones
From the menu, select View > Key configuration to open a complete schedule of the zones referred to the controllers installed in the system. 
Against a white background, the window will show the number of units and zones that have been set. For each controller, the active zones are 
shown in red. The status of each zone can be altered simply by clicking on the number, which will turn green.  
After setting the zones you require, click on Save to save the configuration. To create the next configuration file, select the name in the drop-down 
menu as before. In this window, you can set up to 64 configuration files, which you can call up in the configuration windows of the stations (see 
previous sections).
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• Configuring the standby amplifiers
From the menu, select View > Spare configuration 
to open a complete schedule of all the amplifiers 
installed in the system. 

In the window, the left-hand column shows 
the DPU amplifiers entered previously in the 
configuration file as standby units. For each of 
these, it is possible to indicate the amplifiers they 
will replace in the event of a failure. To do this, 
select the amplifier in the drop-down menu and 
click on ‘Add’ to associate it with its standby unit.

Once you have loaded the file, you can indicate 
whether it is a message to be sent in warning 
situations (Alert) or in evacuation situations 
(Evac).
It is also possible to add a brief description of 
each message entered (max 25 digits).

In addition to voice messages, a warning tone 
(Chime) can also be entered, using the same 
procedure.

Press End to save the configuration, or press 
Canc. to cancel it and return to the main window.

• Compiling voice messages / warning signals
From the menu, select View > Message Compiler to open the window enabling management of the pre-recorded voice messages and of the 
warning signal, if any. Click on Path > Add file and load the required *.wav file.

n.B.. the files to be used must necessarily be recorded in and /or converted into the *.WAV 48 ksample 16bit audio format. 

Once you have completed configuring CONTROLLER 0, save the project and click on the “CONTROLLER 1” tab to proceed with its 
configuration.
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• Creation of an Sd card
Once you have completed all the configuration activities, all the information must be downloaded to an SD card, which will then be plugged into 
the appropriate controller. one Sd card must be created for each controller in the system. Each single card will contain the information 
relating both to the specific controller and to the rest of the system.

After making sure that CONTROLLER 0 is switched off, use a screwdriver to unscrew the small cover at the centre of the rear panel and remove 
it.

At this point, the main window of the programme will show most of the settings made:  

It is possible to obtain a complete printable report of all the settings simply by clicking on ‘Ctr configuration report’, ‘Zone configuration report’ and 
‘Spare configuration report’.

Insert the SD into the drive of the PC, then select the CONTROLLER 0 window. From the main menu, select tools > Create SD. The card will 
be formatted and then automatically programmed with the necessary data.
Once writing has been completed, remove the SD card from the PC, then plug it into its slot in the rear panel of CONTROLLER 0. Put the cover 
back into place and fix it with the screws removed earlier.

Repeat these operations for all the other controllers (in the example, CONTROLLER 1).
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MEnu

ESC

7.   MEnu StRuCtuRE

The VAC 2006 enables access to the system functions through a set of Management Panels, grouped according to operational typologies and 
intended uses into Option Menus accessible from the Main Page. Furthermore, the following Option Menus were assigned to different levels 
of access, with reference to the various different circumstances requiring different degrees of skill on the part of the personnel and different 
levels of authorisation.

• < MuSIC > Menu
Default window for using the system in normal quiescent Conditions. It enables control of the BGM sources and adjustment of the volumes of 
the music section. This menu is not accessible during a Voice Alarm Condition. At this basic level, the RESET, ALERT and EVAC keys are not 
operational.

• < AudIo SEttInG > Menu
Group of basic options for standard operating conditions. It is intended for users for setting and adjusting the PA sources. At this basic level, the 
RESET, ALERT and EVAC keys are not operational.

• < InSPECtIon > Menu  
First access level, for investigating the status of the system. It is intended for the personnel responsible for initial checking of the causes leading 
to a failure or emergency condition. At this initial access level, the RESET key has the function of resetting the buzzer signalling a FAULT. At 
this basic level, the ALERT and EVAC keys are not operational.

• < oPERAtoR > Menu
Second access level for trained personnel, authorised to manage the system in emergency, failure and disablement conditions. A password for 
accessing this level can be added.

• < ConFIGuRAtIon > Menu
Third access level, for trained personnel authorised to use the advanced functions of the system and to alter the configuration parameters, for 
starting up and altering the system. A password for accessing this level can be added.

• < SERVICE > Menu
Fourth access level, included among the options of the CONFIGURATION Menu, for servicing activities, up-dating of firmware and altering the 
operating parameters of the VAC 2006 controller. Use is permitted only for technical personnel having the necessary access key.

• < EMERGEnCY > Menu
Operational environment for managing Manual Emergencies, with top priority. Accessible at all times using the dedicated “Emergency” key, it 
may be used only by authorised personnel trained with regard to the Emergency and Evacuation Plan (EEP).

The functions associated with levels featuring restricted access, for which a password may be set, are highlighted by the symbol

7.1 “HoME” FunCtIonS - ACCESS to tHE oPtIon MEnuS
7.1.1  Basic Level - MuSIC menu
After switching on the system, the MUSIC Management Window will be shown directly. To access the HOME page, press the MENU key. From the 
HOME page it will be possible to select the various different Option Menus for the advanced functions of the system. From the HOME page, press 
ESC to return to the MUSIC management panel. 
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7.1.2 Basic Level - AudIo SEttInGS Menu
From the HOME page, press Ok to select AUDIO SETTING and access the menu in question. From the AUDIO SETTING menu, use the knob 
at the side of the display unit to browse through the options listed, then use Ok to select the one you require. Press ESC to return to the MUSIC 
menu or MENU to return to the HOME page. For the specific features of each panel for managing the AudIo SEttInG menu, refer to the 
appropriate schedules in Section 8. uSInG tHE SYStEM / 8.3 < AudIo SEttInGS Menu >.

7.1.3 System Level - InSPECtIon Menu
From the HOME page, turn the knob then press Ok to select the item INSPECTION and access the menu in question.
From the INSPECTION menu, use the knob at the side of the display unit to browse through the options listed, then use Ok to select the one you 
require. Press ESC to return to the MUSIC menu or MENU to return to the HOME page. For the specific features for each panel for managing 
the InSPECtIon menu, refer to the appropriate schedules in Section 8. USING tHE SYStEM / 8.4 < INSPECtIoN Menu >.

7.1.4   System Level - oPERAtoR Menu
 From the HOME page, turn the knob, then press Ok to select the item OPERATOR: to access the menu in question it is it is necessary 

to enter a password and then press Ok again. As an alternative press ESC to return to the MUSIC menu.
 From the HOME page, turn the knob, then press Ok to select the item OPERATOR: to access the menu in question it is it is necessary 

From the OPERATOR menu, use the knob at the side of the display unit to browse through 
the options listed and select the one you require using the Ok key. Press ESC to return to 
the MUSIC menu or MENU to return to the HOME page.  For the specific features for 
each panel for managing the oPERAtoR menu, refer to the appropriate schedules in 
Section 8. USING tHE SYStEM / 8.5 < oPERatoR Menu >.
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7.1.5   System Level - ConFIGuRAtIon Menu
 From the HOME page, turn the knob, then press Ok to select the item CONFIGURATION: to access the menu in question it is necessary 

to enter a password and then press Ok again. As an alternative press ESC to return to the MUSIC menu.
 From the HOME page, turn the knob, then press Ok to select the item CONFIGURATION: to access the menu in question it is necessary 

From the CONFIGURATION menu, use the knob at the side of the display unit to browse 
through the options listed and select the one you require using the Ok key. Press ESC 
to return to the Music menu or MENU to return to the HOME page.  
For the specific features for each panel for managing the ConFIGuRAtIon/
SERVICE menu, refer to the appropriate schedules in Section 8. USING tHE 
SYStEM / 8.6 < CoNFIGURatIoN menu >.

7.1.6   System Level - SERVICE Menu
 Access the CONFIGURATION menu then use the knob at the side of the display unit to scroll to the <SERVICE> option and press 

Ok to select it. To access the menu in question it is necessary to enter another password and then press Ok again. As an alternative 
press ESC to return to the MUSIC menu.

 Access the CONFIGURATION menu then use the knob at the side of the display unit to scroll to the <

The Functional Specifications of the panels for managing the 
SERVICE menu are the responsibility of the Service personnel 
and beyond the scope of this User Manual. They are therefore 
not illustrated here.
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MENU

ESC

8. uSInG tHE SYStEM
After making all the connections as indicated in Section 4, Connections, start 
the VAC 2006 by turning ON the POWER switch (R1). The display will light 
up and show the panel of the MUSIC menu, from which you can access the 
HOME page pressing MENU. 
If the system is being used for the first time, or if the configuration has 
been changed, proceed according to the indications shown in the section 
8.1 Initialising the system. If the initialise procedure is complete, see the 
instructions of the following sections:
• For normal use of background music and voice announcements, users can 

use just MUSIC and AUDIO SETTING menu.
• For the management of advanced features during fault, emergency and 

configuration condition, see the following menu INSPECTION, OPERATOR, 
and EMERGENCY CONFIGURATION.

• To reset the “beep”, consult the OPERATOR Section (point 8.5.3.1, 
page 103).

• To send emergency messages, consult the MANUAL EMERGENCY 
Section (point 8.7, page 110).

The functions associated with levels featuring 
restricted access, for which a password may be set, 
are highlighted by this symbol.
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8.1 InItIALISInG tHE SYStEM
The project of the audio system must be implemented with the help of the specific  software (see Section 6, “Configuring the system”, on page 
78).

• Password
From the HOME page, select the CONFIGURATION menu and press Ok to confirm your choice. If the restriction calling for access with a 
password has been enabled, the “CONFIGURATION ACCESS” screen will appear: enter the 4-digit code of the password, then press Ok to 
confirm (the default password is 3333, see page 106).
• Resetting the BEEP
Failure signals may occur during the initialisation procedure due to the differences between the configuration of the system as connected and the 
default settings. To reset the acoustic signal (beep), access the “Report> FAULT” menu and press the RESET key. For details consult “FAULT”  
(point 8.5.3.1, page 105). 
 o Path: HOME / CONFIGURATION / report> FAULT (press RESET key).
• Acquisition of impedances
From the MUSIC menu, set all the outputs with music “OFF”. For details, see “MUSIC menu” (point 8.2.4, page 90).
Acquire the new loading impedances of the loudspeaker lines, as indicated under “IMP. ACqUISITION” and enable the test by setting the 
measurement tolerances.
 o Path: HOME / CONFIGURATION / set> TOLERANCE / SET TOLERANCE
 o Path: HOME / CONFIGURATION / acquire> IMPEDANCE / IMP. ACqUISITION (press the Ok key)

• diagnostics for 24 VdC power supply
If the auxiliary 24 VDC power supply has been connected, enable the diagnostic test by setting “24 VDC  P.S. ON”, as illustrated under 
“BACkGROUND TEST” (point 8.5.2.3, page 104). 
 o Path: HOME / CONFIGURATION / set> BACkGROUND TEST / 4-Power supplies

• Emergency messages
The emergency messages are stored on the SD card using the dedicated software (see page 83).

• Input contacts
Use the dedicated software to programme the input contacts in the appropriate manner on the basis of the Emergency and Evacuation Plan 
(E&EP) (see page 81).
 o Path: HOME / CONFIGURATION / set> CONTROL INPUTS

• output contacts
Use the dedicated software to programme the output contacts in a suitable manner, on the basis of system specifications, if any (see page 81).
 o Path: HOME / CONFIGURATION / set> CONTROL OUTPUT

• Volume control
Adjust the output volume of the Emergency sources suitably so as to ensure that the messages are as intelligible as possible. The level set will 
be used for ”Voice Alarm Conditions” and will be the same for all the zones. To adjust the volume of the Emergency Microphone and of the ALERT 
and EVAC messages, follow the instructions  provided under “ALARM LEVEL” (point 8.6.4, page 109).
 o Path: HOME / CONFIGURATION / set> ALARM LEVEL

• Resetting failures
Upon completion of the system configuration, the reports concerning failure that have been stored and cleared should be cancelled (RESOLVED). 
A FAULT RESET should therefore be carried out as indicated under “FAULTS” (point 8.5.3.1, page 105). 
 o Path: HOME / CONFIGURATION / report> FAULT, access the subpanels for viewing failures 

• After initialising the system
After completing the system initialisation procedure, LOG OUT in order to reinstate any access restrictions associated with passwords (point 
8.5.5, page 105).
 o Path: HOME / CONFIGURATION / Exit> Logout (press the Ok key).
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8.2 <MuSIC> MEnu
 Setting the audio parameters of the BGM sources
Music source control panel, shown by the VAC 2006 in normal “quiescent Condition”.

•  Indications on the display
A) General output volume of the BGM Source
B) Status labels of each of the 6 zones:
 oFF Music disabled
 ndB Music enabled with the associated output volume 
 CALL Call in progress from a “voice” source (PA Source).
 nA  Line not active.
C) BGM Source selected for the “music” channel.
D) PA Source active on the “voice” channel for service announcements.

note: The VAC 2006 system enables service announcements to be made from a PA Source to the required zones while continuing to broadcast 
music to all the other zones not affected by the call. When an announcement is being made, the display will show the source that is being used 
on the voice channel (d), and the status label of each zone selected (B) will indicate the word CALL. 
Service announcements will be broadcast at the volume set for the input of the PA Source (see AUDIO SETTINGS menu) and if appropriate will 
also be sent to the zones for which music is de-activated (OFF).

•  navigation keys
MENU: For accessing the MAIN page
Ok: For selecting a source of BGM
kEYS 1 to 6: For selecting music zones 
RESET: Not operational
ALERT: Not operational
EVAC: Not operational

8.2.1  Selection of a BGM Source for the “music” channel
Press oK to select the required source of music from among the following:
• AUX Microphone source connected to the LINE AUX IN input (R7).
• REMOTE Source selected by the secondary VAC 2006 via the VAC 2006 LINk socket (R3).
• INPUT 1 Microphone source connected to the IN 1 input (R6).
• INPUT 2 Microphone source connected to the IN 2 input  (LINE or MIC sockets) (R5).
• NO INPUT No input selected. 

8.2.2  overall volume control of the “music” channel BGM Source
• Use the +/- knob to adjust the volume. 
The attenuation setting is visible directly on the display (A), with variations of 1 dB. 
The volume that is set is stored for each BGM Source selected.

8.2.3  Adjustment of the music volume for each output zone
• Hold the numerical key of the required zone (from 1 to 6) down and turn the +/- knob.
The output volume is adjustable to any of 5 levels of attenuation in respect of the master volume (A); the attenuation steps are as follows:
-15dB (maximum attenuation), -9dB, -6dB, -3dB, 0dB (no attenuation).
The volume that is set refers only to the “Music” channel. 

N.B.: Adjustment is not possible on those lines to which an VAR 2006 router is connected. 

8.2.4  Activation and de-activation of music for each output zone
• Press and then release the numerical key of the required zone (from 1 to 6). 
The status label (B) will switch between oFF (music disabled) and ndB (music on and associated output volume).
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8.3    < AudIo SEttInG > MEnu
Setting the audio parameters of the PA sources
Menu for accessing the panels for managing the audio parameters of the 
music and voice sources.
Turn the knob to browse through the items listed and select the required item. 
Then press Ok to confirm, or:
- Press MENU to return to the HOME page.
- Press ESC to return to the MUSIC menu.

The options of the AUDIO SETTINGS menu enable the following panels to be 
accessed:
8.3.1 set> SPEECH LEVEL
Volume control for the voice sources connected to the VAC 2006.

8.3.2   set> CHIME
Volume control and assignment of voice sources for the CHIME.

8.3.3 InPut 1 
Volume control and setting of the operating mode of the IN 1 input (MIC.).

8.3.4 InPut 2
Volume control and setting of the operating mode of the IN 2 input (MIC. or LINE).

8.3.1 Set> SPEECH LEVEL
 Management of voice sources
Panel for setting the levels of the voice sources connected to the VAC 2006:

1- Emerg.unit Emergency stations of the FMD range.
2-Broad. unit Broadcasting stations of the MBTrange.
3-Mic 1 input Microphone connected to the MIC 1 IN socket.
4-Mic 2 input Microphone connected to the MIC 2 IN socket.
5-From remote Other controllers connected to the LINk sockets on the VAC 2006.

•   Volume control:
Hold down the numerical key corresponding to the source then turn the +/- knob to 
adjust the volume (range -80 to 0 dB).

8.3.2 set> CHIME
 Management of the warning signal (chime)
Panel for setting the chime that is produced on activating a voice source.

•   Attivazione del tono di Chime: 
Press keys 2, 3 and 4 then release them to set the chimes for the various different 
sources:
2-Emerg. unit call: FMD 2001 and FMD 2012 Emergency Stations for broadcasting 

announcements connected to the “EMERGENCY UNITS” 
socket.

3-Brd. unit call:  Microphone stations of the MBT 1106 or MBT 1112 ranges 
connected to the “PAGING UNITS” socket. 

4-Preced. call: Inputs programmed to activate announcements by means of 
precedence or VOX contacts.

Reference values:
on=Chime active
oFF=Chime not active

•   Adjustment of the volume of the Chime tone:
Hold down key 1 and use the +/- knob to adjust the volume within the range from 0 to 255; the volume is common to all four inputs and is separate 
from the volume adjustment assigned to the sources.

•   Loading the Chime tone:
The Chime audio file is managed by the dedicated software (see page 83). 
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8.3.4 InPut 1 
 Management of the source on the In 1 input
Hold the numerical key associated with the function down and turn the +/- 
knob to adjust the setting.
• 1-Mode: Setting of the operating mode of the input for using the voice 

channel as a PA Source. 
  Hold key 1 (Mode) down and turn the +/- knob to select the 

required mode from among the following:
  >  on:
   The input will be connected directly as a voice source and will 

be operational on the basis of the priority and of the zone list 
that is selected.

The RESET, ALERT, EVAC, MENU and Ok have no functions.
Press ESC to return to the AUDIO SETTINGS menu.

   > VoX lev. 1÷7:
   This input is set as a voice source with automatic precedence activated by the presence of the incoming audio signal. The 

precedence is activated when the audio signal exceeds the threshold level that has been set. It is possible to choose from 
among seven increasing threshold levels. Careful adjustment of the threshold will enable prompt broadcasting of the signal to be 
achieved, avoiding involuntary activation of precedence by noise induced on the cable.

   > Precedence:
   The input is enabled for broadcasting as a voice source by closure of a contact connected to the precedence terminals.

  > off: input disabled for the PA announcement function. The source connected continues to be available for selection as a BGM 
Source.

• 2-Zone call: Setting the operating mode of the input for using the voice channel as a PA source. Hold down key 2 (Zone call) then turn the  
 +/- knob to select the required mode from among the following options:

    > Z. 1 ÷ Z. 216:  To select the specific zone in which you wish to broadcast the calls/music.
    > All:  To broadcast the calls/music to all the zones in the system.
    > C. 1 ÷ Z. 64: To select a pre-established group of zones (these configurations can be created using the controller.exe 

software) in which to broadcast the calls/music.
• 3-Hold on: To set the release time after an input signal, when the VOX mode is selected.  
  Hold down key 3 (Hold on) then turn the +/- knob to choose a time (between 1 and 99 secs.).

• 4-Priority: Priority assigned to an input when it is used as a voice source for service announcements. There are 7 priority levels. The input can 
be muted by another voice source featuring a higher level of priority. Hold down key 4 (Priority) then turn the +/- knob to choose the 
required level.

• 5-Sensitivity: Adjustment of sensitivity. Press key 5 (Sensitivity) to choose the required level (between 0, 6, 12 or 18 dB). 

• 6-Phantom: Setting of the Phantom power supply (OFF = not active / ON = active). To change the setting, press key 6 (Phantom), then release 
it.

8.3.3 set> REMotE MuSIC
 Managing Music towards other controllers
Panel enabling music to be sent to other controllers connected to the LINk 
A and B lines to be enabled/disabled. Activation of this function on a single 
controller within the system is recommended.

Reference values:
on=Function active
oFF=Function not active

The RESET, ALERT, EVAC, MENU and Ok keys are not operational.
Press ESC to return to the AUDIO SETTING menu. 
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8.3.4 InPut 2 
 Management of the source on the In 2 input
Hold the numerical key associated with the function down and turn the +/- 
knob to adjust the setting.
• 1-Mode: Setting of the operating mode of the input for using the voice 

channel as a PA Source. 
  Hold key 1 (Mode) down and turn the +/- knob to select the 

required mode from among the following:
  >  on:
   The input will be connected directly as a voice source and will 

be operational on the basis of the priority and of the zone list 
that is selected.

The RESET, ALERT, EVAC, MENU and Ok have no functions.
Press ESC to return to the AUDIO SETTINGS menu.

   > VoX lev. 1÷7:
   This input is set as a voice source with automatic precedence activated by the presence of the incoming audio signal. The 

precedence is activated when the audio signal exceeds the threshold level that has been set. It is possible to choose from 
among seven increasing threshold levels. Careful adjustment of the threshold will enable prompt broadcasting of the signal to be 
achieved, avoiding involuntary activation of precedence by noise induced on the cable.

   > Precedence:
   The input is enabled for broadcasting as a voice source by closure of a contact connected to the precedence terminals.

  > off: input disabled for the PA announcement function. The source connected continues to be available for selection as a BGM 
Source.

• 2-Zone call: Setting the operating mode of the input for using the voice channel as a PA source. Hold down key 2 (Zone call) then turn the  
 +/- knob to select the required mode from among the following options:

    > Z. 1 ÷ Z. 216:  To select the specific zone in which you wish to broadcast the calls/music.
    > All:  To broadcast the calls/music to all the zones in the system.
    > C. 1 ÷ Z. 64: To select a pre-established group of zones (these configurations can be created using the controller.exe 

software) in which to broadcast the calls/music.
• 3-Hold on: To set the release time after an input signal, when the VOX mode is selected.  
  Hold down key 3 (Hold on) then turn the +/- knob to choose a time (between 1 and 99 secs.).

• 4-Priority: Priority assigned to an input when it is used as a voice source for service announcements. There are 7 priority levels. The input can 
be muted by another voice source featuring a higher level of priority. Hold down key 4 (Priority) then turn the +/- knob to choose the 
required level.

• 5-Sensitivity: Adjustment of sensitivity. Press key 5 (Sensitivity) to choose the required level (between 0, 6, 12 or 18 dB). 

• 6-Phantom: Setting of the Phantom power supply (OFF = not active / ON = active). To change the setting, press key 6 (Phantom), then release 
it.
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8.4   < InSPECtIon > MEnu
Panel for selecting options for investigating the status of the system. Only personnel 
authorised to carry out initial investigation of the causes leading to a fault or 
emergency condition may use this panel. 

• report > FAuLtS   
• report > IMPEdAnCE
• report > ConFIG.
• status > ContRoL InP.
• test > IndICAtoRS
< oPERAtoR >
< ConFIGuRAtIon >

Press Ok to select the required item or
- press ESC to return to the MUSIC screen. 
- press MENU to return to the HOME page.

The options of the INSPECTION menu enable the panels for managing the following to be accessed:

8.4.1 FAuLtS panel (from the report> FAuLtS option) 
For checking the status of the current or cleared past failures query.

8.4.2 IMP. REAL tIME panel (from the report> IMPEdAnCE option)
For viewing in real time the line impedance values detected by the system, indicating the percentage of deviation from the value stored at the 
time of initialising the system.

8.4.3 CtR ConFIGuRAtIon panel (from the report> ConFIG option)
To display the system configuration.

8.4.4 ContRoL InPut StAtuS panel (from the status> ContRoL InPut option)
For viewing in real time the status of the input contacts of the VAC 2006 that can activate an Automatic Emergency.

8.4.5 IndICAtoRS tESt panel (from the test> IndICAtoRS option)
For checking the functionality of the signalling elements connected with the emergency (buzzer loudspeaker, display and LEDs)

< oPERAtoR >
Passaggio diretto al menu OPERATOR (point 8.5, page 102).

< ConFIGuRAtIon >
Passaggio diretto al menu CONFIGURATION (point 8.6, page 106).
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8.4.1 FAuLtS
 For viewing the failed components  
Six groups are listed, with a generic indication of the fault condition.
The categories of failed parts and generic signalling of their states are shown in the 
table below.
Press the associated numerical key (1-6) to select the sub-panel and view the details 
of the failure, as illustrated under points below
or 
Press ESC to return to the INSPECTION panel.

8.4.1.1 Automatic resetting of the acoustic signal (beep) following clearing of a failure
If the cause of a failure is cleared before the beep is reset manually (see OPERATOR Menu, point 8.5.3.1, page 105), the VAC 2006 will reset 
the beep automatically, extinguish the FAULT LED and indicate RES (RESUMED) in the label of the part that had FAILED. The RESOLVED 
signal will be stored until a MANUAL RESET of the failure signal is carried out from the FAULTS panel via the OPERATOR menu.

Tab. 8.4.1.1

Label diagnostic category See panel Signalling Cause

1-Loudspk Line Loudspeaker lines LOUDSPk. LINE FAULT

A
LL

Ok No faults2-Voice Alarms Emergency sources VOICE ALARMS FAULT

3-Amplifiers Power amplifiers 
Ground fault loudspeaker lines AMPLIFIER FAULTS

4-Power Supply Primary and secondary power supplies 
Management memory display POWER SUPPLY FAULTS FAULT At least 1 fault detected  

and on-going 

5-Control Input Local input contacts CONTROL INPUT FAULT
RES At least 1 fault cleared  

and no on-going faults6-Communication VAC 2006 internal data communication COMMUNICATION FAULT
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8.4.1.2 LoudSPK. LInE FAuLt
 diagnostics of line speaker units
From the FAULTS panel (point 8.4.1), press numerical key 1 and access the 
panel for viewing the loudspeaker line diagnostics: the diagnostics for each 
output zone are shown as indicated in the following table.
 

Press ESC to return to the FAULTS panel.

Note1:
To eliminate a short circuit between lines A+B and then reset the amplifier on the line, simply press RESET.

Note2:
“Impedance Hi” and “Impedance Low” failures are not reported if the tolerance is set at a higher level than the measured variation of the 
impedance or if the test is disabled. For details concerning programming, see the SET TOLERANCE panel (point 8.6.2, page 107).

8.4.1.3 VoICE ALARMS FAuLt
 diagnosing faults of the Emergency sources
From the FAULT panel (point 8.4.1), press numerical key 2 and access the 
panel for viewing the diagnostics of the Emergency sources. The diagnostic 
state of each item monitored is reported, as shown in the following table.

For some items of equipment it may be necessary to access the sub-panel, 
by pressing the corresponding numbered key.

Press ESC to return to the panel FAULTS.

Tab. 8.4.1.2

Label Part being 
diagnosed Signalling Cause Action required

A
LL

Ok No failure -

Line 1 Speaker units
Zone 1

Short A Short circuit on the line connected to 
output A Eliminate the short circuit and 

carry out a MANUAL RESET of 
the FAILURE signal (from the 
OPERATOR menu)

Line 2 Speaker units
Zone 2

Short B Short circuit on the line connected to 
output B 

Line 3 Speaker units
Zone 3

Short A+B Short circuit on both lines of the zone  
(Note1)

Line 4 Speaker units
Zone 4

Impedance Hi Impedance level higher than acquired 
value detected, beyond the tolerance set 
during configuration (Note2)

Check the connections of the speaker 
units and if necessary repeat the line 
acquisit ion procedure (ACqUIRE 
IMPEDANCE)Line 5 Speaker units

Zone 5

Impedance Low Impedance level lower than acquired value 
detected, beyond the tolerance set during 
configuration (Note2)

Line 6 Speaker units
Zone 6

Res. imp. Hi Failure (“Impedance Hi” signal) cleared Access the Report > FAULTS panel 
from the OPERATOR menu and carry 
out a MANUAL RESET of the FAILURE 
signal

Res. imp. Low Failure (“Impedance Low” signal) cleared
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Label Part being diagnosed display Cause Action required

All All

Ok No failure -

N.T.
Diagnostics disabled during 
configuration (see Set> 
BACkGROUND TEST menu) 

-

Res. Failure (Fault signal) cleared
Access the Report> FAULTS panel from the 
OPERATOR menu and carry out a MANUAL 
RESET of the FAILURE signal.

1-Local emerg. Hand-held microphone or  
Emergency Push-button. Fault Failure of hand-held microphone 

or of Emergency Push-button.

Make sure that the microphone has been 
correctly plugged into the socket on the front 
panel. If the failure persists, contact the Service 
Centre.

2-Configuration SD card Fault SD card error or error in reading 
messages.

Make sure that the SD card has been correctly 
plugged into its slot on the rear panel of the 
controller.

3-Emerg. Unit Emergency 
microphone stations Fault Failure of at least one 

emergency microphone station.

Make sure that the microphone of the station 
is correctly plugged in. If the failure persists, 
contact the Service Centre.

4-Messages
Recorder/player of the 
emergency EVAC and ALERT 
message

Fault Presence of two or more failures.
Make sure that the SD card has been correctly 
plugged into its slot on the rear panel of the 
controller.

5-Line connect.

CAT5 connection to: 
- DPU 
- VAR 
- AMP
 

Fault

Communication error.

Check the connections. If the failure persists, 
contact the Service Centre.

6-Remote Link Intercommunication with 
remote VAC 2006 units Fault

Press key 6 to access the dedicated “LINk 
FAULTS” panel. Check the connecting cables 
between the VAC 2006 units for connection 
VAC 2006 LINk. 
If the failure persists, contact the Service 
Centre.

Tab. 8.4.1.3
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8.4.1.4 AMPLIFIER FAuLtS
 Power amplifier diagnostics and Gnd fault
From the FAULTS panel (point 8.4.1), press numerical key 3 and access the 
panel for viewing the power amplifier diagnostics and ground faults of the 
loudspeaker lines. 
The diagnostic state of each item monitored is reported, as shown in the 
following table (Table D).

Press ESC to return to the panel FAULTS.

Label Part being diagnosed display Cause Action required

All All

Ok No failure -

N.T.

NOT TEST. Diagnostics 
disabled during configuration 
(See Set> BACKGROUND 
TEST menu)

-

Res. Failure cleared due to 
previous Fault signal

Access the report> FAULTS panel from the 
OPERATOR menu and carry out a MANUAL 
RESET of the FAILURE signal.

Amplifier n

Amplifiers of the DPU 
range connected to the 
controller or MPA 5240/48 
amplifiers connected to 
the router

Amp ok -

Input 20kHz 
Check that the connection 
between the controller and the 
amplifier is sound.

Check that the connections between the 
controller, the amplifier and the router have 
been made correctly.
If the failure persists, contact the Service 
Centre.

Out 20kHz 
Make sure that there is an 
output signal on the line.

Make sure that the amplifier has been 
connected to the network and switched on.
If the failure persists, contact the Service 
Centre.

Gnd Fault 
Check the insulation between 
the loudspeaker lines and 
earth.

Check the connections of the loudspeaker 
lines. If the failure persists, contact the 
Service Centre.

Tab. 8.4.1.4
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8.4.1.5 PoWER SuPPLY FAuLtS
 Power supply and display memory diagnostics
From the FAULTS panel (point 8.4.1), press numerical key 4 to access the 
panel for viewing the diagnostics of the primary and secondary power supplies 
and of the memory for managing the display.

The diagnostic state of each item monitored is reported, as shown in the 
following table.

Press ESC to return to the FAULTS panel.

Label Part being diagnosed Cause Action required

All All

Ok No failures -

N.T.
NOT TEST. Diagnostics disabled 
during configuration (See Menu 
set> BACkGROUND TEST)

-

Res. Failure cleared due to previous 
failure signal

Access the Report> FAULTS panel from 
the OPERATOR menu and carry out a 
MANUAL RESET of the FAILURE signal.

  Contr. mains
Primary power supply 
of the controller 
@230Vac

Fault

Primary power supply of the 
controller not detected

Check the 230 VAC power supply, the 
connecting cable and the mains fuse. 
If the failure persists, contact the Service 
Centre.

  Contr. 24VDC
Secondary power 
supply of the controller
@24Vdc

Secondary power supply of the 
controller not detected

Check the 24 VDC power supply, the 
connecting cable and the mains fuse. 
If the failure persists, contact the Service 
Centre.

  3-Rtr/VAI mains
Primary power supply 
of the router/VAIE 2250 
@230Vac

Primary power supply of the 
router or VAIE 2250 not detected

Check the 230 VAC power supply, the 
connecting cable and the mains fuse. 
If the failure persists, contact the Service 
Centre.

  4-Rtr/VAI 24VDC
Secondary power 
supply of the router/
VAIE2250 @24Vdc

Secondary power supply of the 
router or VAIE 2250 not detected

Check the 24 VDC power supply, the 
connecting cable and the mains fuse. 
If the failure persists, contact the Service 
Centre.

 Ctr display Controller display Fault Upset detected on display Contact the Service Centre.

 VAIE display VAIE 2250 display Fault Upset detected on display Contact the Service Centre.

Tab. 8.4.1.5
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8.4.1.6 InPut ERRoR
 diagnostics of the local control inputs  
From the FAULTS panel (point 8.4.1), press numerical key 5 to access the panel for viewing the diagnostics 
of the local control inputs. The diagnostic state of each item monitored is reported, as shown in the following 
table. Press ESC to return to the panel FAULTS.

8.4.2 IMP. REAL tIME  | Real-time line impedance 
Panel for checking the impedance values measured in real time, and percentage variations from the value stored during start-up, using the “Line 
impedance acquisition” procedure. The lines being used are listed. You can select a numerical key to access the corresponding panel indicating 
the impedance measured in Ohms referred to the parallel of lines A and B connected to that line. 

8.4.1.7 CoMMunICAtIon FAuLt
 diagnostics of the internal data communication of VAC 2006
From the FAULTS panel (point 8.4.1), press numerical key 6 and access the panel for viewing the diagnostics 
of the internal data communication of VAC 2006. The diagnostic state of each item monitored is reported in 
the following table. Press ESC to return to the panel FAULTS.

Label data being diagnosed display Cause Action required

I2C bus Data communications between the CPU 
and the keys and front-panel LEDs All Fault Internal communication failure. Contact the Service Centre.

SPI Data communication between CPUs. All Fault Internal communication failure. Contact the Service Centre.

Tab. 8.4.1.7

Label Part being diagnosed display Cause Action required

No input  
fault found

Input contacts 
1 to 8

Empty 
list

No failure, or monitoring not 
enabled for any input contacts -

Input in fault:
List 

number of 
inputs

Break or short circuit in the line 
connecting the contact 

Check integrity of the line connecting the balancing 
resistors and the activation contact. If the problem 
persists, disconnect the line connecting the 
activation contact and connect a 20 kW resistor 
between the +24V service terminals and the control 
input. If the problem persists, contact Servicing.

Inputs fault 
resumed:

Failure cleared due to previous 
failure signal

Access the Report> FAULTS panel from the 
OPERATOR menu and carry out a MANUAL 
RESET of the FAILURE signal.

General Input 
Fault:

Empty 
list

Failure of the internal communi-
cation between the CPU and the 
inputs controlled stage.

If the problem persists, contact Servicing.

General Fault 
resumed:

Failure cleared due to previous 
failure signal

Access the Report> FAULTS panel from the 
OPERATOR menu and carry out a MANUAL 
RESET of the FAILURE signal.

Tab. 8.4.1.6

If the percentage of variation exceeds the level of tolerance set at the time of configuring the system, a “LOUDSPk LINE FAULT” due to an 
excessively high or low impedance (Impedance Hi or Impedance Low) will be signalled.
Press ESC to return to the INSPECTION panel.
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Note: if several input contacts are activated simultaneously, with 
different programming of the messages in relation to the zones, for 
each zone output the system will enable the event with the highest 
priority (see table).

Press ESC to return to the INSPECTION panel.

Maximum priority General reset of messages (RESET)

High priority Pre-recorded Evacuation message (EVAC)

Low priority Pre-recorded Alert message (ALERT)

Minimum priority No event (NONE)

8.4.4 ContRoL InPutS StAtuS
 Status of the local input contacts
Panel for viewing the status of the local input contacts (CONTROL INPUTS). A list of 
the input contacts activated by external peripheral units is provided.
The CONTROL INPUT STATUS panel shows the active inputs, both if no events are 
associated with them and if an outgoing message event has been associated with 
them at the time of configuration. 
In the event of activation of a programmed local input, the VAC 2006 controller 
will stop the normal activity associated with the “Idle” status, mute the music being 
broadcast and inhibit the functions of the PA sources for broadcast announcements, 
and display the “INPUT EMERGENCY” panel. This will indicate which external input 
has activated the emergency (point 8.8, page 112).

The functionality of the inputs is defined by the firmware controller.exe.

8.4.5 IndICAtoRS tESt
 Check of the functionality of the visual and audio signal elements
Panel for checking speaker functionality (BEEP), display and operating emergency LED indicators. All LEDs on the front panel (excluding ‘ON’ 
LED) and the EMERGENCY key LED are flashing. A horizontal bar running for the whole width of the display is also activated and the warning 
signal (BEEP) will sound for about three seconds. The functionality of the built-in speaker, all LEDs and all the display pixels are checked. 
Please contact Support in case of failure. Press ESC to return to the INSPECTION panel.

8.4.3 CtR ConFIGuRAtIon
 System configuration  
Panel showing how the system is configured, on which a list of all the units present 
in the system is provided, as well as the address of the controller:

Ctr address (address of the controller in question): 0 to 5
System Ctr (number of controllers in the system): 1 to 6
Emerg. unit (number of emergency stations) 1 to 7
Broad. unit (number of broadcasting units) 1 to 16
used ctr lines (number of lines used for the controller in use): 0 to 6
confCtr v. (version of the system configuration file) 0.n



VAIE 2000 | Voice Alarm Integrated Systems System Manual | 2013

UK

102

VAC 2006 • VAR 2006

8.5   < oPERAtoR > MEnu
Panel for selecting options for which the personnel instructed 
and authorised to manage the system in emergency, failure and 
disablement conditions are responsible.

The options of the OPERATOR menu enable the following management panels to be accessed:

8.5.1 pannello SPEECH LEVEL (da opzione set > SPEECH LEVEL)
Adjustment of the level of the voice sources connected to the controller.

8.5.2 BACKGRound tESt panel (via the set > BACKGRound tESt option)
For enabling and disabling monitoring of parts affecting the ability of the system to function in emergency conditions.

8.5.3 FAuLtS panel (via the report > FAuLtS option)
query concerning the status of current and cleared failures as described in the Section on INSPECTION. In addition, this level enables 
MANUAL RESETTING OF FAILURE SIGNALS.

8.5.4 FIRMWARE VERSIon panel (via the Firmware Version option)
This panel shows the version of the firmware installed in the system.

< InSPECtIon >
For going directly to the INSPECTION menu.

< ConFIGuRAtIon >
For going directly to the CONFIGURATION menu.

8.5.5 Exit > Logout option
To exit from the service level and return to the basic level, reinstating the access password.

If an access password was enabled during configuration, the following 
panel will be shown: oPERAtoR ACCESS.
- Enter the 4-digit password and Ok to proceed,
  or
- press ESC to return to the HOME page.

The default password is 2222.
 
Following access, from the OPERATOR menu, 
turn the knob to browse through the options listed:
• set > SPEECH LEVEL
• set > BACKGRound tESt
• report> FAuLtS
• report> IMPEDANCE
• report > FAULTS
• report> CONFIG. 
• status> CONTROL INP.
• test> INDICATORS
• Firmware Version
< InSPECtIon >
< ConFIGuRAtIon >
• Exit > Logout 

Select the required item by pressing Ok, or
- press ESC to return to the MUSIC panel,
- press MENU to return to the HOME page.
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8.5.1 SPEECH LEVEL
 Adjustment of the level of the voice sources 
Panel for adjusting the levels of the voice sources connected to the VAC 2006 
controller. To make the adjustments, press the numerical key corresponding to 
the required source then turn the +/- knob .

It is possible to select values within a range from 0 to -80dB.

Press ESC to return to the OPERATOR menu.

8.5.2 BACKGRound tESt
 Setting the background tests
Panel for enabling and disabling background testing of the critical sources 
affecting the ability of the system to function in emergency conditions. The 
categories for choosing the items subjected to diagnostics are listed as 
shown in the figure opposite.
•   The categories for choosing the items subjected to diagnostics are listed 

as shown in the figure opposite.

 > 2-Voice Alarms see point 8.5.2.1
 > 3-Amplifiers see point 8.5.2.2
 > 4-Power Supply see point 8.5.2.3
 > 5-Control Input see point 8.5.2.4
 > 6-Communication see point 8.5.2.5
or
press ESC to return to the OPERATOR menu.

8.5.2.1 VoICE ALARMS
 Setting the test for Emergency Sources
Panel for enabling and disabling the monitoring tests.
•  Press the corresponding numerical key to select required item for opening 

the sub-menu and then to enable or disable the diagnostic test (on = test 
enabled / off = test disabled):

> 1-Local Emerg. > 1-Microphone 
 > 2-Emerg. button

> 2-Configuration > 1-SD card 
 > 2-Msg table

> 3-Emerg. unit > 1-Ctr unit <1> 

> 4-Messages > 1-Evac message
 > 2-Alert message

> 5-Line connect. > 1÷6-Line n connect. 

> 6-Remote Link: > 1-Remote link A
 > 2-Remote link B
 > 3-Remote ctr

Note: The display will show the programming that has been set.
Press ESC to return to the BACkGROUND TEST panel.
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8.5.2.2 AMPLIFIERS
 Setting the tests for the Amplifiers
Panel for enabling and disabling the voice and music amplifier monitoring 
tests.
•   Press the appropriate numerical key to enable or disable the diagnostic 

test (on = test enabled / off = test disabled):

> 1-Ampli Line 1 (on = test enabled / off = test disabled)
> 2-Ampli Line 2 (on = test enabled / off = test disabled)

Note: The display will show the programming that has been set.
Press ESC to return to the BACkGROUND TEST panel.

8.5.2.3 PoWER SuPPLY
 Setting the test for the Power Supplies
Panel for enabling and disabling the monitoring tests applied to the 230 VAC 
primary power supply and to the 24 VDC secondary power supply.
•   Press the appropriate numerical key to enable or disable the diagnostic 

test:

> 1-Mains P.S. (on = test enabled / off = test disabled) 
> 2-24Vdc P.S. (on = test enabled / off = test disabled)
> 4-Display (on = test enabled / off = test disabled)

Note: The display will show the programming that has been set.
Press ESC to return to the BACkGROUND TEST panel.

8.5.2.5 CoMMunICAtIon
 Setting the test for internal data communication
Panel for enabling and disabling testing applied to communication data 
between internal sections of VAC 2006.
•   Press the appropriate numerical key to enable or disable the
 diagnostic test:

> 1-Communication (on = test enabled / off = test disabled) 

Note: The display will show the programming that has been set.
Press ESC to return to the BACkGROUND TEST panel.

8.5.2.4 ContRoL InPut
 Enabling of testing of controlled inputs
Panel for enabling and disabling the monitoring tests applied to the 
controlled inputs.
•   Press the appropriate numerical key to enable or disable the diagnostic 

test:

> 1-Controller IN (on = test enabled / off = test disabled)
> 2-Rtr/PA IN (on = test enabled / off = test disabled) 

Note: The display will show the programming that has been set.
Press ESC to return to the BACkGROUND TEST panel.
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8.5.3 FAuLtS 
 Viewing of Failures (from the oPERAtoR menu)
The OPERATOR menu provides access to the “FAULTS” panel, as illustrated 
in the “FAULTS” section of the <INSPECTION> menu. The additional function 
enabled on accessing the “Report> FAULTS” panel from the OPERATOR level 
is “Manual Resetting of a Failure Signal”.

8.5.3.1 Manual Resetting of a Failure Signal (RES)
Manual Resetting is necessary in the following cases:
• To cancelled a stored RES (RESUMED) signal following detection and 

subsequent clearing of a failure, for all the other items being monitored.
• To reset the buzzer.

8.5.5  Exit > Logout 
 Exiting from a System Level
Upon completing the various activities, before returning to the Basic Level of 
the Music Menu, it is advisable to log out of the System Level of the current 
menu, in order to reinstate the password required for accessing the system 
again in future, thus preventing unauthorised personnel from accessing the 
advanced functions of the system.

From the options list of the OPERATOR MENU:

• turn the +/- knob to select the following option:

 Exit> Logout
 
• press the Ok key

The system will return to the Basic Level, showing the MUSIC Menu panel. 
The prompt requiring the access password to be entered will also be rein-
stated for any other levels that had been reached.

8.5.4 FIRMWARE VERSIon
 For viewing the Firmware version
Panel for viewing the version of the firmware installed in the system. The 
firmware of the following three sections is indicated:

> units software
 Main software installed on the CPU for managing the units.
> Zones software
 Main software installed on the CPU for managing the zones. 
> Matrix firmware
 Firmware for managing the audio signals.

To RESET the FAULT signalling manually, from the general FAULT display panel
 • Press the RESEt key

Upon completion of the procedure, press the ESC key repeatedly to return to the OPERATOR menu.
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8.6   < ConFIGuRAtIon > MEnu
Panel for selecting options pertaining to personnel specifically 
trained and authorised to use the advanced system functions 
and to modify the configuration parameters for starting and 
maintaining the system. 
A password for accessing these functions may be added.

The options of the ConFIGuRAtIon Menu enable the following management panels to be accessed:
8.6.1 ACQuIRE IMPEdAnCE panel (via the acquire > IMPEdAnCE option)
For acquiring and storing the impedance values of the speaker unit lines, which is necessary for system initialisation and diagnostics.
8.6.2 SEt toLERAnCE panel (via the set > IMP. toLERAnCE option)
For setting the tolerance applicable to the line impedance. When the diagnostic system detects impedance that is out of tolerance, a “Fault 
Warning Condition” is activated.
8.6.3 20KHZ LEVEL SEttInGS panel (via the set > 20KHZ LEVELS option)
Setting the levels of the 20 kHz test signal on the various different audio channels.

8.6.4 ALARM LEVEL panel (via the set > ALARM LEVEL option)
Panel for adjusting the output volume of the Emergency sources: Emergency Microphones and Alarm Messages.
8.6.5 AMPLIFIER tESt tIME panel (via the set > AMP SEt tIME option)
Setting the interval between one PMD amplifier test and the next.

8.6.6 pannello PASSWoRd panel (via the Password option)
Panel for enabling, disabling and customising the password for accessing the system service levels.

8.6.7 BEEP oPERAtIon panel (via the Beep operation option)
Panel for enabling, disabling and customising the system beep.
 
< SERVICE > Connection to the SERVICE menu for technical personnel having the necessary password. It is used to change the operating 
parameters of the VAC 2006 system, up-dating the firmware and servicing it.
note: The settings of the Service Menu are not covered in this Manual.

If an access password has been enabled, at the time of configuration the 
ConFIGuRAtIon ACCESS panel will be displayed:
- enter the four-digit password then press Ok to proceed, or
- press ESC to return to the MAIN page.
The default password is 3333.

Once the CONFIGURATION Menu is accessed, all the options illustrated 
earlier in the “AUDIO SETTING”, “INSPECTION” and “CONFIGURATION” 
menus will be shown, as well as the following new options specific to the 
CONFIGURATION menu.
Turn the knob to browse through the options listed:
• acquire > IMPEdAnCE
• set > IMP. toLERAnCE
• set > 20KHZ LEVELS
• set > ALARM LEVEL
• set > SPEECH LEVEL
• set> AMP SEt tIME
• set > BACKGROUND TEST
• set > CHIME
• report > FAULTS
• report > IMPEDANCE
• status > CONTROL INP.
• test > INDICATORS
INPUT 1
INPUT 2
Firmware Version
Password
Beep operation
< SERVICE >
• Exit > Logout

Press Ok to select the required item, or
- press ESC to return to the MUSIC panel.
- press MENU to return to the MAIN page. 
The characteristics of the specific panels of the ConFIGuRAtIon Menu are illustrated below. For the other available options, refer to the 
appropriate sections above. 
At the end of the setup, log out by selecting “Exit> Logout” as described in point 8.5.5, page 105.
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8.6.1 ACQuIRE IMPEdAnCE 
 Line impedance acquisition
Panel for acquiring and storing the impedance levels of the speaker unit 
lines. This information is necessary for system initialisation and diagnostics.

8.6.1.1 Loudspeaker line impedance acquisition
Foreword
Before acquiring the impedance values, make sure that the following steps 
have been completed:
• Preliminary check of the impedance of the lines using a suitable instrument 

(IMPEDANCE-METER) and of the loading conditions.
• Connection of the speaker unit lines as indicated in the CONNECTIONS 

Section.

The new impedance values acquired will be stored automatically in the system and shown on the labels of each zone. They are in Ohms and refer 
to both lines, A and B, connected to the output of each zone. The impedance values residing in the memory will be compared by the monitoring 
system with the values measured subsequently during the diagnostics routine.
note: To measure the impedance of the speaker unit lines, the monitoring system provided in the VAC 2006 uses an inaudible 20 kHz tone. Due to the 
inductance of the loudspeaker coils, the impedance at 20 kHz may be considerably different from that measured with an impedance meter, which usually 
uses a 1 kHz measuring tone. The value acquired by the VAC 2006 is therefore usually indicative only as a comparative value for diagnostic purposes. 
For this reason, when calculating the power absorbed by the speaker unit lines for the purpose of sizing the system it is recommended to use the value 
measured with an impedance meter.
* The amplifiers of the DPU range use a tone that has a frequency of 30 Hz.
Press ESC to return to the CONFIGURATION menu.
Upon completing the procedure, carry out a MANUAL RESET of the FAILURE SIGNALLING, as described under point 8.5.3.1, page 105.

After selecting “Acquire> IMPEDANCE” from the CONFIGURATION menu, the “ACqUIRE IMPEDANCE” panel will show the impedance values 
stored at the time of the previous acquisition:
    
 • press the oK key

8.6.2 SEt toLERAnCE 
 Setting the line tolerance
If the diagnostic system detects a difference between the impedance 
measured in real time and the value stored in the system greater than 
the tolerance that was set: an “Impedance Low” or “Impedance Hi” “Fault 
Warning Condition” will be activated. For details about signalling of failures, 
see the “LOUDSPk. LINE FAULT” panel  (point 8.4.1, page 96).

8.6.2.1 Setting the tolerance for measuring the lines 
Foreword: The measurement tolerance must be set after completing 
acquisition of the line impedance  (see point 8.6.1).
The default value is 30%.

 • press the numerical key corresponding to the line. 
 • Hold the numerical key corresponding to the zone (1-6) down,  
   turning the +/- knob to choose the required value.

>Valori da 10% a 100%: tolerance above or below the stored value.

>test disabled: Impedance check disabled. Testing for short circuits and 
GND faults will in any case be carried out.

It is also possible to disable the impedance test by setting a tolerance of 
0% (Not Tested).

Press ESC to return to the CONFIGURATION menu.
Upon completion of the procedure, if appropriate carry out a MANUAL 
RESET OF THE FAILURE SIGNALLING as described under point 8.5.3.1, 
page 105.

After selecting the “Set> IMP. TOLERANCE” option from the CONFIGURATION 
menu, the “SET TOLERANCE” panel will show the current tolerance settings 
for each output zone.
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8.6.3 20KHZ LEVEL SEttInGS
 Setting the levels of the 20kHz signals
Panel for setting the levels of the 20 kHz test signal on the various different 
audio channels of the VAC 2006 controller.

> 1-Master level 
Master level of the 20 kHz test signal.

 • Press key 1 then turn the +/- knob.
 

> 2-Link music lev.
Output levels of the 20 kHz music output signal sent towards the other controllers 
connected to the system.
 > 1-Link A level   > Press key 1 then turn the +/- knob.

 > 2-Link B level   > Press key 2 then turn the +/- knob.

> 3-Link speech lev. 
Output levels of the 20 kHz speech output signal sent towards the other controllers 
connected to the system. 
 > 1-Link A level   > Press key 1 then turn the +/- knob.
 > 2-Link B level   > Press key 2 then turn the +/- knob.

 

> 4-Line music lev. 
Music channel test levels. 
 > 1-Line 1 level   > Press key 1 then turn the +/- knob.
 > 2-Line 2 level   > Press key 2 then turn the +/- knob.
 > 3-Line 3 level   > Press key 3 then turn the +/- knob.
 > 4-Line 4 level   > Press key 4 then turn the +/- knob.
 > 5-Line 5 level   > Press key 5 then turn the +/- knob.
 > 6-Line 6 level   > Press key 6 then turn the +/- knob.

> 5-Line speech lev.
Voice channel test levels. 
 > 1-Line 1 level   > Press key 1 then turn the +/- knob.
 > 2-Line 2 level   > Press key 2 then turn the +/- knob.
 > 3-Line 3 level   > Press key 3 then turn the +/- knob.
 > 4-Line 4 level   > Press key 4 then turn the +/- knob.
 > 5-Line 5 level   > Press key 5 then turn the +/- knob.
 > 6-Line 6 level   > Press key 6 then turn the +/- knob.
 
N.B.: The display shows the status of the factory-set programming. 

Press ESC to return to 20kHZ LEVEL SETTINGS panel.
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8.6.4 ALARM LEVEL
 Adjustment of the volume of emergency sources
Panel for adjusting the output volume of emergency sources for the purpose of cali-
brating the system. 
To adjust the volume of the required source: 
• hold the corresponding numbered key (1 - 5) down.
  and
• use the +/- knob to adjust the volume 
Note: The volume set will be the same for all the output zones.

Upon completion, press ESC to return to the CONFIGURATION menu.

1-output volumes of the FMd emergency microphone stations connected to their local VAC 2006 unit: the adjustment range for the EMERGENCY 
UNITS is between -80 dB and 0 dB.

2-output volume of hand-held emergency microphones: the adjustment range for FIRE MICROPHONES is between -80 dB and 0 dB. 
It is suggested that in most cases a volume of +16 dB should not be exceeded.

3-output volume of pre-recorded ALERt messages: the adjustment range for ALERT MESSAGES is between -80 dB and 0 dB.

4-output volume of pre-recorded EVACuAtIon messages: The adjustment range for EVAC MESSAGES is between -80 dB e 0 dB.

5-Volume of emergency signals from VAC 2006 remote controllers: the adjustment range for VAC 2006 LINk is between -80 dB e 0 dB.

8.6.6 PASSWoRd
 Setting the password
Panel for enabling, disabling and customising the password for accessing the 
system service levels.
•  Use the +/-  knob to position the cursor on each digit of the password to be 

changed
• Use the numerical keys (1-6) to enter the new password
• Press Ok to enable or disable the password as set.
note: The display will show the new password programming that has been set.

8.6.7 BEEP oPERAtIon
 Management of the system “beep” 
Panel for enabling and disabling the system “beep”.
• Use key 1 to enable or disable emission of the acoustic signal.

nota: The display shows the status of the set programming.

Upon completion, press ESC to return to the CONFIGURATION menu.

8.6.5 AMPLIFIER tESt tIME
 Setting the interval between test signals for testing amplifiers of the  
 dPu range
• Hold the corresponding numerical key (1 to 3) down and use the +/- knob to adjust 
the setting:
1-Line Line  (1 to 6)
2-Amp Amplifier (1 to 16 / ALL)
3-Time Length of test (5s to 18h / no test) 

Upon completion, press ESC to return to the CONFIGURATION menu.
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8.7   MAnuAL EMERGEnCY - < EMERGEnCY > Menu
Following is a description of the procedure for managing emergencies manually by an authorised operator.

8.7.1   General information
The manual emergency mode is accessible at all times. Manual emergencies have priority over any pre-recorded messages being broadcast 
and that were activated by an external peripheral unit connected to the “control Inputs” and over any emergency stations able to broadcast 
messages via the 6 output lines of the controller being used. 

8.7.2    Manual management of emergencies
As explained below, thanks to its dual-channel operation, the VAC 2006 controller enables structured management of alarm messages, of 
muting of the messages and of selection of the zones. Following is a list of operations providing a brief introduction to manual emergencies.

A) SEndInG oF An EMERGEnCY MESSAGE FRoM A ContRoLLER
-  Press the EMERGEnCY key once. The key will light up steadily. 

Activation of the emergency mode will also be shown on the routers, 
stations and any other controllers connected to the controller.

- Send a voice message (using the hand-held microphone) or an alerting 
message (ALERt key) or evacuation message (EVAC key) to all zones. 
The display will show the type of message being broadcast.

N.B.: Messages sent using a hand-held microphone have absolute 
priority over pre-recorded evacuation and alert messages.

To end live emergency messages, release the PTT key and press the EMERGEnCY push-button again. Make sure that you close the lid 
again.

B) SEndInG An EMERGEnCY SIGnAL FRoM REMotE StAtIonS oF tHE FMd RAnGE 
-  Lift the safety lid on the station and press the EMERGEnCY push-button once. It will light up steadily. Activation of the emergency mode by 

the station will also be shown on the routers and on the controller(s) connected to the station on their displays and by a flashing key.
- Select the zones to which the message should be sent.
- Speak into the microphone, holding the PTT (Push-to-Talk) key down until the end of the message. 

 N.B.: the Ptt key has priority over any pre-recorded messages being broadcast.

• Sending pre-recorded alert and/or evacuation messages
- Select the zones to which the message should be sent.
- Press the ALERt (alert) key or the EVAC (evacuation) key to send 

the pre-recorded message to the zones that have been selected.

To end live emergency messages, alert messages and/or evacuation messages, press the EMERGEnCY key again.

To end live emergency messages, release the PTT key, then press 
the EMERGEnCY push-button again. Make sure that you close the 
lid again.
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C) EXItInG tHE SYStEM FRoM MAnuAL MAnAGEMEnt oF tHE EMERGEnCY
Upon completion of the Manual Emergency management procedure, press the red EMERGEnCY key, which will extinguish, and: 

 - If no alarms from external peripheral units connected to the input contacts (Control Inputs) have been activated, then the system will 
automatically revert to the “Idle” status, displaying the <MUSIC> menu. The ALARM LED will remain OFF to indicate that the VOICE ALARM 
condition is not active.

 - If any alarms from external peripheral units connected to the input contacts (Control Inputs) have been activated, then the system will revert 
to the Automatic Emergency mode, displaying the INPUT ALARM STATUS menu. Broadcasting of the emergency messages will resume 
as programmed for the inputs that have been activated, and the ALARM LED will light up, if appropriate, to indicate activation of a VOICE 
ALARM.
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8.8.1 Activation of an Automatic Emergency
In the event of activation of a programmed local input, the VAC 2006 controller 
will stop the normal activity associated with the “Idle” status, mute the music 
being broadcast and inhibit the functions of the PA sources for broadcast 
announcements, and display the “INPUT EMERGENCY” panel. This will 
indicate which external input has activated the emergency.
If the contact has been programmed to send at least one emergency message 
to at least one output zone, the system will initiate the Automatic Emergency 
by enabling a “Voice Alarm Condition” and causing the ALARM LED to light up. 
The INPUT EMERGENCY panel will show the type of out-going pre-recorded 
message on each line.

Viewing the operational status
ALARM LED: This LED lights up to indicate that a VOICE ALARM is active 
when a live microphone announcement or a pre-recorded message are being 
sent out to at least one zone. 

8.8.2 operation of the system during Automatic Emergency
As long as the input contacts are active, the MUSIC panel will remain inactive. It will, however, be possible to navigate among the various menus to access 

the advanced functions of the system and to investigate or change the settings.

- A current “Voice Alarm Condition” due to an Automatic Emergency may be altered by an authorised operator entering the system to activate the 
manual controls for managing the emergency, in order to RESET the messages, change the current messages or send live announcements using the 
microphone provided for this purpose.

For details about management of a Manual Emergency, consult the MANUAL EMERGENCY, point 8.7, page 110.

8.8.3 Exiting from an Automatic Emergency
 • De-activate the contact that had activated the emergency  
   or
 • Press the EMERGENCY push-button. At the same time, hold the RESET key down for at least 2 seconds, then release it.

To inform the operator that the alarm was activated via external contacts, the controller keeps the notice of the emergency flashing on the display.
 

The system will return to a “quiescent Condition” showing the MUSIC panel.

8.8 AutoMAtIC EMERGEnCY - Alarm Condition activated from an external peripheral unit
Following is a description of the operating mode of the system in the event of an Automatic Emergency initiated by an external peripheral unit 
activating the input contacts programmed to enable a “Voice Alarm Condition”.

Line status bar:
- Empty label: zone without any current message.
- RESEt: zone mute due to general reset contact.
- EVAC: zone with EVACUATION message being broadcast.
- ALERt: zone with ALERT message being broadcast.
- dIS: zone in which alarms are disabled (see point 8.6.4).
- FAIL: zone with failure condition on the speaker line. Label shown even if the type or failure does not prejudice the outgoing signal. When 

operating on a single channel due to an amplifier failure, this indicates that the zone is unable to broadcast the planned signal. 
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9.       FAuLt WARnInG CondItIon
The VAC 2006 system has a diagnostic routine that monitors constantly availability of the emergency sources and the soundness of the critical 
path of the signals providing the functions in emergency conditions.

9.1   SYStEM oPERAtIon And SIGnALLInG In GEnERIC CondItIonS
9.1.1  System signalling due to an existing “Fault Warning Condition”  
If, with the system in its normal “quiescent Condition”, the monitoring system detects a cause of a failure, it promptly activates signalling of a 
“Fault Warning Condition”, as follows:
• the FAULT LED (visual signal) will light up.
• a BEEP (acoustic signal) will be heard via the monitoring loudspeaker.
• activation of any local output contacts (CONTROL OUTPUTS) that may have been programmed (remote signalling).
• the failure condition (FAULT) will be indicated in the status label on the Report FAULT panel.

9.1.2  System signalling following cleaning of “Fault Warning Condition” (RES)
If the cause of the failure is cleared automatically, without any action on the part of the operator, the system will return automatically to its 
“quiescent Condition”, resetting all the signals described above and storing the last failure that occurred as follows:
• The word RES will be shown on the status label of the Report FAULT panel indicating that the failure has been cleared.

9.1.3  Resetting the signal following clearing of a failure (FAuLt RESEt)
To reset a signal referred to a failure that has been cleared and stored:
• From the OPERATOR menu, go to the FAULT panel (point 8.5.3, page 105)
• Carry out a MANUAL RESET of the failure signal as indicated under point 8.5.3.1, page 105.
note: In the event of failure of a loudspeaker line due to a short circuit, once the line is repaired it is necessary to carry out a MANUAL RESET of the failure 
from the OPERATOR menu, in order to re-activate the audio signal on the output of the line concerned.

9.1.4  Recommended procedure during a Fault Warning condition
The procedure to be followed during a Fault Warning condition is the following:
• From the INSPECTION menu, go to the FAULT panel (point 8.4.1, page 95)
• Check the category of the FAULT diagnosed and go to the appropriate sub-panel.
• Check the cause of the failure and, if possible, restore correct operation following the instructions contained in the table referred to the sub-

panel (see points from 8.4.1.2 to 8.4.1.7).
If upset is successfully cleared, termination of the Fault Warning condition will be signalled as follows:
• The FAULT LED will extinguish.
• The output contact involved, if any, will be de-activated.
• The word RES will appear in the status label of the Report FAULT panel to show that the failure has been cleared.
Upon completion of the procedure, it is advisable to reset the signal for the failure that has been cleared, as indicated under point 9.1.3.

9.2 SYStEM oPERAtIon And SIGnALLInG In tHE EVEnt oF A SPEAKER LInE FAILuRE
A failure of the speaker line may be due to various different causes. The associated signalling and the activities required are described under 
point 8.4.1.2 LOUDSPK. LINE  FAULT panel. If the problem is due to a variation in the impedance, the VAC 2006 will continue to broadcast the 
audio signal output from the zone. If it is due to a short circuit on the line, the system will disconnect the failed line and broadcast the audio signal 
on the other line serving the same zone.  
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tECHnICAL SPECIFICAtIonS VAC 2006

Display 3”, backlit, 128x64 dots

Inputs

uSB-EXt. Powered uSB input on the front panel - type A socket

Emergency microphone
• Sensitivity / Impedance
• Frequency response / S/N ratio

Balanced XLR-F on the front panel
Signa level 20 mV / 10 kW
60 ÷ 20.000 Hz / 72 dB

In.1
Socket (MIC.)
• Sensitivity / Impedance
• Frequency response / S/N ratio

Programmable for the following modes: on / oFF / Precedence / VoX with A.P.t.
Balanced XLR-F (with possibility of activating 24 V phantom power supply
Signal level Min. 3 mV - Max 100 mV / 1,8 kW
240 ÷ 20.000 Hz / 63 dB

In.2
Socket (MIC.)
• Sensitivity / Impedance
• Frequency response / S/N ratio
Socket (LInE)
• Sensitivity / Impedance
• Frequency response / S/N ratio

Programmable for following modes: on/ oFF / Precedence / VoX with A.P.t.
Balanced XLR-F (with possibility of activating 24 V phantom power supply)
Signal level Min. 3 mV - Max 100 mV / 1,8 kW
240 ÷ 20.000 Hz / 63 dB
Balanced with terminals(HOT-COM-GND)
Max signal level 1800 mV / 31 kW
60 ÷ 20.000 Hz / 84 dB

AuX
• Sensitivity / Impedance
• Frequency response / S/N ratio

RCA stereo socket for source of sound (BGM) – Conversion to mono 
Max signal level 1800 mV / 31 kW
60 ÷ 20.000 Hz / 84 dB

Paging units
• Sensitivity / Impedance
• Frequency response / S/N ratio

2 Rj45 for calling (PA) units of the MBt 1106 / MBt 1112 range.
Max signal level 1400 mV / 85 kW
60 ÷ 20.000 Hz / 83 dB

EMERGEnCY unItS Rj45 for connection to a dedicated emergency microphone station.

outputs

SLAVE LInK outPut
• Output level / Impedance

Rj45 for connection to an VAR 2006 / dPu / VAIE 2250 unit
Max 2000 mV / 400 W

VAC 2006 LInK
• Output level / Impedance
• Sensitivity / Input impedance

Rj45 for connection to a VAC 2006 unit
Max 2000 mV / 400 W
2000 mV / 50 kW

Emergency controls
• CONTROL INPUTS inputs
• CONTROL OUTPUTS outputs

Programmable as normally Activated or normally de-activated.
7 inputs with diagnostics.
3 relays for signalling emergency conditions and failures, NO-NC-Changeover terminals.

Precedence In 1 - In 2 Precedence input with terminals with common +12 Vdc.

LAn Presa LAn Rj45 per collegamento tCP/IP a web server.

overall

Mains power supply @230Vac

Consumption @230Vac

230 Vca 50/60 Hz ±10%
10 W

External power supply @24Vdc

Consumption @24Vdc 
24 Vcc (min 22Vcc ÷ max 28Vcc)
0,3 A

Environmental operating conditions Temperature: +5°C to +40°C / Relative humidity: 25% to 75% non-condensing

Mounting Direct to rack 19” (2U).

Size of unit (L x H x D)
Size of package (L x H x D)

482 x 88 x 220 mm
522 x 155 x 292 mm

Net weight
Gross weight

4,5 kg
5,5 kg

tECHnICAL SPECIFICAtIonS VAR 2006

Mains power supply @230Vac

Consumption @230Vac

230 Vca 50/60 Hz ±10%
12 W

External power supply @24Vdc

Consumption @24Vdc 
24 Vcc
0,5 A

Maximum switchable output power per single zone 500 W

Environmental operating conditions Temperature: +5°C to +40°C / Relative humidity: 25% to 75% non-condensing

Mounting Direct to rack 19” (1U)

Size of unit (L x H x D)
Size of package (L x H x D)

482 x 44 x 220 mm
522 x 155 x 292 mm

Net weight
Gross weight

4 kg
5 kg
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LISt oF oPtIonAL FunCtIonS

Clause description

7.6.2 Manual silencing of the voice alarm condition

7.7.2 Manual reset of the voice alarm condition

7.9 Voice alarm condition output

8.3 Indication of faluts related to the transmission path

8.4 Indication of faults related to voice alarm zones

9 Disablement condition

10 Voice alarm manual control

11 Interface to external control device(s)

12 Emergency microphone(s)

13.14 Redundant power amplifiers

LISt oF AuXILIARY FunCtIonS

Broadcast calls

Background music



Le informazioni contenute in questo manuale sono state scrupolosamente controllate; tuttavia non si assume nessuna 
responsabilità per eventuali inesattezze. La FBT Elettronica S.p.A. si riserva il diritto di modificare le caratteristiche tecniche 
ed estetiche dei prodotti in qualsiasi momento e senza preavviso. 

code: 37782


